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About This Guide  
The Proficy Batch Execution Equipment Configuration Manual describes the tasks associated with 
configuring equipment entities in the Equipment Editor application. This manual is intended for use by 
individuals who perform the engineering duties of automated batch operations using Batch Execution. 
This manual assumes the reader is familiar with the equipment, resources, and phase logic for the plant 
in which Batch Execution is running. 

Reference Documents 
Refer to following documents for additional information: 

• ANSI/ISA-S88.01 Batch Control, Part 1: Models and Terminology  

• System Configuration Manual  

• Recipe Development Manual  

• Phase Programming Manual  

• PLI Development Manual  

• Application Guide  

Introduction 
The Equipment Editor is a graphical tool for configuring and maintaining one or more area models. 
Within an area model you define the following equipment entities: 

• Area  

• Process Cells  

• Units  

• Equipment Phases  

• Control Modules  

Batch Execution uses the equipment defined within an area model to: 

• Construct recipes.  

• Execute batches.  

The Equipment Editor is integrated into the Proficy Batch Execution WorkSpace application, 
providing a central location for all your development needs. The following subsections highlight some 
of the key benefits that the Equipment Editor provides. 
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Graphical Interface 
The Equipment Editor provides a graphical, hierarchical representation of the equipment in your plant. 
Icons represent each piece of equipment, providing an immediate association between the equipment 
on the plant floor and the equipment configured in the Equipment Editor. Users can easily examine 
equipment by drilling up and down through the equipment hierarchy. 

S88.01-Aware  
The terminology and equipment hierarchy in Batch Execution is based on the widely accepted 
industry-standard ISA S88.01 Batch Control Models and Terminology. Standard S88.01 terms, such as 
process cell and unit, are used throughout the Equipment Editor. Users that apply the standard to their 
process can easily identify these equipment entities in Batch Execution. 

Open Architecture  
The Batch Execution Server is an OPC-enabled client. This lets you retrieve data from any OPC (OLE 
for Process Control) compliant data server, such as GE's iFIX® software. Based on Microsoft's® OLE 
(Object Linking and Embedding) technology, OPC provides greater interoperability between control 
applications, field systems and devices, and Office/BackOffice applications. OPC servers of real-time 
information, such as DCS, PLCs, smart field devices, and analyzers can communicate directly with the 
Batch Execution Server.  

Integration with iFIX  
In addition to being able to retrieve data from GE's iFIX software, the Equipment Editor also lets you 
associate an iFIX picture with the equipment configured in Batch Execution. Operators can access 
these pictures from the Batch Execution Client to view real-time process values for the associated 
equipment. 

Maximizing Equipment Usage  
Batch Execution supports Active Binding™, which allows Batch Execution to bind and re-bind units at 
multiple stages in a batch's life cycle including when a batch is created, started, or in production. 
Recipe authors can configure recipes to automatically allocate equipment to batches based on the: 

• Properties of the equipment entities.  

• Real-time conditions on the plant floor.  

Your area model can incorporate features such as class-based units, equipment pathing within a 
process cell, unit capacity, and unit status to provide Batch Execution with a host of information to 
perform Active Binding.  
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Interoperability with Batch Execution 
The area model configuration affects other areas of Batch Execution including: 

Recipe Development – your area model configuration affects the configuration of recipes in the 
Recipe Editor. For example, in order for a recipe author to build a recipe that can run on 
multiple units, you must configure class-based units.  

Batch Execution – your area model configuration affects what equipment the Batch Execution 
Server can allocate to batches. During batch execution, the Batch Execution Server verifies 
that the selected equipment is part of a valid equipment path, meets the capacity 
requirements, and is available for use. The Batch Execution Server also allocates all 
equipment that was specified as "needed" in the Equipment Editor. This reserves the needed 
equipment so that other batches cannot use the same equipment at the same time.  

Understanding the S88.01 Physical Model  
The equipment hierarchy in Batch Execution is based on the ISA S88.01 Physical Model. The Physical 
Model defines a hierarchy consisting of several levels that identifies the equipment within an 
enterprise. Equipment is grouped together at a lower level to create a piece of equipment in the next 
higher level. 

The objective of the Physical Model is to define equipment entities that can be grouped together to 
perform specific process activities. Performing this task requires you to have a clear understanding and 
definition of each piece of equipment in your plant. Refer to the Batch Execution Application Guide 
for more information on the Physical Model. 

Example: Equipment Hierarchy in Batch Execution 

The following figure illustrates a sample equipment hierarchy. Refer to the Getting Started section for 
more information on the sample application that uses this area model. 
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Sample Application Equipment Hierarchy 

Implementation Strategies 
The sections that follow provide strategies for configuring equipment in the Batch Execution 
Equipment Editor, including: 

• Partitioning your plant equipment.  

• Implementing a class-based design.  

• Implementing Active Binding.  

Partitioning Plant Equipment 
Prior to configuring equipment in the Equipment Editor, partition your equipment for maximum 
productivity. This includes identifying: 

• The units and other equipment that make up a process cell.  

• The equipment phases and other related equipment that make up a unit.  

• The phases within a unit.  

• Common resources.  
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NOTE: To optimize new process designs or modifications to existing processes, include equipment 
partitioning in the design specifications of the process. 

General Definition Guidelines  

To achieve the most efficient and easily maintained equipment, use the following guidelines: 

• Define equipment without a particular product in mind. This way, when you make a change in 
the product or process, it is less likely you will need to change the equipment definitions.  

• Define each piece of equipment to work independently.  

Partitioning Process Cells  

A process cell consists of the production and supporting equipment necessary to make a batch. In 
Batch Execution, a process cell can contain units, equipment phases, and control modules. Two major 
factors determine how you partition process cells. These factors are the: 

• Number of different products manufactured.  

• Physical structure of your equipment.  

The following subsections describe each condition. 

Number of Products  

The ISA S88.01 Batch Control Standard defines process cells as either single-product or multi-
product. A single-product process cell produces the same product in each batch. A multi-product 
process cell can produce different products. Batch Execution supports both single-product and multi-
product process cells. 

Physical Structure 

The ISA S88.01 Batch Control Standard defines three types of process cell structures: 

• Single path.  

• Multiple path.  

• Network path.  

A single path structure is a group of units through which a batch passes sequentially. A multiple path 
structure consists of several single path structures in parallel, with no product transfer between them. 
In a network structure, the paths may be either fixed or variable. If the path is variable, the path is 
determined at batch run-time. Batch Execution supports all three pathing structures. 

Equipment Pathing  

Within a process cell, Batch Execution lets you configure the physical connections between units to 
ensure that batches execute on a valid equipment path. Refer to Implementing Active Binding section 
for more information on equipment pathing. 
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Partitioning Units  

An integral part of your control strategy is deciding what pieces of equipment make up a unit. A unit is 
a major piece of equipment in a process cell that performs a specific task. It consists of all the 
equipment modules and control modules that the unit needs to perform this task. Equipment phases 
control the equipment that makes up a unit. Note that units: 

• Only run one batch at a time.  

• Operate independently of each other.  

You cannot effectively configure a unit in Batch Execution until you have a complete understanding of 
the equipment and control modules that make up the unit.  

Example: Defining the MIXER Unit  

The following figure illustrates how the MIXER and RAW unit classes in the sample toothpaste 
application are partitioned. The mixer contains the equipment modules (such as the agitator) and 
control modules that operate the mixer. In this case, it is clear that the control modules that make up 
the agitator equipment module should be defined as part of the MIXER unit. However, it may be less 
clear to determine which unit certain equipment (such as the valve connecting the RAW and MIXER 
units) belongs to. In the case of the sample toothpaste application, the valve is included in the MIXER 
unit. 

 

Sample MIXER Equipment Phases  
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Identifying Common Resources  

In complex batch processes, you may have equipment that more than one resource uses. This type of 
equipment is called a common resource. Typically, a common resource is either a control module or an 
equipment module that more than one unit can request. In Batch Execution, other resources or the 
operator can make requests for resources. In order for Batch Execution to allocate resources 
appropriately, you can designate common resources as either exclusive-use or shared-use resources. 
Only one requestor can use an exclusive-use resource at one time. Multiple requestors can use a 
shared-use resource simultaneously. 

Examples of common resources include: 

• A pump that is shared between two units. If the pump can only be used by one unit at one 
time, you would designate the pump as an exclusive-use resource.  

• A process heater that can heat multiple units simultaneously. In this case, you would 
designate the heater as a shared-use resource.  

Batch Execution provides several options for configuring common resources:  

If the common 
resource is a... 

Batch Execution lets you... 

Unit Share the unit between two or more process cells.  

Equipment Phase Share the equipment phase between two or more units. 

Control Module Assign the control module as a needed resource to each piece of 
equipment that requires the control module to execute. 

NOTE: For more information on configuring and arbitrating common resources, including shared-use 
and exclusive-use resources, refer to the Advanced Topics section. 

Example: Configuring Equipment Phases as Common Resources  

In the sample toothpaste application, the Flavoring and Whitener units share a valve that transfers 
material into a mixer. The equipment phase, XFER_OUT7 is designated as an exclusive-use resource. 
The following figure illustrates this configuration. 
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Configuring Equipment Phases as Common Resource  

Example: Configuring Control Modules as Common Resources  

The following figure shows a pneumatic conveying system. In this system, the blower is a common 
control module that is a common resource. The blower is assigned to BIN1 and BIN2 as needed 
equipment.  

 

Configuring Control Modules as Common Resources 
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Implementing a Class-Based Design 
The ability to create class-based equipment entities ties in with the overall goal of creating reusable 
and maintainable equipment. In Batch Execution, process cells, units, and phases are defined at both 
the class-level and the instance-level. 

The class-level defines common properties that apply to all instances of that equipment entity. The 
instance-level defines information that ties a specific entity to its physical equipment. Implementing a 
class-based design is especially effective when configuring units. 

Implementing Class-Based Units  

Implementing class-based units allows recipe authors to build class-based recipes. Class-based recipes 
are recipes that can execute on any unit within a class of units. Depending on how the recipe is 
configured, the Batch Execution Server can: 

• Automatically select the specific unit instance.  

• Prompt the operator to select the unit when the recipe executes.  

For more information on class-based recipes and configuring recipes for automatic unit allocation, 
refer to the Recipe Development Manual. 

Example: Class-Based Units  

Use a class-based design when a process cell contains several similar units, such as mixers or storage 
tanks. As illustrated in the following figure, the process cell contains seven storage tanks, three mixers, 
and two reactors. Rather than defining twelve unique units, you can define three unit classes and then 
configure the I/O points for each unit instance. Using this class-based configuration, the recipe author 
can build one class-based recipe that runs on any unit instance in the raw, mixer, and reactor classes. 

 

Unit Classes and Instances  
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Implementing Active Binding 
Batch Execution supports Active Binding. Active Binding encompasses all aspects of binding a unit 
procedure to a physical unit. Batch Execution can bind and re-bind unit procedures to units at multiple 
stages in a batch's life cycle including when a batch is: 

• Created (added to the batch list).  

• In production.  

To provide Batch Execution with information to intelligently bind an appropriate unit, you can 
implement the following functionality in your area model: 

Equipment pathing – Within a process cell, you can specify the physical connections between 
units. When the unit procedure executes, the selected unit must be within a valid equipment 
path.  

Equipment capacity – For each unit, you can specify the unit's maximum capacity. When the 
recipe executes, the selected unit must meet the capacity requirement defined for the unit 
procedure. 

Equipment status tags – For each unit, you can specify a Unit Ready status and a Unit Priority 
status, which indicate the unit's current availability and priority rating. When the recipe 
executes, the unit selected by the Batch Execution Server must be in a ready status. If more 
than one unit is ready, the Batch Execution Server selects the unit with the highest priority.  

Implementing Equipment Pathing  

Within a process cell, you can define the physical connections between units. During equipment 
configuration, you graphically configure these connections using drawing tools provided in the 
Equipment Editor. The Batch Execution Server uses these connections to ensure that a batch executes 
on a valid path in the process cell. Implementing equipment pathing: 

• Prevents the Batch Execution Server or the operator from allocating units to batches that are 
not part of a valid execution path.  

• Verifies that the Jacobson Links™ defined in recipes are valid based on the pathing defined in 
the area model. Jacobson Links are connections that are drawn within a recipe's sequential 
function chart (SFC) to graphically represent a necessary physical connection between unit 
procedures. Refer to the Recipe Development Manual for more information on Jacobson 
Links.  

For example, if the recipe requirements specify that two units must be connected, the Batch Execution 
Server ensures that the execution path for the batch contains two connected units. 

Equipment pathing is especially important if, during a batch, material is transferred between units. 
Without this pathing, any unit within a unit class may be considered valid, regardless of whether it is 
physically connected to another unit. 
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Implementation Guidelines  

When configuring your equipment paths, consider the following guidelines: 

• Only connect units that are physically connected on the plant floor.  

• Bi-directional connections between two units require two separate connections. An example 
of a bi-directional connection is when material can be transferred to and from two connected 
units.  

For more information on configuring equipment pathing, refer to the Configuring Equipment section. 

Implementing Equipment Capacity  

Equipment capacity defines the maximum capacity that a unit can contain, transfer, or process during 
production. The capacity definition for a unit coupled with the minimum capacity requirement defined 
for a unit procedure recipe ensures that only those units with the required capacity are allocated to 
batches. 

A unit's capacity can also be incorporated into VBIS scheduling applications to schedule batches based 
upon capacity plans. For more information on VBIS, refer to the Custom Applications manual. 

For more information on configuring a unit's equipment capacity, refer to the Configuring Equipment 
section. 

Implementing Equipment Status Tags  

Batch Execution supplies two pre-defined unit tags, Unit Ready and Unit Priority, which you can use 
to indicate the current status of a unit.  

Unit Ready tag – indicates whether the unit is ready for use. A value of zero (0) indicates the unit 
is ready and can be used by a batch. A non-zero value indicates the unit is not currently 
available. Batch Execution will not allocate a unit with a non-zero Unit Ready tag to a 
batch. 

Unit Priority tag – indicates the priority of the unit, as compared to other units in the same unit 
class. If multiple units are available for a batch, Batch Execution selects the unit with the 
highest priority value. 

How you implement these tags depends on your particular process and requires you to program your 
process controller or HMI to set these tags as appropriate. For more information on using these tags, 
refer to the Advanced Topics section.  

Example: Active Binding  

The equipment configuration for the sample toothpaste application uses equipment pathing, equipment 
capacity, and equipment status tags to provide Batch Execution with data to ensure that suitable units 
are allocated to batches. The following table lists the equipment capacity settings and the current 
equipment status for each unit instance in the MIXER class.  
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Sample Unit Equipment Capacity and Status   

Unit Instance Equipment Capacity Current Equipment Status 

MIX1 1000 Liters MIX1_READY=1 

MIX1_PRIORITY=3 

MIX2 600 Liters MIX2_READY=0 

MIX2_PRIORITY=1 

MIX3 1000 Liters MIX3_READY=0 

MIX3_PRIORITY=3 

Recipe Requirements 

Assume that the following equipment requirements exist for the MAKE_BASE and 
MAKE_ADDITIVE unit procedures in the sample application.  

Sample Recipe Equipment Requirements   

Unit Procedure Unit Class Capacity Requirement Bind Type 

MAKE_BASE MIXER 1000 Liters Automatic 

MAKE_ADDITIVE MIXER 200 Liters Automatic 

Based on the requirements and equipment configurations listed in the previous tables, the Batch 
Execution Server selects the path shown in the following figure. 
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Unit Classes and Instances  

The Batch Execution Server performs the following process of elimination to select the equipment path 
shown in this figure: 

1. Batch Execution eliminates MIX1 because the MIX1_READY tag indicates that it is 
currently offline. This narrows the choice to MIX2 and MIX3.  

2. Batch Execution selects MIX3 for the MAKE_BASE unit procedure because:  

• Its Unit Ready tag indicates it is online.  

• It meets the minimum capacity requirement defined in the unit procedure.  

• MIX3 is physically connected to the transferring units.  

3. Batch Execution selects MIX2 for the MAKE_ADDITIVE unit procedure, because:  

• Its Unit Ready tag indicates it is online.  

• It meets the minimum capacity requirement defined in the unit procedure.  

• MIX2 is physically connected to the transferring units.  

4. Batch Execution selects the REACTFLAVOR unit for the MAKE_FINAL unit procedure 
because this is the only reactor that is physically connected to MIX2 and MIX3.  

For more information on configuring recipes for Active Binding, refer to the Recipe Development Manual.  
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Getting Started 
To help you get started creating your area model, the sections that follow describe basic Equipment 
Editor concepts. It also introduces the sample application's equipment configuration, which is used as 
the basis for most examples in this manual. 

You can access the Equipment Editor application either from the Proficy Batch Execution WorkSpace 
or by double-clicking the Equipment Editor icon in the Batch Execution program group. Refer to the 
Application Guide for more information on using the Proficy Batch Execution WorkSpace. 

Understanding the Area Model  
The Equipment Editor is the application used to configure an area model. The area model contains 
configuration information for the equipment within an area. For each area model you create, the 
Equipment Editor creates a CFG file. 

For example, the DEMO.CFG file is the sample application's area model. This file contains all the 
equipment configuration information for the sample application's AREA1 area model.  

When you start the Batch Execution Server or the Recipe Editor, it loads the area model, which is 
referenced during recipe creation and batch execution. The Batch Execution Server reads the area 
model file once, at the time a batch is created in the Batch Execution Client. Likewise, the Recipe 
Editor reads the area model once when you first start the Recipe Editor.  

IMPORTANT: To view any changes you make to the area model while a batch is running, you need to 
shut down and restart the Server and Soft Phase Server. Similarly, if you make changes to the area 
model while the Recipe Editor is running, you need to shut down and restart the Recipe Editor in order 
to view the changes. 

Exporting and Importing Area Models  
The information within your project's area model is stored in binary format. You can export the area 
model to a text (.txt) or XML file. You could also modify this area model, and import the file back into 
the Proficy Batch Execution product.  

The Export command is available from both the Proficy Batch Execution Workspace and in the 
Equipment Editor. To access the Export command in the WorkSpace, on the Area menu choose Export 
and the format type (Text or XML). To access the Export command in the Equipment Editor, on the 
File menu click Export and the file type. 

Be aware that Import command is only available from the Equipment Editor. The Proficy Batch 
Execution WorkSpace does not display the Import option. To use the Import command in the 
Equipment Editor, on the File menu, click Import. 

IMPORTANT: You cannot merge area model files if you use default equipment IDs. This is because 
default IDs are not unique and the duplicate IDs will not appear in the merged area model. 
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The Equipment Editor Window  
The Equipment Editor provides an easy-to-use, graphical interface that includes features such as right 
mouse button support and toolbar buttons.   

The Equipment Editor window contains the following items:  

• Toolbar  

• Configured Classes window  

• Work Area  

• Location bar (not available when running the Equipment Editor from the Proficy Batch 
Execution WorkSpace)  

• Status bar (not available when running the Equipment Editor from the Proficy Batch 
Execution WorkSpace)  

• Proficy Batch Execution WorkSpace system tree (only available when running the Equipment 
Editor from the Proficy Batch Execution WorkSpace)  

Using the Navigation Tools  

The Equipment Editor contains several tools for navigating through the equipment hierarchy. The 
following table describes each tool.  

Use the... To... 

Up Arrow and Down Arrow buttons on the 
toolbar. 

Proficy Batch Execution WorkSpace system 
tree. 

Move up and down through the equipment 
hierarchy. 

Location bar. 

Status bar. 

View what level of the hierarchy you are 
currently in. 

Customizing the Window  

You can customize the window layout to best suit your needs. You can: 

• Resize and move the toolbar and configured classes window to different locations by selecting 
the tool and dragging it to the desired location.  

• Toggle the display of the toolbar, configured classes window, and location bar by selecting 
the appropriate command from the View menu.  
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Using the Toolbar  

The Equipment Editor toolbar provides a faster alternative to using most of the menu commands. To 
learn what each button does, position the cursor on a button. A ToolTip identifies each button's 
function.  

The following figure illustrates the Equipment Editor window from within the Proficy Batch Execution 
WorkSpace. 

 

Equipment Editor Window  

Prerequisites  
As you build the area model, it is important to keep in mind that you can only implement those features 
that have already been programmed in the process controller. The Equipment Editor does not allow 
you to define new equipment or phases; it simply provides a graphical, easy-to-understand 
representation of the existing equipment on the plant floor and the existing phase logic programmed in 
the process controller. All equipment definitions in the Equipment Editor must be compatible with how 
the equipment is programmed in the process controller. 



Equipment Configuration Manual  

17 

To configure the actual process requirements, you need to: 

• Understand the equipment you are defining. Refer to your plant's P&ID drawing.  

• Program the process controller with the Phase Logic Interface (PLI) and the project-specific 
phase logic. Refer to the PLI Development Manual and the Phase Programming Manual for 
more information.  

• Identify the tags your process requires. For example, if you are using iFIX, identify the 
database tags (PDB) that are required for your process. Note that Batch Execution lets you 
add tags to the iFIX database during area model configuration.  

• Obtain the following information for each unit and have it available during equipment 
configuration:  

• Unit's capacity and unit of measure  

• Unit Ready and Unit Priority tag names and addresses  

• Obtain the following information for each equipment phase and have it available during 
equipment configuration:  

• Tag names and addresses  

• Phase parameters defined in the phase logic  

• Request variables defined in the phase logic  

• Operator messages defined in the phase logic  

• Number of phase partners defined in the phase logic  

• Phase class type  

• Define the OPC servers for your process data. Refer to the System Configuration Manual for 
configuration instructions.  

See the Application Guide for an overview of Batch Execution development tasks. 

Introducing the Sample Application 
The equipment defined for the sample toothpaste application provides examples that you can view and 
explore in the Batch Execution Equipment Editor.  The following sections describe the sample 
application's equipment configuration: 

• Process and Instrumentation Drawing 

• Equipment Hierarchy 

• Execution Paths 

Process and Instrumentation Drawing  

Typically, a process engineer uses the plant's Process and Instrumentation Drawing (P&ID) as a 
reference when configuring the equipment. The Sample P&ID Drawing shown in the Equipment 
Hierarchy section is a P&ID representation of the equipment used in the sample application. 
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Equipment Hierarchy  

Based on the P&ID diagram in the following figure, the equipment hierarchy for the sample 
application is partitioned as follows: 

Area – The area name for the sample toothpaste application uses the default name, AREA1.  

Process Cell – AREA1 contains one process cell called TOOTHPASTE. This process cell 
contains all of the equipment required to make batches of toothpaste. 

Units – The TOOTHPASTE process cell contains three unit classes:  

This Unit 
Class... 

Defines these Unit Instances... 

MIXER MIX1, MIX2, MIX3 

REACTOR REACTPLAIN, REACTFLAVOR 

RAW WATER, BAKINGSODA, GUM, FLUORIDE, PH_ADDITIVE, 
FLAVORING, WHITENER 
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Sample P&ID Drawing 
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MIXER Equipment Phases  

As shown in the following figure, each instance of the MIXER unit class contains equipment-specific 
instances of the ADD_INGS, AGITATE, COOL, and XFER_OUT equipment phase classes. 

 

Sample MIXER Phases  

RAW Equipment Phases 

As shown in the following figure, each instance of the RAW unit class contains the XFER_OUT 
equipment phase. 

 

RAW Phases  

REACTOR Equipment Phases 

As shown in the following figure, each instance of the REACTOR unit class contains equipment-
specific instances of the XFER_IN and AGITATE equipment phase classes. 
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Sample REACTOR Phases  

Execution Paths  

The sample toothpaste application uses a multi-product, network path process cell. The equipment 
pathing defined for the sample application's process cell determines the valid batch execution paths. 
Batch Execution uses Active Binding to select the path at run-time. Refer to the Implementation 
Strategies section for more information on Active Binding. 

The execution flow for the sample toothpaste application is as follows: 

1. Transfer the base ingredients into a mixer where they are agitated. The base ingredients 
(water, baking soda, gum, fluoride, and Ph_additive) are on one header feeding MIX1, MIX2 
and MIX3.  

2. Transfer the additive ingredients into a mixer where they are agitated. The additive 
ingredients (flavoring and whitener) are on a second header that feeds into MIX2 and MIX3.  

3. Transfer the additive and base mixtures into one of the reactors where they are combined to 
produce the final product. All three mixers feed into the REACTFLAVOR unit while the 
REACTPLAIN unit is fed only by MIX1.  

NOTE: The REACTPLAIN unit is used when making a batch of the base mixture, without the additive 
ingredients. 

The following figures illustrate the possible execution paths for the sample toothpaste application. For 
information on configuring equipment paths, refer to the Configuring Equipment section. 
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The following figure illustrates the execution path when the Batch Execution Server selects MIX2 for 
the MAKE_BASE unit procedure and MIX3 for the MAKE_ADDITIVE unit procedure.  

 

Sample Execution Path Using MIX2 and MIX3 
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The following figure illustrates the execution path when the Batch Execution Server selects MIX2 for 
the MAKE_ADDITIVE unit procedure and MIX3 for the MAKE_BASE unit procedure. 

 

Sample Execution Path Using MIX2 and MIX3 
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The following figure illustrates the batch's execution path when the Batch Execution Server selects 
MIX1 for the MAKE_BASE unit procedure and MIX3 for the MAKE_ADDITIVE unit procedure.  

 

Sample Execution Path Using MIX1 and MIX3 
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The following figure illustrates the execution path when making a batch of toothpaste without the 
flavoring or whitener additives. This process requires the batch to use the REACTPLAIN unit. 
Therefore, the recipe author configures the recipe to select MIX1 for the MAKE_BASE unit 
procedure, because this is the only mixer connected to the REACTPLAIN unit. 

 

Sample Execution Path Using REACTPLAIN 

Task Overview: Equipment Configuration  
The following tasks are required to create an area model. Each task is described in detail in the 
upcoming sections. 

1. Configure an area.  

2. Configure enumeration sets and enumerations.  

3. Configure process cell classes and instances.  

4. Configure unit classes and instances.  

5. Configure equipment pathing within process cells.  

6. Configure equipment phase classes and equipment phases.  

7. Configure control modules as resources.  
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Configuring Enumerations 
The following sections provide information on how to configure and implement enumerations in your process. 

An enumeration is a process variable that is assigned an ordinal (numeric) value. These enumeration 
strings become easily-understandable choices for recipe authors and operators when setting values for 
phase parameters, phase reports, or unit tags. The enumeration string corresponds to the ordinal value 
that is used by the phase logic in the process controller.  

Typically, you use enumerations when the recipe author or operator needs to specify an ingredient 
type. The following table shows a FLAVORS enumeration set. The operator or recipe author only 
needs to select the appropriate flavor name; Batch Execution automatically supplies the corresponding 
numeric value required by the phase logic.  

FLAVORS Enumeration Set   

Enumeration string... Can correspond to ordinal value (used by phase logic)... 

WINTERGREEN 0 

SPEARMINT 1 

PEPPERMINT 2 

Valid entries for enumeration strings include:  A - Z,  0 - 9, and the underscore character. Enumeration 
strings should not contain spaces or these characters:  !@#$%^&*()  

Configuring and Implementing Enumerations 
Configuring and implementing enumerations spans several Batch Execution applications. These tasks 
are grouped into two categories: 

• Configuration tasks  

• Implementation tasks  

Configuration Tasks  

Configuring enumerations consists of the following tasks: 

1. In the Equipment Editor, define enumeration sets and enumerations based on the phase logic 
defined in the process controller.  

2. In the Equipment Editor, configure equipment phase parameters, equipment phase reports, 
and unit tags with an enumeration data type as appropriate.  

Refer to the Standard Equipment Phases section for information on configuring equipment phase 
parameters and equipment phase reports. 
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Implementation Tasks  

Once enumerations are configured, recipe authors can use them as follows: 

1. During recipe development, authors can select from a list of enumeration strings to assign 
phase parameter values to a recipe.  

2. During batch execution, operators can select from a list of enumeration strings to supply 
parameter values for a batch.  

Example: Configuring and Implementing Enumerations  

The following figure illustrates how enumerations are configured and implemented in the sample 
toothpaste application. In this example, the recipe author takes advantage of the flexibility built into 
the XFER_IN equipment phase. This phase uses a FLAVORS enumeration set, which enables the 
recipe formulator to build one recipe that can produce several flavors of toothpaste. Enumerations are 
used to select the appropriate flavor additive depending on the type of toothpaste being made. For 
example, if the operator selects WINTERGREEN as the ingredient, Batch Execution sends a value 0 to 
the phase logic, which instructs the phase logic to open the valve for the tank containing the 
WINTERGREEN flavoring.  
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Configuring and Implementing Enumerations  

Pre-Defined Enumeration Sets 
Batch Execution supplies two pre-defined enumeration sets: 

• PHASE_FAILURES enumeration set  

• UNIT_OF_MEASURE enumeration set  

The following subsections describe each enumeration set. 
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PHASE_FAILURES Enumeration Set  

The Equipment Editor supplies a pre-defined PHASE_FAILURES enumeration set. This enumeration 
set links to the failure register (PHASE_F) in the Phase Logic Interface (PLI). When a failure register 
is set, the Batch Execution Client's Alarm Summary window displays the failure register's associated 
enumeration string. 

It is recommended that you create enumerations specific to your process. For instance, the sample 
toothpaste application could include the following enumeration strings:  

Enumeration String... Can correspond to Ordinal Value (used by phase logic)... 

PHASE EXCEED TEMP 1 

AGITATE FAILED 2 

In the example above, when PHASE_F is set to 1, the string PHASE EXCEED TEMP is sent to the 
Alarm Summary window in the Batch Execution Client. 

NOTE: If you do not define any enumerations for the PHASE_FAILURES enumeration set, operators 
will see the following message when failures occur: 

CONFIG ERROR - 0 not defined in PHASE FAILURES enumeration set - unable 
to locate failure description: 10phase failed. 

UNIT_OF_MEASURE Enumeration Set 

The Equipment Editor supplies a pre-defined UNIT_OF_MEASURE enumeration set. Batch 
Execution supplies the most commonly used units of measure in this set. However, you can define 
additional units of measure required for your particular process. This enumeration set contains the 
following pre-defined units of measure:  

UNIT_OF_MEASURE Enumeration Set   

Standard Unit of Measure 

Metric (Mass) • Milligrams 

• Grams 

• Kilograms 

• Tonnes - 1000 KG 

US (Mass) • Ounces 

• Pounds 

• Tons - 2000 LB 
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UNIT_OF_MEASURE Enumeration Set   

Standard Unit of Measure 

Metric (Volume) • Milliliters 

• Liters 

• Kiloliters 

US (Volume) • Fluid Ounces 

• Pints 

• Quarts 

• Gallons 

Batch Execution uses the UNIT_OF_MEASURE enumeration set to assign units of measure to the: 

• Maximum equipment capacity for a unit. You define this capacity in the Equipment Editor.  

• Capacity requirement for a recipe's unit procedure. You define this requirement during recipe 
configuration in the Recipe Editor.  

• The default batch size defined for a recipe. You define this size during recipe configuration in 
the Recipe Editor.  

When assigning a unit of measure to these items, you can select from a predefined list. This ensures 
that the same units of measure are used across all Batch Execution applications. When specifying 
UOMs in the Equipment Editor, if the unit of measure does not exist in this list, you can add new units 
of measure to the UNIT_OF_MEASURE enumeration set. You can define any unit of measure 
required for your process. For example, you can define Packages, Pieces, Cartons, and so on.  

IMPORTANT: If you want Batch Execution to use equipment capacity as part of its Active Binding 
selection criteria, assign the same UOM to (1) all units within a unit class and (2) the unit procedure's 
capacity requirement. If the unit procedure's capacity requirement and the unit's capacity amount have 
different UOMs, Batch Execution ignores the unit's capacity amount during Active Binding. For 
details on configuring a unit's equipment capacity, refer to the Configuring Equipment section. 

Overview: Defining Enumerations 
Defining enumerations consists of:  

1. Defining enumeration sets (except when defining enumerations for the PHASE_FAILURES 
and the UNIT_OF_MEASURE enumeration sets).  

2. Defining enumerations strings and their corresponding ordinal values.  

NOTE: For existing enumeration sets, you can add new enumerations strings on the fly, while 
the Batch Server is running; you do not have to restart the Batch Server for your changes to 
be recognized. Saving the Equipment Model is all that is required. The new enumerations that 
you add do not apply to batches you already scheduled, only to new, subsequently added, 
batches. 
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You can only add a new enumeration to the set, not remove or modify an existing enumeration 
on the fly. For example, you cannot change the ordinal number or string name for an 
enumeration while the Batch Server is running and expect it to get applied without restarting 
the Server. If you want to delete an enumeration or change an existing one, you must stop and 
restart the Batch Server for your changes to get applied.  

For example, if your existing enumeration set is A = 0, B= 1, C =2, you can make the 
following type of changes while the Batch Server is running: A = 0, B = 1, C = 2, D = 3 (D 
added). But, these types of on the fly changes are invalid: A = 0, B = 1, C = 3 (value of C 
changed); A = 0, B = 1 (C removed).  

These limitations apply only to changes made to existing enumeration sets on the fly and not 
to changes made during configuration.   

Prerequisites  

Before defining enumerations, the following tasks must be complete: 

• The phase programmer must configure the phase logic to support enumerations.  

• The ordinal values you enter must match the values configured in the phase logic.  

NOTE: The UNIT_OF_MEASURE enumeration set does not require any programming in your phase 
logic.  

Overview: Maintaining Enumerations 
If necessary, you can modify and delete enumeration sets. You may need to perform one or more of the 
following maintenance tasks:  

• Modify enumeration set names.  

• Modify enumeration strings and their corresponding ordinal values.  

• Delete enumeration sets.  

• Delete enumeration strings and their corresponding ordinal values.  

NOTE: You cannot delete or rename the PHASE_FAILURES or the UNIT_OF_MEASURE 
enumeration sets. 

Important Information for Working with Enumerations 

For existing enumeration sets, you can add new enumerations strings on the fly, while the Batch Server 
is running; you do not have to restart the Batch Server for your changes to be recognized. Saving the 
Equipment Model is all that is required. The new enumerations that you add do not apply to batches 
you already scheduled, only to new, subsequently added, batches.  

You can only add a new enumeration to the set, not remove or modify an existing enumeration on the 
fly. For example, you cannot change the ordinal number or string name for an enumeration while the 
Batch Server is running and expect it to get applied without restarting the Server. If you want to delete 
an enumeration or change an existing one, you must stop and restart the Batch Server for your changes 
to get applied. 
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For example, if your existing enumeration set is A = 0, B= 1, C =2, you can make the following type of 
changes while the Batch Server is running: A = 0, B = 1, C = 2, D = 3 (D added). But, these types of 
on the fly changes are invalid: A = 0, B = 1, C = 3 (value of C changed); A = 0, B = 1 (C removed).  

These limitations apply only to changes made to existing enumeration sets on the fly and not to 
changes made during configuration.  

Maintenance Guidelines  

When you modify or delete enumerations that are currently used by equipment phases, you may need 
to re-configure the phase parameters.  

If you ... Then... 

Modify or delete an enumeration string 
that is used as the default value for an 
equipment phase parameter. 

You must modify the equipment phase parameter to 
use a new default enumeration string. 

Delete an enumeration set that is used by 
any equipment phase. 

The data type of the affected equipment phase 
parameters, tags, and reports changes from 
enumeration to integer. 

Modify or delete a unit of measure that is 
assigned to a: 

Unit's equipment capacity. 

Unit procedure's minimum equipment 
capacity. 

Recipe's default batch size. 

You must change the assigned unit of measure to 
one that exists in the UNIT_OF_MEASURE 
enumeration set.  

NOTE: Batch Execution displays the Enumeration Set Modification dialog box that describes the tags, 
parameters, and reports that will change based on modification of the selected enumeration set. 

Configuring Equipment 
The sections that follow describe how to configure areas, process cells, and units in the Batch 
Execution Equipment Editor. Before you begin defining this equipment, you need to have a complete 
understanding of the physical layout of the equipment in your plant. All definitions in the Equipment 
Editor must match the physical equipment in your plant. Refer to your plant's P&ID drawing, if 
necessary. 
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Overview: Configuring Equipment  
The steps that follow describe how to define an area model. 

To define an area model:  

1. Define an area to represent the area model for your plant.  

2. In the area, define one or more process cells to contain the equipment to produce a batch of 
your product.  

3. In the process cell, define the units that reside in the process cell.  

4. Define the physical connections between units within the process cell.  

5. For each unit, define the equipment phases that execute on the unit.  

For information on equipment phases, refer to the Standard Equipment Phases section. 

Defining an Area  
An area represents a physical, geographical, or logical grouping of equipment. In Batch Execution, an 
area can contain the following equipment: 

• Process cells  

• Units  

• Equipment phases  

• Control modules  

In Batch Execution, the equipment defined within an area is called the area model. Recipes are built 
and executed based on the equipment defined in a specific process cell within the area model. An area 
model contains all of the equipment necessary to produce all products at a plant. 

When you start the Equipment Editor or you define a new project, Batch Execution automatically 
creates a default empty area called AREA1. This provides a starting point for all equipment definitions 
in this area. You may, however, want to change the name of the area based on your plant's needs. 

Example: Area Model  

Typically, you define one area model that contains all of the equipment at your plant. For example, the 
sample plant, which can produce both toothpaste and mouthwash, is represented by one area model 
called AREA1. This area model contains the equipment required to produce both products.  

Defining Process Cells 
Depending on how your equipment is partitioned, you can define one or more process cells in your 
area model. A process cell consists of all the production and supporting equipment necessary to make a 
batch. It may include one or more production lines, which are used to produce more than one product. 
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For more information on partitioning process cells, refer to the Implementation Strategies section. 

Overview: Configuring Process Cells  

The steps that follow explain how to configure process cells. 

To configure a process cell:  

1. Define a process cell class and specify the icon and class name for the process cell.  

2. Define a process cell and specify the cell instance name and optionally, equipment arbitration 
information.  

3. Optionally, specify the iFIX picture associated with the process cell.  

Example: Process Cells  

Using the sample toothpaste application as an example, the AREA1 area contains the process cell class 
called TOOTHPASTE. The TOOTHPASTE process cell contains all the equipment necessary to make 
all flavors of toothpaste. 

Defining more than one process cell may be appropriate if your plant makes multiple products that 
share some, but not all, equipment in an area. For example, if the sample plant produced toothpaste and 
mouthwash, it is likely that some equipment may be shared across the two processes. In this case, you 
could create two process cells, one containing the equipment to produce toothpaste and another 
containing the equipment to produce mouthwash. However, if the majority of the equipment is shared, 
then it may still be appropriate to just have one process cell for both products. 

Defining Units 
A unit is a major piece of equipment in a process cell that performs a specific task. It consists of all the 
equipment and control modules that a unit needs to perform this task. An integral part of your control 
strategy is defining what pieces of equipment make up a unit. This strategy should be defined before 
you begin configuring units in your plant.  

Design Strategies  

There are several strategies to consider when designing your units:  

Class-Based Units 

If you have several similar units in your plant, you may want to implement a class-based unit strategy. 
This strategy lets recipe authors build class-based recipes.  

Equipment Pathing  

Once you have defined your units, you can define the physical connections between the units. Batch 
Execution can use these connections to ensure that a batch executes on a valid path.  
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Equipment Capacity  

For each unit instance, you can define the maximum capacity that the unit can contain, transfer, or 
process during production. Recipe authors can then indicate the minimum capacity required for a unit 
procedure and Batch Execution will ensure that an appropriate unit is selected during batch production.  

Unit Ready and Unit Priority Tags  

You may want to incorporate Unit Ready and Unit Priority tags into your process to prevent the 
allocation of unavailable or undesired units to batches. 

For more information on implementing these strategies, refer to the Implementation Strategies section. 

Overview: Configuring Units  

Configuring units consists of the following tasks:  

1. Create a unit class for each class of unit in your plant; for example, mixers, heaters, and 
reactors.  

2. For each unit class, define the class properties including the class name and icon.  

3. Create a unit instance for each physical unit in the appropriate process cell.  

4. For each unit, define the unit properties including the name, equipment capacity, and 
arbitration information.  

5. Optionally, specify the iFIX picture associated with the unit.  

6. Optionally, use the Link tool to draw connections between physically connected units to form 
an equipment path.  

7. If appropriate, define unit tags. Refer to the Advanced Topics section for information on unit 
tags.  

8. If the unit is shared by another process cell, share the unit. Refer to the Advanced Topics 
section for instructions on sharing equipment.  

Example: Configuring Units  

The TOOTHPASTE process cell in the sample application contains twelve units. In the Equipment 
Editor, the units are configured as follows:  

• A RAW unit class is defined for seven storage tanks.  

• A MIXER unit class is defined for three mixers.  

• A REACTOR unit class is defined for two reactors.  

Individual instances of each unit class are created to represent the physical equipment in the plant: 

• Seven instances of the RAW class are defined as WATER, BAKINGSODA, FLUORIDE, 
WHITENER, GUM, PH_ADDITIVE and FLAVORING.  

• Three instances of the MIXER class are defined as MIX1, MIX2, and MIX3.  

• Two instances of the REACTOR class are defined as REACTFLAVOR and REACTPLAIN.  
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The following figure illustrates the unit classes and instances in the TOOTHPASTE process cell. 

 

Sample Application Unit Configuration 

Configuring Equipment Pathing  

Once you have added units to your process cell, you can link physically connected units to form one or 
more equipment paths within a process cell. You configure these connections graphically using the 
following tools: 

Link Units tool – puts you in linking mode and allows you to draw the links between physically 
connected units. 

Manifold tool – drops in a manifold that lets you connect multiple units together. 

Understanding Origin and Destination Units  

A connection between two units results in both an origin and a destination unit. This determines the 
direction of the connection. For example, if a reactor feeds into a fermentor, the reactor is the origin 
unit and the fermentor is the destination unit. If the fermentor can also feed into the reactor, you must 
draw another connection where the fermentor is the origin unit and the reactor is the destination unit. 
The following figure illustrates this configuration.  
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Connecting Origin and Destination Units 

Using Manifolds  

Manifold objects: 

• Let you easily connect multiple units.  

• Can be configured as a common resource.  

For example, assume that your plant contains a manifold that is a single pipe with inlets fed from two 
material tanks, TANK1 and TANK2, and outlets feeding into two mixers, MIX1 and MIX2. Assume 
that you only want one tank feeding into a mixer at one time. You can configure the manifold as a 
common, exclusive-use resource that is allocated to the transfer out phase on each tank. The following 
figure illustrates this example: 

 

Using Manifolds 
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You can also configure the connection lines as common resources. For more information on configuring 
manifolds and connection lines as common resources, refer to the Advanced Topics section. 

Example: Equipment Pathing  

Configuring equipment paths ensures that the units selected for a batch are within a valid execution 
path. For example, in the sample toothpaste application, if MIX2 and MIX3 are selected for the 
MAKE_BASE and MAKE_ADDITIVE unit procedures, then Batch Execution determines that it must 
select the REACTFLAVOR reactor for the MAKE_FINAL unit procedure because neither MIX2 nor 
MIX3 are connected to the REACTPLAIN unit. The following figure illustrates this execution path. 

 

Sample Execution Path 

Refer to the Implementation Strategies section for more information on equipment paths. 

Defining a Unit's Equipment Capacity  

For each unit instance, you can define the unit's equipment capacity. You specify this value as an 
amount and a unit of measure to represent the maximum capacity that the unit can contain, transfer, or 
process during production. The capacity amount for a unit coupled with the minimum capacity 
requirement defined for a recipe's unit procedure ensures that only those units with the required 
capacity are allocated to batches. 
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Configuration Guidelines 

Use the following guidelines to define a unit's equipment capacity: 

• Unit instances within the same class can have different capacity amounts. For example, you 
may have two mixers of the same class; however, one may hold 600 Liters and the other may 
hold up to 1000 Liters.  

• You can select the unit of measure (UOM) for the capacity amount from a pre-defined list. 
The entries in this list are defined in the UNIT_OF_MEASURE enumeration set. If the 
required UOM is not in this list, you can add new units of measure to this enumeration set.  

• If you want Batch Execution to consider unit capacity as part of its unit selection criteria, 
assign the same UOM to:  

• All units within the same unit class.  

• The unit procedure's minimum capacity requirement.  

IMPORTANT: If a unit has a different UOM than the UOM specified for the unit procedure's capacity 
requirement, Batch Execution ignores the unit's capacity amount as part of the selection criteria. 

Example: Equipment Capacity and Unit of Measure  

Assume the capacities listed in the following table are defined for the units within the MIXER class.  

Sample Unit Capacities for MIXER Class of Units   

Unit Instance Capacity Amount Capacity UOM 

MIX1 2000 Liters 

MIX2 1000 Liters 

MIX3 1000 Liters 

Now, assume that the MAKE_BASE unit procedure has the equipment requirements listed in the 
following table.  

Sample Unit Procedure Equipment Requirements   

Unit 
Class 

Bind Type Minimum Capacity 
Amount 

Minimum Capacity 
UOM 

MIXER Automatic 2000 Liters 

Using the configurations in the previous two tables, Batch Execution sees that MIX1 is the only unit 
within the MIXER class that meets the minimum capacity requirement defined for the unit procedure. 
Assuming all other criteria are met, Batch Execution will allocate MIX1 to the unit procedure. 
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Now, assume that a different UOM is assigned to the MIX3 unit in the MIXER class, as shown in the 
following table.  

Sample Unit Capacities for MIXER Class of Units   

Unit Instance Capacity Amount Capacity UOM 

MIX1 2000 Liters 

MIX2 1000 Liters 

MIX3 1000 Pounds 

Using the configurations in this table, Batch Execution ignores the capacity setting for MIX3 because 
the UOM is different from the unit procedure's capacity requirement (Liters). Therefore, Batch 
Execution considers MIX3 a valid unit even though it may not be large enough to handle the unit 
procedure. Batch Execution will allocate either MIX1 or MIX3 based on other selection criteria, such 
as equipment pathing and the unit's equipment status. 

Understanding Unit Tags  

Unit tags are tags that are associated with a unit, such as temperature and level indicators. Unit tags, 
accessible to all phases on that unit, are typically used to implement class-based recipes.  

Batch Execution also supplies two pre-defined unit tags, UNIT_READY and UNIT_PRIORITY, 
which Batch Execution uses to check a unit's equipment status during Active Binding. 

For more information on configuring and using unit tags, refer to the Advanced Topics section. For 
more information on Active Binding, refer to the Implementation Strategies section. 

Standard Equipment Phases 
=Phases configured in the Equipment Editor are equipment-centric, meaning that you are not defining 
the control logic for the phase; instead, you are configuring the equipment on which the equipment 
phase executes. This type of phase is called an equipment phase. The actual control logic for an 
equipment phase resides in the process controller, not in the Equipment Editor.  

Your task in the Equipment Editor is to create a representation of each equipment phase in the process 
controller and tie it to the equipment on which the equipment phase executes. In order to do this, you 
must have a complete understanding of how the equipment phases are programmed in the process 
controller. 
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Prerequisites  
Before you can begin configuring equipment phases, gather the following information, as appropriate, 
about how the phase logic is programmed in the process controller: 

• The equipment phase parameters required by the phase logic, including the parameter IDs, 
data types, and high and low limits.  

• The equipment phase reports required by the phase logic, including the report IDs and data types.  

• The operator messages required by the equipment phase, including the message ID.  

• The number of phase partners required by the phase logic.  

• The number of requests required by the phase logic.  

• The phase class type.  

• The I/O address for each equipment phase tag. If you are using the iFIX database, tag 
addresses reference a node.tag.field.  

Understanding How Standard Equipment Phases Work  
In the Equipment Editor or WorkSpace, you configure equipment phases at two levels: 

Equipment Phase Class – defines generic information that applies to all instances of this phase. 
This generic information includes the parameters, reports, and operator messages required 
by the equipment phase. 

Equipment Phase – defines the equipment-specific instance of an equipment phase and ties the 
equipment phase to the physical equipment (a unit) by specifying the equipment phase tags.  

The following figure illustrates how the AGITATE equipment phase in the sample toothpaste 
application is configured. In this example, three equipment-specific instances of the AGITATE 
equipment phase class are configured and tied to the physical equipment in the plant. 

 

Sample AGITATE Phase Configuration  
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Overview: Configuring Standard Phases 
The following illustration provides an overview on how to configure a standard phase in the Proficy 
Batch Execution WorkSpace or Equipment Editor. 
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Standard Phase Template  

The Standard Phase Template allows you to change the default tag settings. The equipment tags for a 
standard phase include: Command, Failure, Owner, Pause, Paused, Request, Single Step, Status, Step 
Index, Unit, Parameter, Report, and Request Tags. You can configure the default node name, tag name, 
and tag type for each tag. 

By changing the default tags to your custom settings, creating and maintaining batch projects with lots 
of equipment phases can be easier and faster. If you enter your default settings into the template when 
you first create your project, you will not need to edit each tag individually when you add a new phase 
to your project, especially if you are using iFIX as your SCADA software.  In the iFIX product, the 
tags are formatted as Node.Tag.Field. 

Any modifications you make to the Standard Phase Template apply to standard phases you add to your 
project after making the template updates. The values that you enter into the template do not change 
the equipment phase tags in pre-existing equipment phases. 

To access the Standard Phase Template dialog box from the Edit menu, click Tag Template. The 
following figure illustrates an example of this dialog box. 

 

Standard Phase Template Dialog Box 

Only the first Node field is available for editing in this dialog box. When you edit the Node field for 
the Command tag, all tags are automatically populated with the name you enter. This is because all 
tags for a phase must have the same node name. If you select the Use Server Alias button, all of the 
Server name fields are filled with the "#ALIAS#." text. The #ALIAS# syntax allows you to use the 
Alias configured in the Create OPC Server dialog box. 
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Be aware that you cannot edit the Phase field from the Standard Phase Template dialog box. The Phase 
name field is just a placeholder for information that gets added when you actually add the phase; the 
Phase name field gets modified when you add or modify equipment phases in the Equipment Editor or 
WorkSpace.   

For example, with the entries for the Standard Tag Template above, the Command tag for a phase 
named AIR3 appears like this in the Edit Equipment Phase dialog box: 

 

In this example, the PHASE field gets replaced with AIR3. The _VC represents the tag name (the third 
column in the template), and A_CV represents the tag type (the fourth column). In iFIX, _VC represents 
the PLI command register and A_CV represents the current value of a block displayed as text. 

For an example of using the Standard Phase Template dialog box with Proficy Process Systems, refer 
to the More on the Standard Phase Template section. 

Standard Phase Class Properties 
For each phase class, you can configure the following class properties: 

• Parameters  

• Reports  

• Operator messages  

• Number of requests  

• Number of phase partners  

• Type  

The class properties apply to all instances of the equipment phase and are tied to the physical 
equipment by specifying the equipment phase tag address for each property. 

Parameters  

Equipment phase parameters specify values that the Batch Execution Server downloads to the phase 
logic in the process controller. Registers in the process controller store these values that the phase logic 
uses to ultimately control the equipment. Recipes can specify parameter values, or Batch Execution 
can request the operator to specify parameter values at run-time.  

IMPORTANT: Be aware that phase parameters for Batch Direct phases are only downloaded at the 
start of a phase. 
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You define phase parameters in the equipment phase class. For each parameter you define, the 
Equipment Editor creates a corresponding parameter index tag in the equipment phase instance. For 
example, assume that you define two phase parameters (SPEED and TIME) for the AGITATE phase 
class. For each instance of the AGITATE phase, Batch Execution creates two parameter tags. You can 
then configure each parameter tag in the equipment phase instance by associating the parameter tag 
with an I/O address:  

This parameter 
name and ID... 

Corresponds to this 
parameter tag index... 

And corresponds to an I/O 
address such as... 

Name: SPEED 

ID: 10 

PARMTR01 FIX.SPEED.F_CV 

Name: TIME 

ID: 25 

PARMTR02 FIX.TIME.F_CV 

Parameter Data Types  

You must specify the parameter data type as it corresponds to the phase logic in the process controller. 
You can specify the following data types: 

• Real  

• Integer  

• String  

• Enumeration  

If the parameter has an enumeration data type, you must configure enumeration sets. Refer to the 
Configuring Enumerations section for more information. 

Scaling Parameters  

Batch Execution lets you enable scaling for phase parameters with an integer or a real data type. 
Scaling should only be enabled if it is appropriate. Typically, you may want to enable scaling for 
parameters that specify an ingredient amount. For information on configuring scalable parameters, 
refer to the Advanced Topics section. 

Example: Equipment Phase Parameters 

In the sample application, the AGITATE equipment phase class contains the following equipment 
phase parameters: 

• SPEED specifies the agitation speed.  

• TIME specifies the duration of time to agitate.  
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Phase Reports  

You typically use phase reports to report the actual process values or batch values used by the 
equipment phase. Registers in the process controller store these values. After a phase completes, the 
phase logic in the process controller uploads report values to the Batch Execution Server.  

IMPORTANT: Be aware that for Batch Direct phases the phase reports are only uploaded upon 
completion of a phase. 

You define phase reports in the equipment phase class. For each report you define, the Equipment Editor 
creates a corresponding report index tag in the equipment phase instance. For example, assume that you 
define two phase reports (ACT_SPEED and ACT_TIME) for the AGITATE phase class. For each instance 
of the AGITATE phase, Batch Execution creates two report tags. You can then configure each report tag in 
the equipment phase instance by associating the report parameter tag with an I/O address:  

This report name 
and ID... 

Corresponds to this report 
tag index... 

And corresponds to an I/O 
address such as... 

Name: ACT_SPEED 

ID: 12 

REPORT01 FIX.ACTSPEED.F_CV 

Name: ACT_TIME 

ID: 14 

REPORT02 FIX.ACTTIME.F_CV 

Phase Report Data Types  

You must specify the report data type as it corresponds to the phase logic in the process controller. 
You can specify the following data types: 

• Real  

• Integer  

• String  

• Enumeration  

If the report has an enumeration data type, you must configure enumeration sets. Refer to the 
Configuring Enumerations section for more information. 

Example: Phase Reports  

In the sample application, the COOL equipment phase class contains the COOL_TEMP phase report. 
The phase logic records the actual settings and then uploads them to the Batch Execution Server where 
they can be analyzed. 

Operator Messages  

You can program the phase logic in the process controller to make a request to send a message to the 
operator.  
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Operator messages are: 

• Displayed to the operator when the phase is executed manually by the operator.  

• Sent to the batch event journal. Every batch produces a batch event journal file. This file is in 
ASCII format and is accessed from the Batch Execution Client.  

You must configure the operator messages required by the phase as follows:  

• Define the text of the message and its associated message ID as defined in the phase logic.  

• For each operator message you enter, increment the Request tag number by one.  

Example: Operator Messages  

For example, assume that you want to configure operator messages for the Agitate phase. To do so: 

• The phase logic programmer needs to define Send Message requests in the Agitate phase 
logic in the process controller. For more information on programming requests in the phase 
logic, refer to the Phase Programming Manual.  

• In the Equipment Editor for the Agitate phase class, define the text of the messages that will 
be displayed to the operator and sent to the event journal.  

In the following figure, the Agitate phase requests the Batch Execution Server to send the 
STARTING_AGITATE message when the phase begins execution. When the phase completes, the 
phase requests the Batch Execution Server to send the AGITATE_COMPLETE message. 

 

Sending Operator Messages 
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Phase Partners  

Phase partners are phases that communicate with other phases. During equipment phase class 
configuration, you must specify the number of partners with which the phase can communicate. Based 
on the number of partners you specify, the recipe author can build a phase link group, which lists the 
phases in the recipe that can communicate with each other. 

Typically, a phase link group contains phases that must be synchronized. For example, you may want 
to synchronize transferring material out of one unit and into another. The synchronization is 
programmed in the phase logic by sending a message from one phase to another. When the message is 
received by its phase partner, the phases are synchronized and the phases can begin execution.  

Requests  

In addition to downloading phase parameter values, uploading phase report values, and sending 
operator messages, Batch Execution provides a series of request functions. These functions enable the 
phase logic to request the Batch Execution Server to perform specific actions, such as acquiring and 
releasing equipment and sending phase messages. If the phase logic is programmed with any of these 
additional requests, you must perform the following tasks: 

• In the equipment phase class property settings, you must specify the number of requests 
required by the phase. A Request Data register is created for each request. Refer to the 
equipment phase tags table in the Tying Standard Phases to Equipment section for more 
information on the phase tags.  

• In the equipment phase, tie each Request Data register to the I/O address.  

For more information on programming requests in the phase logic, refer to the Phase Programming 
Manual. 

Tying Standard Phases to Equipment 
In Batch Execution, you tie equipment phases to the equipment by specifying the equipment-specific 
addresses for ten standard tags plus any parameter, report, and request tags required by the phase. By 
specifying these tags, you are configuring a unit's equipment phase. The Phase Logic Interface (PLI) 
requires these tags. The PLI is programmed in the process controller and provides a standard interface 
between the Batch Execution Server and the equipment phase. For more information on programming 
the PLI, refer to the PLI Development Manual. The following table describes each tag. 

Equipment Phase Tags   

Equipment 
Phase Tag 

Equivalent PLI 
Register 

Description 

COMMAND Command Register 
(PHASE_VC) 

Commands a phase to transition from one state to 
another. 

FAILURE Failure Register 
(PHASE_F) 

Indicates whether a failure has occurred. When the 
register is set to 0, no failure has occurred. 
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Equipment Phase Tags   

Equipment 
Phase Tag 

Equivalent PLI 
Register 

Description 

OWNER Owner Register 
(PHASE_W) 

Indicates whether Batch Execution or an external 
interface is commanding the phase. 

PARMTR0n Parameter Value 
Register 
(PHASEP0n) 

Stores parameter values that are downloaded to the 
phase logic. 

REQUEST Request Register 
(PHASE_RQ) 

Initiates a request from phase logic to the Batch 
Execution Server. 

REQUST0n Request Data 
Register 
(PHASEQ0n) 

Specifies additional information about the request. 

REPORT0n Report Value 
Register 
(PHASER0n) 

Stores report values, which are uploaded to the Batch 
Execution Server. 

PAUSE Pause Register 
(PHASE_P) 

Allows the equipment phase to pause at the next 
programmed transition.  

PAUSED Paused Register 
(PHASE_PD) 

Indicates that the equipment phase has paused at the 
programmed transition. 

STATUS Status Register 
(PHASE_ST) 

Indicates the state of the equipment phase. 

SINGLE STEP Single Step 
Register 
(PHASE_SS) 

Indicates when the equipment phase is in single step 
mode. Single step mode causes the equipment phase to 
transition to the next programmed pause and waits for 
the operator to issue a resume command. 

UNIT Unit Register 
(PHASE_UN) 

Indicates the current unit.  

STEP INDEX Step Index Register 
(PHASE_SI) 

Indicates the step index of the equipment phase. 
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Understanding Data Servers  

Before you can tie equipment phases to equipment, you must configure a process data server. Batch 
Execution supports OPC data servers. The OPC data server lets you retrieve data from your iFIX 
process database or any OPC-aware process hardware. OPC (OLE for Process Control) defines 
standard objects, methods, and properties for meeting the interoperability requirements of real-time 
process automation applications. For information on configuring OPC servers, refer to the System 
Configuration Manual.  

The following figure illustrates the layers of communication when using OPC to retrieve data from 
iFIX. 

 

OPC Communication  

Assigning iFIX Database Tags to Equipment Phases  

Batch Execution lets you assign iFIX database tags to Batch Execution equipment phase tags. The 
table that follows after the general guidelines lists the recommended tag types and EGU ranges to 
assign to Equipment Phase tags.  

General Guidelines 

The following are general guidelines regarding the information in the following table. 

• You can replace any tag recommended as AR with an AO/AI pair of tags. In the Equipment 
Editor you would specify the AO tag.  

• You can replace any tag recommended as DR with a DO/DI pair of tags. In the Equipment 
Editor, you would specify the DO tag.  
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• You can replace any digital tag type with an analog tag type.  

• Certain tag values and EGU ranges are specified as "project-specific." This means that the tag 
type or EGU range you assign depends on your particular application.  

Recommended iFIX Tag Types and EGU Ranges   

Equipment 
Phase Tag 

Equivalent 
PLI Register 

Possible 
Values 

Possible 
Tag Type 

Recommended EGU 
Range 

COMMAND Command 
Register 
(PHASE_VC) 

Project-
specific 

Analog 
Input (AI) 

0 – 65,535 

Batch Execution uses 
the upper byte of the 
command register for 
sequencing information. 
The recommended EGU 
range reflects this.  

FAILURE Failure 
Register 
(PHASE_F) 

Project-
specific 

Analog 
Input (AI) 

0 – 65,535 

OWNER Owner Register 
(PHASE_W) 

0 – 1  Digital 
Input (DI) 

0 – 1 

PARMTR0n Parameter 
Value Register 
(PHASEP0n) 

Project-
specific 

Analog 
Input (AI) 
or Analog 
Register 
(AR) 

Project-specific 

REQUEST Request 
Register 
(PHASE_RQ) 

0 – 8,000 Analog 
Input (AI) 

0 – 65,535 

REQUEST0n Request Data 
Register 
(PHASEQ0n) 

0 – 8,000 Analog 
Input (AI) 

0 – 65,535 

REPORT0n Report Value 
Register 
(PHASER0n) 

Project-
specific 

Analog 
Input (AI) 

Project-specific 

PAUSE Pause Register 
(PHASE_P) 

0 – 1  Digital 
Input (DI) 

0 – 1 
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Recommended iFIX Tag Types and EGU Ranges   

Equipment 
Phase Tag 

Equivalent 
PLI Register 

Possible 
Values 

Possible 
Tag Type 

Recommended EGU 
Range 

PAUSED Paused 
Register 
(PHASE_PD) 

0 – 1  Digital 
Input (DI) 

0 – 1 

STATUS Status Register 
(PHASE_ST) 

0 – 100 Analog 
Input (AI) 

0 – 65,535 

SINGLE 
STEP 

Single Step 
Register 
(PHASE_SS) 

0 – 1  Digital 
Input (DI) 

0 – 1 

UNIT Unit Register 
(PHASE_UN) 

Project-
specific (This 
value is the 
equipment ID 
assigned to 
the unit.) 

Analog 
Input (AI) 

0 – 65,535 

STEP INDEX Step Index 
Register 
(PHASE_SI) 

Project-
specific 

Analog 
Input (AI) 

0 – 65,535 

NOTE: GE recommends the use of Analog Input (AI) blocks. 

Browsing and Adding Tags to iFIX Databases  

Batch Execution lets you browse through and select tags from multiple iFIX databases. If the tag does 
not exist in the database, Batch Execution lets you add a new tag to the database whenever you enter 
an undefined tagname. For example, as you configure an equipment phase and assign a tagname to the 
Command register, you can add the target tag to the database and place it on scan without having to 
exit the Equipment Editor application. 

For more information on the iFIX database, refer to the iFIX Building a SCADA System manual. 

Batch Direct Equipment Phases 
With Batch Direct phases, the PLI logic is built directly into the phase and maintained by the Batch 
Execution Server. This PLI logic provides a standard interface between the Batch Execution Server 
and the equipment phase. What that means, is that you can use Batch Direct phases to directly 
communicate with existing PLC programs located on your process controllers, without having to 
rewrite any additional PLI logic. With Batch Direct phases, you have a simpler interface to the process 
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controller. 

In your Proficy Batch Execution projects you can: 

• Choose to use only Batch Direct phases in your projects. For instance, for smaller Batch 
Execution systems that do not require full PLIs, using the simpler batch direct phases can save 
implementation time. 

• Use Batch Direct phases along-side standard equipment phases in new or existing projects. 
This also can reduce your project complexity and implementation costs, by allowing you to 
reuse older projects without extensive control logic changes. 

• Maintain the standard Batch Execution System (BES) functionality with seamless integration 
of the Batch Direct phases within your batch applications. For instance, when developing 
Batch Direct phases, a simple sigma icon denotes a batch direct phase in the WorkSpace or 
Recipe Editor. Also, the look and feel of the operator screens in the Client is virtually the 
same for both batch direct and standard phases. 

Prerequisites 
Before using Batch Direct phases in your project, you need to have an understanding of your control 
logic. Gather the following information, as appropriate, about how the phase logic is programmed in 
the process controller: 

• The equipment phase parameters required by the phase logic, including the parameter IDs, 
data types, and high and low limits. 

• The equipment phase reports required by the phase logic, including the report IDs and data 
types. 

• The I/O addresses required for each equipment phase tag, as well as for the Enter, Exit, and 
Status tags for Batch Direct phases and their values. 

For each Batch Direct phase, there are six state blocks and six equipment phase tags available. Only 
the Running state block is required, however. You may decide to include more than just the Running 
state block. Knowing beforehand what state blocks and equipment phase tags that you want to 
configure in each Batch Direct phase will assist you in batch project development. 

Although you do not need to know how to program the phase logic, you still need to be familiar with 
the I/O memory addresses in the controller (or how to access these addresses through your controller 
software) to configure tags in your Batch Direct phases and configure the expected values that are 
required for each state block. 

With proper preparation, tag names for each state in your Batch Direct phase can be configured to 
match the ones in your process control software. By using the same naming convention, you can 
simplify your project further. 

What You Need to Know About State Blocks... 

The six state blocks for Batch Direct phases include: 

• Running 

• Holding 
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• Held 

• Restarting 

• Stopping 

• Aborting 

For each of enabled state blocks, you can enter the Enter, Exit, and Status tags (memory addresses in 
the process controller) and the corresponding values, if there are deviations from the default. The 
default value for each tag is 1. For the active level, the acceptable values are 0 to 65,534. For the 
inactive level, the acceptable values are any value other than the value chosen for the active level. You 
need to determine what values you need, and what their memory addresses are in the process 
controller. 

IMPORTANT: For the Enter, Exit and Status tags, GE strongly recommends using Unsigned Integer 
as the data type for the destination addresses in the process controller. Use of any other data type may 
yield unexpected and inconsistent Batch Direct phase results. 

For example, if you are using an iFIX database, the I/O addresses for the tags use the format of 
Node.Tag.Field. For example, for the Running state block for the Enter tag in the iFIX database, the 
I/O address might look something like this: NODE1.PHASE1_RE.F_CV. Addressing is specific to the 
controller and you must have familiarity with your controller.  

These two examples highlight some of the differences that you can encounter. However, the I/O 
address format is specific to your controller. Therefore, it is imperative that you know what the 
addresses are, and their format. 

What You Need to Know About Standard Equipment Tags... 

The six standard equipment tags for Batch Direct phases may include: 

• Failure 

• Pause 

• Paused 

• Single Step 

• Step Index 

• Unit 

For each tag that you choose to enable in your Batch Direct phase, you must enter a memory I/O 
address from the process controller. You must know this value, or how to access it from the process 
controller software. 

Standard PLI Structure vs. Batch Direct PLI Structure 
With Batch Direct phases, the PLI functionality is split between the Batch Execution System (BES) 
and the control logic. The figures that follow explain where these splits occur – in both the standard 
and Batch Direct phases. 
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Standard PLI Structure 

The following illustration depicts the standard PLI structure, without the Batch Direct functionality. In 
this figure you find both the PLI and equipment phase logic located on the controller (the middle two 
rectangles). 

 

Batch Direct PLI Structure 

The following illustration depicts the Batch Direct PLI structure. In this figure, you find the PLI 
located on the same computer as the Batch Execution Server, while only the equipment phase logic 
runs on the controller (the third rectangle). 



 

56 

 

Differences Between Direct and Standard Phases 
Unlike standard phases, Batch Direct phases do not support: 

• Message Requests 

• Soft Phase Server 

Since message requests are not supported, this also means that: 

• Batch direct phases do not support message partners. 

• Batch direct phases do not support electronic work instructions (EWIs). 

• Phase parameters are only downloaded at the start of a phase. 

• Phase reports are only uploaded upon completion of a phase. 

The way in which you configure Batch Direct phases in the Batch Equipment Editor or WorkSpace is 
very similar to standard equipment phase configuration. The only difference in the phase class dialog 
box is that instead of an Operator Messages tab, an Enable Tags tab appears, as shown in the following 
figure. 
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Edit Direct Equipment Phase Class Dialog Box 

For each state block enabled in the above dialog box, you configure the Enter, Exit, and Status tags and 
their values when you create the Batch Direct phase instance. The following figure shows an example 
of how you configure these tags for a state block. This example shows the tags for the Aborting state 
block. The Enter tag is configured with a specific address and value, the Exit tag is configured to be 
the inverse of the Enter tag, and the Status tag is configured to be the same as the Enter tag. 

Be aware that as a batch developer, the only visible change in your area model view will be the 
appearance of a sigma symbol in the upper left corner of your Batch Direct phase icon. In the Client, 
the changes are even more subtle. A user can only see a difference in the SFC screen, for instance, if 
you named your phase as a Batch Direct phase (using a specific naming convention). 

One Tag Example 

The following dialog box shows an example of the Running state with the Enter, Exit, and Status tags 
configured as the same tag. 
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Edit Direct Phase Tags Dialog Box, 1 Tag Example 

In this example, when the Enter phase starts, all parameters are downloaded, and then a 1 is written to 
the Enter tag. The phase logic executes and the phase state should go to Running. When the phase has 
run to completion, the phase logic must write a value not equal to 1 to the Status tag. The Server will 
detect this as completed phase and upload all configured report tag values. Finally, the Server will 
write a 0 to the Exit tag. 

Three Tags Example 

The following dialog box shows an example of the Running state with the Enter, Exit, and Status Tags 
as unique tags. 
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Edit Direct Phase Tags Dialog Box, 3 Tags Example 

In this example, when the Enter phase starts, all parameters are downloaded, and then a 1 is written to 
the Enter tag. The phase logic executes and writes a 12 to the Status tag. The phase state should then 
go to Running. When the phase logic has run to completion, the phase logic must then write a value 
other than 12 to the Status tag. The Server will detect this as completed phase and upload all 
configured report tag values. Finally, the Server will write a 4 to the Exit tag. 

Where Batch Direct Phase Information Appears in the Product 

The integration of the Batch Direct functionality into the Proficy Batch Execution product is 
practically seamless. For batch developers and operators, who are already familiar with working with 
the Proficy Batch Execution product, it should take you little time to get familiar with the batch direct 
functionality. 

As a Batch Execution project developer, you can identify Batch Direct phases in the Equipment Editor, 
WorkSpace, or Recipe Editor by the sigma symbol that appears in the top left corner of the phase 
name. 

As an operator, the only difference you can expect to see will be in the naming convention of the 
phases used in the SFC, if you the developer chooses to use one. 

The following sections describe, in detail, where Batch Direct user interface differences can be 
expected: 

• Equipment Editor/WorkSpace 

• Recipe Editor 

• Batch Execution Client 



 

60 

Equipment Editor/WorkSpace 

The following figure shows where the user interface differences for Batch Direct occur in the 
Equipment Editor and Workspace. 

 

 

 

A sigma icon in the upper left corner of the phase 
name in the tree view indicates that the equipment 
phase is a direct phase. 

 

 

A sigma icon in the upper left corner of the phase 
instance indicates that the phase instance is a direct 
phase. 

Double-click this phase instance icon to open the 
Edit Equipment Phase dialog box. Double-click a 
state block in the list box to open the Edit Direct 
Phase Tags dialog box. 
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The toolbar button with the red plus sign opens the 
Create Direct Equipment Phase dialog box. This 
button appears directly next to the Add Standard 
Equipment Phase button in the default toolbar. 

NOTE: You must have an OPC Server configured 
as your default server in order to add a direct phase 
to the Workspace area. For more information, refer 
to The Data Server for Batch Direct Phases section. 

 

 

A sigma icon in the upper left corner of the phase 
class indicates that the phase class is a direct phase 
class. 

Double-click this phase class icon to open the Edit 
Direct Equipment Phase dialog box. Click the 
Enable Tags tab to identify the tags you want to 
enable for all phases in this class. 

Recipe Editor 

The only visual difference in the Recipe Editor is that a sigma icon appears in the upper left corner of 
the Batch Direct phase name in the Recipe Editor's tree view, as shown in the following figure. 

 

Batch Direct Phase in the Recipe Editor Tree 

Additionally, since Batch Direct phases do support electronic work instructions or message requests, 
the EWI feature is unavailable from the right-click menu of the recipe step. Instead, when you open the 
right-click menu for a step that uses a batch direct phase, it appears shaded. 

Batch Execution Client 

As an operator, the only difference you can expect to see in the Batch Execution Client will be in the 
naming convention of the phases that appear in the SFC View screen. 

TIP: For phase logic programmers not familiar with the batch nomenclature, be aware that the Semi-
Automatic mode button on the Add Batch toolbar is the Proficy Batch Execution name for Single Step 
mode.  So, if you want to use Single Step mode, use the Semi-Automatic mode button. 

If your Batch Execution project developer chooses not to use a naming convention for Batch Direct 
phases when creating your area model, there are no visible differences in the Client application. 

For example, say you (as a developer) enter BD_ at the beginning of each direct phase name that you 
create in the area model in the Equipment Editor or WorkSpace. When you add a batch in the Client 
(as an operator) that includes those direct phases, the BD_ appears in the phase names displayed in the 
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SFC View screen, as shown in numbered areas of the following figure. 

 

 

 

In this example, the BD_ that appears in front of the 
phase name in the Table View indicates that this step 
uses a batch direct phase. 

 

 

In this example, the BD_ that appears in front of the 
phase name in the SFC View indicates that this step 
uses a Batch Direct phase. 

 
 

In this example, the BD_ that appears next to the step 
name in the transition indicates that the step listed in 
the transition uses a Batch Direct phase. 

 

 

In this example, the BD_ that appears in front of the 
step name in the Status bar, indicates that this step 
uses a batch direct phase. 

NOTE: If the Batch Execution project developer does not use a naming convention, no differences 
appear in the SFC View screen. 
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Understanding How Batch Direct Phases Work 
In the Equipment Editor or WorkSpace, you configure Batch Direct phases at two levels: 

Equipment Phase Class defines generic information that applies to all instances of the Batch 
Direct phase. This generic information includes the parameters, reports, and the enabled 
Batch Direct state blocks required by the equipment phase. 

Equipment Phase defines the equipment-specific instance of a Batch Direct equipment phase and 
ties the equipment phase to the physical equipment (a unit) by specifying the equipment 
phase tags. 

The following figure illustrates how the BD_XFER_OUT equipment phase class is configured. In this 
example, three equipment-specific instances of the BD_XFER_OUT equipment phase class are 
configured and tied to the physical equipment in the plant. 

 

Batch direct phase classes and instances have almost the same configuration steps as those for standard 
phases.  The main difference is that for Batch Direct phases, you can configure Enter, Exit, and Status 
tags for each state block you choose to enable. Another difference is that operator messages and 
message partnering are not supported in Batch Direct phases. 

For more information on types of tags and state blocks that you can configure for Batch Direct phases, 
refer to the following sections: 

• States Blocks and Equipment Phase Tags 

• Tags for Each State Block 

• State Blocks and Tag Combinations 
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For more information on what is supported in Batch Direct phases, refer to the Differences Between 
Direct and Standard Phases section. 

Default Settings for a Batch Direct Phase 

By default, Batch Direct phases have the Running state block enabled. The Running state block is the 
minimum requirement for all Batch Direct phases. For the Running state block, you assign Enter, Exit, 
and Status tags. At a minimum, you need to configure the Enter tag value. 

Running State Block Example 

Say you enter an I/O address for the Enter tag of the Running state block. For the Exit tag, select the 
Inverse of Enter tag option. For the Status tag, select the Same as Enter Tag option.  

In this scenario, you would expect the following to occur: 

• Proficy Batch Execution writes to the RUNNING_ENTER tag to start the phase.  

• When the RUNNING_STATUS tag is configured with the same address as the 
RUNNING_ENTER tag, Proficy Batch Execution interprets the RUNNING_ENTER status 
as the RUNNING_STATUS. In other words, the phase is assumed to be running once 
signaled. 

• The phase remains in the running state until the process controller sets the address to a non-
active level. Proficy Batch Execution then interprets the inactive, RUNNING_STATUS level 
and sets the phase to complete. 

State Blocks and Equipment Phase Tags  

The following table provides descriptions of the state blocks that you can enable in Batch Direct 
phases.  

 State Blocks Available for a Batch Direct Phase   

State 
Block 

Description 

Running Starts and monitors the Batch Direct equipment phases. This state block is required. 

Stopping Commands a Batch Direct equipment phase to Stop, and monitors its status. This 
state block is optional. 

Aborting Commands a Batch Direct equipment phase to Abort, and monitors its status. This 
state block is optional. 

Holding Commands a Batch Direct equipment phase to Hold, and monitors its status. This 
state block is optional. 

Held Commands the Held state, and monitors the status. This state block is optional. 
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 State Blocks Available for a Batch Direct Phase   

State 
Block 

Description 

Restarting Starts and monitors the transition of the Restarting state into the Held state. This 
state block is optional. 

The following table provides descriptions of the optional equipment phase tags that you can define for 
the Batch Direct phase.  

 Optional Equipment Phase Tags Available for a Batch Direct Phase   

Equipment 
Phase Tag 

Description 

FAILURE Indicates whether a failure has occurred in the batch direct phase. When the 
register is set to 0, no failure has occurred. 

PAUSE Allows the Batch Direct phase to pause at the next programmed transition. 

PAUSED Indicates that the Batch Direct phase has paused at the programmed transition. 

SINGLE STEP Indicates when the Batch Direct phase is in single step mode. Single step 
mode causes the equipment phase to transition to the next programmed pause 
and waits for the operator to issue a resume command. 

STEP INDEX Indicates the step index of the Batch Direct equipment phase. 

UNIT Indicates the current unit number for the Batch Direct equipment phase. 
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Tags for Each State Block  

Each of the state blocks (Running, Stopping, Aborting, Holding, Held, and Restarting) has three tags. 
The following table describes these tags.  

 Tags Available for Each Block 

Tag Description 

Enter The Enter tag must be mapped to a unique I/O address.  Proficy Batch 
Execution sets the Enter tag at the start of the command. 

Proficy Batch Execution sets the state block to indicate that a phase should Run, 
Stop, Abort, Hold, be Held, or Restart. If you configure the Enter, Exit, and 
Status tags to the same address, Proficy Batch Execution sets the Enter tag at the 
start of the command, and the controller logic resets it when the command 
completes. 

Exit Proficy Batch Execution uses the Exit tag value to command a phase to stop and 
exit from its current state. When the state terminates, the controller logic resets 
the Enter tag.  

Status The controller logic sets the Status tag, informing Proficy Batch Execution 
when the state is active. When the command completes, the controller resets the 
Status tag. Proficy Batch Execution then resets the Enter tag. 

State Blocks and Tag Combinations  

For each state block you configure Enter, Exit, and Status tags. You enter an I/O address and value for 
each tag. The Exit and Status tags can be configured to the same value as the Enter tag.  

The following table outlines the actions between Proficy Batch Execution and the PLC when different 
combinations of Enter, Exit, and Status tags are configured for each state block.  
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Batch 
Direct 
Tags 

Aborting State 
Block 

Running, Stopping, 
Holding, and Restarting 
State Blocks 

Held State Block 

Enter Proficy Batch 
Execution sets the 
Enter tag to initiate the 
transition from the 
current state (either the 
Held, Running, 
Stopping, Holding, or 
Restarting state) to the 
Aborting state. 

The phase logic then 
resets the Enter tag to 
indicate that the 
controller completed 
the execution of the 
logic associated with 
this state. 

Proficy Batch Execution sets 
the Enter tag to initiate the 
transition from the current 
state to the Running, 
Stopping, Holding, or 
Restarting state. 

If Proficy Batch Execution 
receives a valid stop, abort, 
or hold command while one 
of these states is active, then 
Proficy Batch Execution 
resets the Enter tag. 

IMPORTANT: If the 
running logic completes 
normally, then the phase 
logic resets the Enter tag. 

Proficy Batch 
Execution sets the 
Enter tag to initiate 
the transition from 
the Holding state to 
the Held state. 

Proficy Batch 
Execution then resets 
the Enter tag value to 
indicate that a valid 
restart, abort, or stop 
command has been 
received. 

Enter and 
Exit 

Proficy Batch 
Execution sets the 
Enter tag to initiate the 
transition from the 
current state (either the 
Held, Running, 
Stopping, Holding, or 
Restarting state) to the 
Aborting state. 

The phase logic then 
resets the Enter tag to 
indicate that the 
controller completed 
the execution of the 
logic associated with 
this state. 

The Exit Tag is never 
used for the Aborting 
state, and should not be 
configured for this 
state. 

Proficy Batch Execution sets 
the Enter tag to initiate the 
transition from the current 
state to the Running, 
Stopping, Holding, or 
Restarting state. 

If Proficy Batch Execution 
receives a valid stop, abort, 
or hold command while one 
of these states is active, then 
Proficy Batch Execution sets 
the Exit tag and resets the 
Enter tag.     

IMPORTANT: If the 
running logic completes 
normally, then the phase 
logic resets the Enter tag. 

Proficy Batch 
Execution sets the 
Enter tag to initiate 
the transition from 
the Holding state to 
the Held state. 

Proficy Batch 
Execution then resets 
the Enter tag and sets 
the Exit tag value to 
indicate that a valid 
restart, abort, or stop 
command has been 
received. 
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Batch 
Direct 
Tags 

Aborting State 
Block 

Running, Stopping, 
Holding, and Restarting 
State Blocks 

Held State Block 

Enter and 
Status 

Proficy Batch 
Execution sets the 
Enter tag to initiate the 
transition from the 
current state (either the 
Held, Running, 
Stopping, Holding, or 
Restarting state) to the 
Aborting state. 

When this state 
becomes active, the 
phase logic sets the 
Status tag and executes 
the associated logic. 

When the logic 
completes, the phase 
logic in the controller 
resets the Status tag. 

Proficy Batch 
Execution then resets 
the Enter tag based on 
the value of the Status 
tag. 

Proficy Batch Execution sets 
the Enter tag to initiate the 
transition from the current 
state to the Running, 
Stopping, Holding, or 
Restarting state. 

Once one of these states is 
active, the phase logic sets 
the Status tag to indicate 
such. 

If Proficy Batch Execution 
receives a valid stop, abort, 
or hold command while one 
of these states is active, then 
Proficy Batch Execution 
resets the Enter tag. This 
causes the phase logic to 
reset the Status tag and stop 
executing the logic. 

IMPORTANT: If the 
running logic completes 
normally, then the phase 
logic resets the Status tag to 
indicate such. Proficy Batch 
Execution then resets the 
Enter tag. 

Proficy Batch 
Execution sets the 
Enter tag to initiate 
the transition from 
the Holding state to 
the Held state. Once 
in the Held state, the 
phase logic sets the 
Status tag to indicate 
such. 

Proficy Batch 
Execution then resets 
the Enter tag and sets 
the Exit tag value to 
indicate that a valid 
restart, abort, or stop 
command has been 
received. 

In response to this 
action, Proficy Batch 
Execution resets the 
Status tag. 
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Batch 
Direct 
Tags 

Aborting State 
Block 

Running, Stopping, 
Holding, and Restarting 
State Blocks 

Held State Block 

Enter, 
Exit, and 
Status 

Proficy Batch 
Execution sets the 
Enter tag to initiate the 
transition from the 
current state (either the 
Held, Running, 
Stopping, Holding, or 
Restarting state) to the 
Aborting state. 

When this state 
becomes active, the 
phase logic sets the 
Status tag and executes 
the associated logic. 

When the phase logic 
completes, the phase 
logic normally resets 
the Status tag. Proficy 
Batch Execution then 
resets the Enter tag 
based on the Status tag 
value. 

The Exit Tag is never 
used for the Aborting 
state, and should not be 
configured for this 
state. 

Proficy Batch Execution sets 
the Enter tag to initiate the 
transition from the current 
state to the Running, 
Stopping, Holding, or 
Restarting state. 

Once one of these states is 
active, the phase logic sets 
the Status tag to indicate 
such. 

If Proficy Batch Execution 
receives a valid stop, abort, 
or hold command while one 
of these states is active, then 
Proficy Batch Execution sets 
the Exit tag. This causes the 
phase logic to reset the 
Status tag and stop 
executing. 

IMPORTANT: If the state's 
logic completes normally, 
the phase logic resets the 
Status tag to indicate such. 
Proficy Batch Execution 
then resets the Enter tag. 

Proficy Batch 
Execution sets the 
Enter tag to initiate 
the transition from 
the Holding state to 
the Held state. Once 
in the Held state, the 
phase logic sets the 
Status tag to indicate 
such. 

Proficy Batch 
Execution then resets 
the Enter tag and sets 
the Exit tag value to 
indicate that a valid 
restart, abort, or stop 
command has been 
received. 

In response to this 
action, the Proficy 
Batch Execution 
resets the Status tag. 

IMPORTANT: If the Holding and Restarting states are not configured for a phase, then a Hold 
command does not change the Running state.  

The Data Server for Batch Direct Phases 
The supported data server for Batch Direct phases is the OPC data server. The OPC data server allows 
you to retrieve data from your iFIX process database or any OPC-aware process hardware. OPC (OLE 
for Process Control) defines standard objects, methods, and properties for meeting the interoperability 
requirements of real-time process automation applications.  

Before adding a direct phase class to your project, you must configure the OPC data server and 
designate it as your project's default data server. Once configured, you can add Batch Direct phase 
classes and tie equipment phases to the actual equipment. 

To configure the OPC data server for Batch Direct phases, use the Edit Servers dialog box. Access this 
dialog box from the Edit Servers button on the toolbar, or from the Edit menu, choose Servers. 
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Be aware that the OPC data server should reside on the same computer as the Batch Server that 
interfaces with the phase logic for the batch direct functionality. 

Overview: Configuring Direct Phases 
The following illustration provides an overview on how to configure a Batch Direct phase from the 
Proficy Batch Execution WorkSpace or Equipment Editor. 
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TIP: Direct Phase Naming Convention 

When adding direct phase classes and instances to your Proficy Batch Execution projects, consider 
using a naming convention. For instance, you may want to add a prefix such as BD_ to all Batch Direct 
phase classes and instances. Here is an example of a Batch Direct phase class for the transfer out step: 

BD_XFER_OUT 

When you add a batch in the Client that includes this Batch Direct phase, the BD_ name appears in the 
phase names displayed in the SFC View screen. For more information, refer to the Batch Execution 
Client section. 

Direct Phase Template 

The Direct Phase Template allows you to change the default tag settings. The equipment tags for a 
Batch Direct phase include: Failure, Pause, Paused, Single Step, Step Index, and Unit. The state blocks 
for a Batch Direct state include: Running, Holding, Held, Restarting, Stopping, and Aborting. 

By changing the default tags to your custom settings, creating and maintaining batch projects with lots 
of equipment phases can be easier and faster. If you enter your default settings into the template when 
you first create your project, you will not need to edit each tag individually when you add a new phase 
to your project, especially if you are using iFIX as your SCADA software. In the iFIX product, the tags 
are formatted as Node.Tag.Field, which is also the tag format the template is geared for. 

TIP: If you are not using iFIX tags, try to use a naming convention that will be easy to modify later. 
Most likely, without iFIX, you will have to enter manual changes in your tag names. 

Any modifications you make to the Direct Phase Template apply to direct phases you add to your 
project after making the template updates. The values that you enter into the template do not change 
the equipment phase tags in pre-existing equipment phases. 

To access the Direct Phase Template dialog box from the Edit menu, click Direct Tag Template. The 
following figure illustrates an example of this dialog box. 

 

Direct Phase Template Dialog Box 

When you edit the Node field, all tags for each state block are automatically populated with the name 
you enter. This is because all tags for a phase must have the same node name. If you select the Use 
Server Alias button, all of the Server name fields are filled with the "#ALIAS#." text. The #ALIAS# 
syntax allows you to use the Alias configured in the Create OPC Server dialog box. 
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Be aware that you cannot edit the Phase field from this dialog box or from the Direct Phase Tag 
Template dialog box, which you access by clicking the browse button next to the state block. The 
Phase name field is just a placeholder for information that gets added when you actually add the phase; 
the Phase name field gets modified when you add or modify equipment phases. If you do not use iFIX, 
you can change this value later, when you add the direct phase instance to your project in the 
Equipment Editor or WorkSpace. 

For example, if you leave the default settings for the Running tag in the Standard Tag Template, as 
shown in the following figure: 

 

The tag information for a phase, named PHASE11, appears like this in the Edit Equipment Phase 
dialog box: 

 

In this example, the PHASE field gets replaced with PHASE11 for the Enter, Exit, and Status tags. The 
_RE indicates the Running Enter block, the _RX indicates the Running Exit block, and the _RS 
indicates the Running Status block. In iFIX, F_CV represents the current value of a block displayed as 
a number. 
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Direct Phase Class Properties 
For each phase class, you can configure the following class properties: 

• Parameters 

• Phase Reports 

• Batch Direct Blocks and Tags 

The class properties that you define apply to all instances of the direct phase class. Each instance is 
tied to the physical equipment by specifying the address of the Batch Direct tags. 

Standard phases can also include parameters and phase reports.  Refer to the Standard Phase Class 
Properties section for more information.  The following section describes the class properties specific 
to only batch direct phases. 

Batch Direct Blocks and Tags 

The state blocks that you choose to enable for a Batch Direct phase class are based on your individual 
project needs. For each of the state blocks you enable at the class level, you configure tags at the phase 
instance level. The state blocks that you can enable include the: 

• Running State 

• Holding, Held, and Restarting State 

• Stopping State 

• Aborting State 

• Failure 

• Pause and Paused 

• Single Step 

• Step Index 

• Unit 

Only the Running State is required. Holding, Held, and Restarting States cannot be individually 
selected; you must enable all three at once. 

To enable state blocks at the phase class level, use the Enable Tags tab of the Create or Edit Direct 
Equipment Phase Class dialog box. The following figure shows an example of this dialog box, with the 
minimum state block enabled – the Running state. 
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Edit Direct Equipment Phase Class Dialog Box with the Minimum Configuration 

Tying Batch Direct Phases to Equipment 
In Proficy Batch Execution, you tie Batch Direct phases to the equipment by specifying the equipment-
specific addresses for the Enter, Exit, and Status tags associated with the Batch Direct phase along with 
any standard equipment phase tags. Additionally, you configure any parameter, report, and request tags 
required by the phase. By specifying these tags, at the phase instance level, you are configuring a unit's 
equipment phase. 

To configure tags at the phase instance level, use the Edit Equipment Phase dialog box. Double-click a 
state block or phase tag from the list box to open a dialog box that allows you to configure the required 
tag or tags. 

The following figure shows an example of the dialog box that you use to configure the tags for a Batch 
Direct phase. In this example, only the Running state appears enabled in the list box (the default). The 
default values for the Enter, Exit, and Status tags appear under the Type field, in the right side of the 
dialog box. 
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Edit Equipment Phase Dialog Box 

Double-click the Running state block to open the Edit Direct Phase Tags dialog box, where you can 
modify the Enter, Exit, and Status tags. The following figure shows an example of the Edit Direct 
Phase Tags dialog box. In this example, only the Enter and Exit tag are configured.  The Status tag is 
left with the default value. 
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Edit Direct Phase Tags Dialog Box 

FAQ on Batch Direct Phases 
The questions and answers outlined below describe some commonly asked questions about the Batch 
Direct functionality. 

Question 1: How do I enable Batch Direct state blocks for a phase 
instance? 

Open the Edit Direct Equipment Phase Class dialog box. Click the Enable Tags tab to make your 
selections. 

For an illustration of the Edit Direct Equipment Phase Class dialog box with the Enable Tags tab 
selected, refer to the Differences Between Direct and Standard Phases section. For more information 
on the steps to configure Batch Direct phases refer to the Overview: Configuring Direct Phases section.  

Question 2: How do configure the Enter, Exit, and Status Tags for a Batch 
Direct phase? 

Double-click the Batch Direct phase instance in the work area. Double-click any of the state blocks 
that appear in the list box to display the Edit Direct Phase Tags dialog box. From this dialog box, you 
can enter your modifications to the Enter, Exit, and Status tags. 

For an illustration of the Edit Direct Phase Tags dialog box, refer to the Differences Between Direct 
and Standard Phases section. For more information on the steps to configure Batch Direct phases refer 
to the Overview: Configuring Direct Phases section. 
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Question 3: What happens when there is no aborting logic defined? 

In this scenario, abort commands issued by the operator in the Client cause Proficy Batch Execution to 
signal the controller to exit the Running block. 

Question 4: What happens when there is no stopping logic defined? 

Stop commands from the operator cause Proficy Batch Execution to signal the controller to exit the 
Running block. 

Question 5: What happens when there is no holding logic defined? 

In this scenario, Hold commands from the operator are ignored by the PLI in Proficy Batch Execution. 
The phase continues to run to until completion. The status of a batch remains as Running until the 
Batch Direct phase completes. 

Question 6: I have lots of iFIX tags to enter for my phases, is there an easy 
way to do this? 

Yes. Use the Direct Phase Template. For more information, refer to the Direct Phase Template section. 

Advanced Topics 
The sections that follow discuss several advanced features in the Equipment Editor including: 

• Configuring control modules as resources.  

• Creating shared resources.  

• Configuring and arbitrating common resources.  

• Configuring unit tags, including the UNIT_READY and the UNIT_PRIORITY tags.  

• Configuring scalable parameters.  

Configuring Control Modules  
A control module consists of sensors and other control modules that together perform a specific task. 
Control modules are the smaller pieces of equipment that make up an equipment module. If your 
process contains control modules that are required by other resources, you can: 

• Define the control modules as a resource in Batch Execution.  

• Assign the control module as needed equipment to other resources.  

Once you define the control modules as a resource, Batch Execution can acquire and allocate the 
equipment when needed. Additionally, Batch Execution considers any Manifolds and Connector lines 
contained within a process cell as control modules that you can assign to other resources.  
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Aside from Manifolds and Connector lines, control module resources are not represented graphically in 
the Equipment Editor. Instead, you define control modules using the Edit Control Module command. 
This makes the resource available to assign to other resources. 

Configuring Shared Equipment  
Sharing equipment lets you define the shared equipment once and then share it wherever necessary. All 
changes made to shared equipment are automatically updated in all shared instances. Batch Execution 
lets you share: 

• A unit between process cells.  

• An equipment module between units.  

To configure shared equipment:  

1. Configure the unit or equipment phase.  

2. Add the shared equipment to the appropriate process cells or units.  

3. Configure the arbitration settings for the shared equipment.  

Configuring Arbitration for Shared and Common Resources 
Common resources are equipment that more than one resource can use. In Batch Execution a common 
resource can be: 

• A unit that is shared between process cells.  

• An equipment phase that is shared between units.  

• A control module that is common to multiple resources.  

In order to determine how Batch Execution handles multiple requests for the same resource, you must 
configure equipment arbitration. Equipment arbitration coordinates how Batch Execution allocates 
resources when there are more requests for the resource than can be accommodated at one time. 

Configuring arbitration consists of defining the following information for each piece of equipment in 
your plant: 

• Equipment ID  

• Maximum Owners  

• Equipment Needed  

The following sections describe each component.  
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Understanding Equipment IDs  

All equipment configured in the Equipment Editor is assigned a unique equipment ID. Batch 
Execution uses this ID to: 

• Arbitrate equipment.  

• Service requests from the phase logic to acquire and release equipment.  

Understanding Maximum Owners  

The maximum number of owners setting determines whether a common resource is an exclusive-use or 
shared-use resource. If the resource is exclusive-use, set the maximum number of owners to one (the 
default). This indicates that only one requester can use this piece of equipment at any one time. If the 
resource is shared-use, set the maximum number of owners to the number of requesters that can 
simultaneously use this resource. The shared-use equipment must be physically capable of being used 
by multiple requesters at one time. For more information on common resources, refer to the 
Implementation Strategies section. 

Understanding Equipment Needed  

The equipment needed setting specifies any additional resources that this equipment requires in order 
to execute. You can assign needed equipment to a process cell, a unit, an equipment phase, or a control 
module. You must configure the needed equipment as a process cell, unit, equipment phase, or control 
module. The following table describes the arbitration results of assigning needed equipment.  

Assigning Needed Equipment   

When you assign a needed 
resource to... 

The resource is acquired 
when the... 

The resource is released 
when the... 

An equipment phase or a 
control module 

Recipe phase begins. Recipe phase is reset. 

A unit Unit procedure begins. Unit procedure is reset. 

Phase Request Logic 

If you need a resource for just a small portion of a phase, you may want to acquire and release the 
equipment in the phase logic, rather than configure the equipment as a needed resource. The benefit of 
programming equipment requests in the phase logic is that you can release the resource prior to the 
completion of the phase, making it available to other requesters. Otherwise, the resource is owned by 
the phase for the entire execution of the phase. For more information on programming requests, refer 
to the Phase Programming Manual. 

Examples: Equipment Arbitration  

The following figure shows an example of two mixers sharing an equipment phase. In this example, 
the shared equipment phase is a valve. The valve executes an equipment phase that transfers material 
into either MIX1 or MIX2.  
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To configure the equipment in this example as a common resource:  

1. Share the equipment phase on both MIX1 and MIX2.  

2. Assign the equipment phase as a needed resource to each unit.  

3. If the valve can only be used by one unit at one time, set the maximum owners to one.  

With this configuration, the valve is acquired by the first unit procedure that requests the valve. When 
the unit procedure completes, the valve is released and another unit procedure can acquire the valve. 

 

Arbitrating Equipment Phases between Units 

This figure shows an example of two equipment phases that require a control module to execute. In 
this example, the XFER_IN1 and XFER_IN2 equipment phases both use the same pump to transfer 
material. The pump is defined as a control module and is assigned as a needed resource to each 
equipment phase. Furthermore, if the pump can only be used by one equipment phase at one time, you 
need to set the maximum owners to one.  

 

Arbitrating Control Modules between Equipment Phases 

Using Unit Tags 
Unit tags represent data that is associated with a specific unit, and all phases that execute on the unit 
can access these tags. Unit tags are used in recipe transitions, which define when a recipe moves from 
one step to another. For example, you may want to verify that the level of a mixer reaches a specific 
value before allowing the recipe to continue to the next step.  

Batch Execution also lets you create unit tag classes, which are defined for a unit class. Unit tag classes provide 
an indirect reference to a group of specific unit tags. When building a class-based recipe, the recipe author 
references the tag class rather than the tag so the transition can apply to any instance of the unit class.  
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Example: Unit Tag Classes  

In the example illustrated in the following figure, the MIXER class of units in the sample toothpaste 
application contains two unit tag classes: LEVEL and TEMP. These are variable names for the specific 
tags defined on each instance of the unit. The LEVEL tag class resolves to LI101, LI102, or LI103, and 
the TEMP tag class resolves to TI101, TI102, or TI103, depending on the current mixer. 

 

Unit Tags  

Configuring the UNIT_READY and UNIT_PRIORITY Tags  

When you create a unit instance, Batch Execution supplies two pre-defined unit tags that you can use 
to define the unit's equipment status. These tags can point to a register in your process controller or to a 
tag in your HMI. If your process uses these tags, during Active Binding, Batch Execution will select 
units based on these tag values. Each tag is described below. 

Using the UNIT_READY Tag 

The UNIT_READY tag indicates whether the unit is ready for use. UNIT_READY tag values can 
range from 0 (zero) to 32,767. A value of zero indicates the unit is ready and can be used by a batch. A 
non-zero value indicates the unit is not currently available. Batch Execution will not allow a unit with a 
non-zero Unit Ready tag value to be used by a batch. For example, the logic in your process controller 
could: 

1. Detect if the operator switches a unit off.  

2. If the unit is off, the logic in your process controller could set the UNIT_READY tag to a 
non-zero value, so that Batch Execution cannot allocate the unit to a batch.  
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Using the UNIT_PRIORITY Tag 

The UNIT_PRIORITY tag indicates the priority of the unit, as compared to other units in the same unit 
class. If multiple units are available for a batch, Batch Execution selects the unit with the highest 
priority value. Unit Priority values can range from 0 (zero) to 32,767. You can associate any meaning 
with each priority value. Batch Execution simply treats the number as a priority and selects units with 
the highest UNIT_PRIORITY tag value.  

For example, assume that your plant has two mixers, MIX1 and MIX2. In order to even the load 
between these two mixers, your logic in the process controller could: 

1. Detect if the mixer was used for the previous batch. For this example, let's assume that the 
previous batch used MIX1.  

2. Decrease the value of MIX1's unit priority tag, MIX1_PRIORITY, and increase the value of 
MIX2's tag, MIX2_PRIORITY.  

During the next batch, Batch Execution checks the priority values of each mixer and select the unit 
with the highest priority. In this case, Batch Execution selects MIX2, because it has the highest priority 
tag value. 

Assigning iFIX Tags to Equipment Status Tags 

Batch Execution lets you assign iFIX database tags to both the UNIT_READY and UNIT_PRIORITY 
tags. The following table lists the iFIX tag type to assign to each tag.  

iFIX Tag Types for Equipment Status Unit Tags   

For these tags... Use this iFIX Database Tag Type... 

UNIT_READY tags Analog Input (AI) or Analog Register (AR) 

UNIT_PRIORITY tags Analog Input (AI) or Analog Register (AR) 

NOTE: GE recommends the use of Analog Input (AI) blocks. 

Configuring Static Values for Unit Ready and Unit Priority 

If you choose not to configure points for the UNIT_READY and UNIT_PRIORITY tags, you can 
define static values for these items. Using static values as opposed to setting the tag values provides 
less flexibility in your process. However, with simpler processes you may find that using static values 
is the best method. With more complex processes you may find it necessary to configure the 
UNIT_READY and UNIT_PRIORITY tags.  

Each static setting is described below. 

Unit Ready – lets you select whether the unit is "always ready" (online) or "always not ready" 
(offline). The default setting is online. If you select offline, Batch Execution cannot allocate 
this unit to a batch. Typically, you will select online, making the unit available to batches. 
The default Unit Ready setting is online. 
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Unit Priority – lets you specify the unit's priority value (the higher the value, the higher the 
priority). Batch Execution will select the unit with the highest priority. The default priority 
value is 0 (zero). 

Example: Using Unit Ready and Unit Priority 

For example, assume the following conditions exist in the sample toothpaste application:  

Mixers UNIT_READY UNIT_PRIORITY 

MIX1 0 (online) 12 

MIX2 0 (online) 25 

MIX3 3 (offline) 2  

Based on these conditions, Batch Execution performs the following process of elimination to decide 
which unit to allocate to the unit procedure: 

1. Batch Execution checks the Unit Ready status of the mixers and eliminates MIX3 from the 
list of valid units because it is offline. The choice is now limited to MIX1 or MIX2.  

2. Batch Execution checks the Unit priority status of MIX1 and MIX2 and selects MIX2 as the 
first choice because it has a higher priority value than MIX1.  

Configuring Scalable Parameters  
When you create a batch in the Batch Execution Client, you can scale the batch by a specified 
percentage. This percentage is then applied to all parameters that have scaling enabled. If you plan to 
scale batches, you need to enable scaling for those parameters that need to be scaled. Typically, 
parameters that specify ingredient amounts should have scaling enabled. For example, if the operator 
sets the batch scaling percentage to 50%, all ingredient amounts are cut in half. 

You need to determine the scaling percentage value based on the desired batch size. For example, if 
the default batch size is 3000 and the operator needs to produce a batch of 2500, the operator would 
need to scale the batch by 83.3%. This requires you to calculate the percentage, as illustrated in the 
following table. 
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Understanding Parameter Scaling 

Equipment Editor Dialog Boxes 
The Equipment Editor application includes the following dialog boxes for working with equipment 
(listed in alphabetical order): 

• Add Control Module Dialog Box 

• Add Control Modules Class Dialog Box 

• Audit Information Dialog Box 

• Browse OPC Items Dialog Box 

• Connection Properties Dialog Box 

• Create Direct Equipment Phase Class Dialog Box 

• Create Enumeration Dialog Box 

• Create Enumeration Set Dialog Box 

• Create Enumeration Sets and Enumerations Dialog Box 

• Create Equipment Phase Class Dialog Box 

• Create OPC Server Dialog Box 

• Create Process Cell Class Dialog Box 

• Create Unit Class Dialog Box 

• Create Unit Tag Dialog Box 

• Direct Phase Tag Template Dialog Box 
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• Direct Tag Template Dialog Box 

• Edit Area Dialog Box 

• Edit Control Modules Dialog Box 

• Edit Direct Equipment Phase Class Dialog Box 

• Edit Direct Phase Tags Dialog Box 

• Edit Enumeration In Dialog Box 

• Edit Enumeration Set Name Dialog Box 

• Edit Equipment Phase Class Dialog Box 

• Edit Equipment Phase Dialog Box 

• Edit Equipment Phase Tag Dialog Box 

• Edit Operator Message Dialog Box 

• Edit Phase Parameter Dialog Box 

• Edit Phase Report Dialog Box 

• Edit Process Cell Class Dialog Box 

• Edit Process Cell Dialog Box 

• Edit Servers Dialog Box 

• Edit Tags Dialog Box 

• Edit Unit Class Dialog Box 

• Edit Unit Tag Dialog Box 

• Enumeration Set Modification Dialog Box 

• File Export As Dialog Box 

• File Import Dialog Box 

• Import Equipment Model XML File Dialog Box 

• Manifold Properties Dialog Box 

• Print Setup Dialog Box 

• Select Directories Dialog Box 

• Select Equipment Dialog Box 

• Select HMI Picture Dialog Box 

• Set Tag Server Dialog Box 

• Share Equipment Phase Dialog Box 

• Share Unit Dialog Box 

• Standard Phase Template Dialog Box 

• Tag Template Dialog Box 

• Unit Properties Dialog Box 

• Zoom Dialog Box 
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Add Control Module Dialog Box 
The Add Control Module dialog box displays the following items: 

Name 

Enter the name of the control module that you want to add.  The system automatically assigns a name, 
or you can enter your own name.  Control module names must be unique. 

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Class 

Displays the class for the control module. You cannot edit this field. 

Arbitration  

The following table lists the contents of the Arbitration area:  

Item Description 

Equipment ID Enter the unique equipment ID to identify this control module.   

Max Owners 
Enter the maximum number of owners that may simultaneously own 
this control module.   

Equipment Needed 
Lists the equipment that this equipment needs to own exclusively in 
order to begin operation.  

Add 
Lets you add equipment to the Equipment Needed list box. 

Remove 
Deletes the selected equipment from the Equipment Needed list box.  
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Add Control Modules Class Dialog Box 
The Add Control Modules Class dialog box displays the following item: 

Name 

Enter the name of the control module class that you want to add.  The system automatically assigns a 
name, or you can enter your own name.  Control module class names must be unique.   

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Audit Information Dialog Box 
The Audit Information dialog box displays the following items: 

Audit Version 

Displays the audit version number of the currently configured area model file. The audit version 
number increases by one each time the area model is saved.   

Unique Identifier (GUID) 

Displays the unique, system-generated identifier for the area model. Proficy Batch Execution generates 
the GUID when you create a new project for the first time, or use the Save As command to create a 
new project. 

Performed By  

The following table lists the contents of the Performed By area: 

Item Description 

User Name Displays the Microsoft Windows user ID of the operator (from 
the Performed By group) who last authorized the saving of the 
area model.    

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Proficy 
Batch Execution WorkSpace, and then saved the area model with 
the required electronic signatures in the Proficy Batch Execution 
Equipment Editor or WorkSpace.   
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Item Description 

Full Name 
Displays the full user name of the operator (from the Performed By 
group) who last authorized the saving of the area model.  

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Proficy 
Batch Execution WorkSpace, and then saved the area model with 
the required electronic signatures in the Proficy Batch Execution 
Equipment Editor or WorkSpace. 

Timestamp 
Displays the date and time when Proficy Batch Execution 
authenticated the electronic signature of the operator (from the 
Performed By group).   

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Proficy 
Batch Execution WorkSpace, and then saved the area model with 
the required electronic signatures in the Proficy Batch Execution 
Equipment Editor or WorkSpace. 

Comment 
Displays any comments entered by the operator (from the 
Performed By group) who last authorized the saving of  the recipe. 
   

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Proficy 
Batch Execution WorkSpace, and then saved the area model with 
the required electronic signatures in the Proficy Batch Execution 
Equipment Editor or WorkSpace. 

Verified By  

The following table lists the contents of the Verified By area:  

Item Description 

User Name Displays the Windows user ID of the supervisor (from the 
Verified By group) who last authorized the saving of the area 
model.    

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Proficy 
Batch Execution WorkSpace, and then saved the area model with 
the required electronic signatures in the Proficy Batch Execution 
Equipment Editor or WorkSpace. 
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Item Description 

Full Name 
Displays the full user name of the supervisor (from the Verified By 
group) who last authorized the saving of the area model.    

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Proficy 
Batch Execution WorkSpace, and then saved the area model with the 
required electronic signatures in the Proficy Batch Execution 
Equipment Editor or WorkSpace. 

Timestamp 
Displays the date and time when Proficy Batch Execution 
authenticated the electronic signature of the supervisor (from the 
Verified By group).   

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Proficy 
Batch Execution WorkSpace, and then saved the area model with the 
required electronic signatures in the Proficy Batch Execution 
Equipment Editor or WorkSpace. 

Comment 
Displays any comments entered by the supervisor (from the Verified 
By group) who last authorized the saving of the recipe.    

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Proficy 
Batch Execution WorkSpace, and then saved the area model with the 
required electronic signatures in the Proficy Batch Execution 
Equipment Editor or WorkSpace. 

Browse OPC Items Dialog Box 
The Browse OPC Items dialog box displays the following items: 

Select an Item 

Select an OPC item from the list box. 

Item ID 

Enter an Item ID number. 

Filter String 

Enter a filter string to display only a subset of items in the Select and Item list. 
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Connection Properties Dialog Box 
The Connection Properties dialog box displays the following items: 

Name 

Enter a unique name for the connection.  

Label 

Optionally enter a descriptive label for connection.  This label appears on the connection line. 

Origin 

Displays the name of the origin unit. 

Destination 

Displays the name of the destination unit.  

Arbitration  

The following table lists the contents of the Arbitration area: 

Item Description 

Equipment ID Enter the unique equipment ID to identify this connection. 

Max Owners 
Enter the maximum number of owners that may simultaneously own 
this connection. 

Equipment Needed 
Lists the equipment that this equipment needs to own exclusively in 
order to begin operation.  

Add 
Lets you add equipment to the Equipment Needed list box. 

Remove 
Deletes the selected equipment from the Equipment Needed list box.  
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Create Direct Equipment Phase Class Dialog Box 
The Create Direct Equipment Phase Class dialog box displays the following items: 

General Tab 

The following table lists the contents of the General tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank. 

Icon 
Displays a list of available icons. 

Parameters Tab 

The following table lists the contents of the Parameters tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank. 

Phase Parameters 
Lists the phase parameters that are currently configured for this 
equipment phase.   
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Item Description 

Add 
Lets you add a parameter to the equipment phase. 

Edit 
Lets you edit the selected phase parameter.  

Delete 
Deletes the selected phase parameter. 

Reports Tab 

The following table lists the contents of the Reports tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank.  

Phase Reports 
Lists the phase reports that are currently configured for this 
equipment phase. 

Add 
Lets you add a phase report to the equipment phase. 

Edit 
Click to edit the selected phase report. 

Delete 
Deletes the selected phase report. 
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Enable Tags 

The following table lists contents of the Enable Tags Tab under the Direct Phase Tags area:  

Item Description 

Running State Select this check box to enable the Running state. 

Hold, Held, and Restarting 
States 

Select this check box to enable the Hold, Held, and Restarting 
states. 

Stopping State Select this check box to enable the Stopping state. 

Aborting State Select this check box to enable the Aborting state. 

Failure Select this check box to enable the Failure state. 

Pause and Paused Select this check box to enable the Pause and Paused states. 

Single_Step Select this check box to enable the Single_Step state. 

Single_Index Select this check box to enable the Single_Index state. 

Unit Select this check box to enable the Unit state. 

Create Enumeration Dialog Box 
The Create Enumeration dialog box displays the following items: 

Enumeration 

Enter the enumeration string for the corresponding ordinal value.  This is the string displayed to recipe 
authors and operators.  Enumeration string names must be unique within enumeration sets. 
Enumeration names should not contain spaces or these characters:  !@#$%^&*() 

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Example: WINTERGREEN   

Ordinal 

Enter the ordinal or number that represents the enumeration.  This number must match the number that 
is programmed into the phase logic in the process controller.  Ordinals must be unique within 
enumeration sets.  
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Create Enumeration Set Dialog Box 
The Create Enumeration Set dialog box displays the following item: 

Enumeration Set 

Enter the enumeration set name.  Enumeration set names must be unique within enumeration sets. 
Enumeration set names should not contain spaces or these characters:  !@#$%^&*()"   

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Example: FLAVOR  

Create Enumeration Sets and Enumerations Dialog Box 
The Create Enumeration Sets and Enumerations dialog box displays the following items: 

Enumeration Sets 

Lists the configured enumeration sets. 

Enumerations 

Lists the currently defined enumerations. 

Sets  

The following table lists the buttons to manipulate the Enumeration Sets:  

Item Description 

New Lets you create a new enumeration set. 

Edit 
Lets you change the name of the currently selected enumeration set. 

Delete 
Deletes the currently selected enumeration set. 
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Enumerations  

The following table describes the buttons in the Enumerations area:  

Item Description 

New Lets you add a new enumeration to the currently selected 
enumeration set.   

Edit 
Enter the enumeration string for the corresponding ordinal value.  This 
is the string displayed to recipe authors and operators.  Enumeration 
string names must be unique within enumeration sets. Enumeration 
names should not contain spaces or these characters:  !@#$%^&*() 

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Example: WINTERGREEN   

Delete 
Deletes the currently selected enumeration set.   

   

Create Equipment Phase Class Dialog Box 
The Create Equipment Phase Class dialog box displays the following items: 

General Tab 

The following table lists the contents of the General tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank.  
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Item Description 

Icon 
Displays a list of available icons. 

Number of Request 
Tags 

Enter the number of request tags required for this equipment phase. 
 This number must match the number of requests that are made by 
the phase logic.   

Number of Message 
Partners 

Enter the number of phase partners that this equipment phase must 
communicate with.   

Parameters Tab 

The following table lists the contents of the Parameters tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank. 

Phase Parameters 
Lists the phase parameters that are currently configured for this 
equipment phase. 

Add 
Lets you add a parameter to the equipment phase. 

Edit 
Lets you edit the selected phase parameter.  

Delete 
Deletes the selected phase parameter. 
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Reports Tab 

The following table lists the contents of the Reports tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank.  

Phase Reports 
Lists the phase reports that are currently configured for this 
equipment phase. 

Add 
Lets you add a phase report to the equipment phase. 

Edit 
Lets you edit the selected phase report.  

Delete 
Deletes the selected phase report. 

Operator Messages Tab 

The following table lists the contents of the Operator Messages tab: 

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 
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Item Description 

Type 
Enter the equipment phase type or leave this field blank.  

Operator Messages 
List the operator messages that are currently configured for this 
equipment phase.  These messages are displayed to the operator 
during manual phase control.   

Add 
Lets you add an operator message to the equipment phase.  

Edit 
Lets you edit the selected operator message.  

Delete 
Deletes the selected operator message. 

   

Create OPC Server Dialog Box 
The Create OPC Server dialog box displays the following items: 

Select a Server 

Lists the currently configured servers. 

Server Name 

Enter a server name.  Server names must be unique. 

Valid Entries:  A - Z,  0 - 9, and the underscore character. Valid Entries:  

Alias 

Enter an alternate name that you would like to associate with the active server. If you are using Batch 
Execution with Proficy Process Systems, enter the alternate name for the Proficy Process Systems 
active server; the format of this name is: Channel.Device. For example, for a channel named PAC1 and 
a device named D1, enter PAC1.D1 in this field. If you are using iFIX with Batch, the name you enter 
here is the Nodename. The name that you enter in the Alias field will later be substituted into the Tag 
Template, after the template is configured.  
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BadValue 

Enter the bad value string sent from the application.   

Watchdog 

Enter a tag to act as a watchdog register.  

NOTE: For Proficy Process Systems, the format of this name is: Channel.Device.WatchDog.WD. For 
example, for Proficy Process Systems, for channel named PAC1, a device named D1, and a Watchdog 
function block named WD5, enter PAC1.D1.WD5.WD in this field. 

DLL 

Displays the path and .DLL file name for the OPC server. 

Default Refresh Rate 

Enter the rate in milliseconds to refresh data from the OPC server. The default is 1000, which is equal 
to one second. 

Create Process Cell Class Dialog Box 
The Create Process Cell Class dialog box displays the following items: 

Name 

Enter the name of a new process cell class.  Process cell class names must be unique within process 
cell classes.   

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Example:  INTYPLANT  

Icon 

Displays a list of available icons. 

Create Unit Class Dialog Box 
The Create Unit Class dialog box displays the following items: 

Name 

Enter a name for the unit class.  Unit class names must be unique within the unit classes. 
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Valid Entries:  A - Z, 0 - 9, and the underscore character.   

Example:  MIXER  

Icon 

Displays a list of available icons. 

Tag Classes 

Lists the unit tag classes for this unit class.  A unit tag class is automatically created when the same 
class is assigned to more than one unit tag. 

Create Unit Tag Dialog Box 
The Create Unit Tag dialog box displays the following items: 

Name 

Enter the unit tag name. 

Tag Class 

Lists the unit tag classes for this unit tag.  A unit tag class is automatically created when the same class 
is assigned to more than one unit tag. 

Type 

Identifies the data type of the equipment phase tag.  The type assigned should correspond to the actual 
data type in the data server.   

Valid Entries:  Real, Integer, String, Enumeration 

Item 

Enter the OPC item for the tag.  Make certain the appropriate OPC server is listed in the Server Name 
field.  If you have defined an OPC server for the iFIX OPCEDA driver, you can click the ? button to 
browse through the database tags.  If the tag you require does not exist, you can add a new tag to the 
database by entering the node.tag.field for the new tag in this field.   

iFIX Database Tag Valid Entries: NODE.TAG.FIELD 

Example:  DEMO.AI1.F_CV  
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Server  

The following table lists the contents of the Server area:  

Item Description 

Name Displays the server that is assigned to the equipment phase tag. 
 Select the down-arrow button to select a different server. 

App. 
Display-only field. 

Topic 
Displays-only field. 

Timeout 
Displays the watchdog field name within the data server. Proficy 
Batch Execution sets the value to 1, then expects the process-
connected device to clear this field within a specified time-out period. 
 If the process-connected device fails to clear this field within the 
designated time-out period, Proficy Batch Execution assumes 
communication is lost. 

   

Direct Phase Tag Template Dialog Box 
The Direct Phase Tag Template dialog box displays the following items: 

Enter Tag  

The following table lists the contents of the Enter Tag area:  

Item Description 

Alias Placeholder for the node name. If you want to edit the name, close 
this dialog box and enter the new node name into the Node field 
in the Direct Phase Template dialog box. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment Editor, 
the Name field in the Edit Equipment Phase dialog box replaces this 
generic PHASE placeholder. 
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Item Description 

Suffix 
The Enter tag suffix. By default, this value is set to _RE for Running, 
_OE for Holding, _HE for Held, _AE for Aborting, _PE for 
Stopping, and _TE for Restarting. 

Type 
The Enter tag type. By default, the tag type is set to the current value, 
displayed as a number (F_CV). 

Value 
Enter the value of the Enter tag.  By default this value is set to 1.  

Valid Entries:  For the active level, the acceptable values are 0 – 
65534.  For the inactive level, the acceptable values are 0 or 1.  

For example, when the controller indicates it is running, the 
controller sets the status to the active level.  When complete, the 
controller sets the status back to a 0 if the active level was 1 – 65534. 
Otherwise if the active level is zero, the controller sets the status to 1. 

Exit Tag  

The following table lists the contents of the Exit Tag area:  

Item Description 

Inverse of Enter Tag Select this check box if you want the Exit tag to use the same 
address as the Enter tag, but invert the active level.  For instance, 
if the Enter tag is equal to 1, the Exit tag would be set to 0. 

If you select this check box and the Enter tag is set to something 
other than a 1 or 0, the Exit tag is automatically set to 0. 

Alias Placeholder for the node name. If you want to edit the name, close 
this dialog box and enter the new node name into the Node field in 
the Direct Phase Template dialog box. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment Editor, 
the Name field in the Edit Equipment Phase dialog box replaces this 
generic PHASE placeholder. 
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Item Description 

Suffix 
The Exit tag suffix. By default, this value is set to _RX for Running, 
_OX for Holding, _HX for Held, _AX for Aborting, _PX for 
Stopping, and _TX for Restarting. 

Type 
The Exit tag type. By default, the tag type is set to the current value, 
displayed as a number (F_CV). 

Value 
Enter the value of the Exit tag.  By default this value is set to 1.  

Valid Entries:  For the active level, the acceptable values are 0 – 
65534.  For the inactive level, the acceptable values are 0 or 1. 

Status Tag  

The following table lists the contents of the Status Tag area:  

Item Description 

Same as Enter Tag Select this check box to make the Status tag use the same address 
as the Enter tag. 

Alias Placeholder for the node name. If you want to edit the name, close 
this dialog box and enter the new node name into the Node field in 
the Direct Phase Template dialog box. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment Editor, 
the Name field in the Edit Equipment Phase dialog box replaces this 
generic PHASE placeholder. 

Suffix 
The Status tag suffix. By default, the Status tag is set to _ST for 
standard phases. For Batch Direct phases, the Status tag is set to _RS 
for Running, _OS for Holding, _HS for Held, _AS for Aborting, _PS 
for Stopping, and _TS for Restarting. 

Type 
The Status tag type. By default, the tag type is set to the current 
value, displayed as a number (F_CV). 
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Item Description 

Operator 
Select a logical operator from the drop-down list. 

Value 
Enter the value of the Status tag.  By default this value is set to 1.  

Valid Entries:  For the active level, the acceptable values are 0 – 
65534.  For the inactive level, the acceptable values are 0 or 1. 

 

Direct Tag Template Dialog Box 
The Direct Tag Template dialog box displays the following items: 

Direct Tags  

The following table lists the contents of the Direct Tags area:  

Item Description 

Running 
Select this check box to enable the Running tags, by default, for 
new Batch Direct phases that you create. 

Holding 
Select this check box to enable the Holding tags, by default, for new 
Batch Direct phases that you create. 

And Held 
Select this check box to enable the Held tags, by default, for new 
Batch Direct phases that you create. 

And Restarting 
Select this check box to enable the Restarting tags, by default, for 
new Batch Direct phases that you create. 

Stopping 
Select this check box to enable the Stopping tags, by default, for 
new Batch Direct phases that you create. 

Aborting 
Select this check box to enable the Aborting tags, by default, for 
new Batch Direct phases that you create. 
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Standard Tags  

The following table lists the contents of the Standard Tags area:  

Item Description 

Failure Select this check box to enable the Failure tag, by default, for 
new Batch Direct phases that you create. 

Pause Select this check box to enable the Pause tag, by default, for new 
Batch Direct phases that you create. 

Single_Step 
Select this check box to enable the Single Step tag, by default, for 
new Batch Direct phases that you create. 

Step_Index 
Select this check box to enable the Step Index tag, by default, for 
new Batch Direct phases that you create. 

Unit 
Select this check box to enable the Unit tag, by default, for new 
Batch Direct phases that you create. 

Node 

Enter the server node name. The node you enter in this field is automatically entered into all the node 
fields for each tag. This is by design; all tags for a phase must have the same node name. 

Use Server Alias 

Click this button to populate all of the Server name fields with the "#ALIAS#." text. The #ALIAS# 
syntax allows you to use the Alias configured in the Create OPC Server dialog box.  

NOTE: To access the Create OPC Server dialog box, on the Edit menu, select Server. Select a server 
and click Edit, or click Add to add a new one. The dialog that displays after you click Edit or Add will 
display the Alias field. 
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Edit Area Dialog Box 
The Edit Area dialog box displays the following items: 

Name 

Enter the area name. 

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Example:  AREA1  

Version 

Enter the version number for the area. 

Edit Control Modules Dialog Box 
The Edit Control Modules dialog box displays the following items: 

Control Module Classes 

Lists the configured control module classes.  

Control Modules 

Lists the configured control modules defined for the selected control module class. 

Classes  

The following table lists the buttons to manipulate the Control Module Classes:  

Item Description 

Add Lets you add a control module class.   

Delete 
Deletes the selected control module class.  
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Control Modules  

The following table lists the buttons to work with Control Modules:  

Item Description 

Add Lets you add a new control module to the selected control module 
class.  

Delete 
Deletes the selected control module.  

   

Edit Direct Equipment Phase Class Dialog Box 
The Edit Equipment Phase Class dialog box displays the following items: 

General Tab 

The following table lists the contents of the General tab:  

Item Description 

Name Enter the direct equipment phase class name.  Equipment phase 
names can be up to 255 characters and must be unique within 
equipment phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the direct equipment phase type or leave this field blank.  

Icon 
Displays a list of available icons. 

Number of Request 
Tags 

Enter the number of request tags required for this equipment phase. 
 This number must match the number of requests that are made by 
the phase logic.   
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Item Description 

Number of Message 
Partners 

Enter the number of phase partners that this equipment phase must 
communicate with.   

Parameters Tab 

The following table lists the contents of the Parameters tab:  

Item Description 

Name Enter the direct equipment phase class name.  Equipment phase 
names can be up to 255 characters and must be unique within 
equipment phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character.  

Type 
Enter the equipment phase type or leave this field blank. 

Phase Parameters 
Lists the phase parameters that are currently configured for this 
equipment phase. 

Add 
Lets you add a parameter to the direct equipment phase. 

Edit 
Lets you edit the selected phase parameter.  

Delete 
Deletes the selected phase parameter. 
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Reports Tab 

The following table lists the contents of the Reports tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank.  

Phase Reports 
Lists the phase reports that are currently configured for this 
equipment phase. 

Add 
Lets you add a phase report to the direct equipment phase. 

Edit 
Lets you edit the selected phase report.  

Delete 
Deletes the selected phase report. 

Enable Tags Tab 

The following table lists the contents of the Enable Tags tab:  

Item Description 

Running State Select this check box to enable the Running state. 

Hold, Held, and Restarting 
States 

Select this check box to enable the Hold, Held, and Restarting 
states. 

Stopping State Select this check box to enable the Stopping state. 

Aborting State Select this check box to enable the Aborting state. 
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Item Description 

Failure Select this check box to enable the Failure state. 

Pause and Paused Select this check box to enable the Pause and Paused states. 

Single_Step Select this check box to enable the Single_Step state. 

Single_Index Select this check box to enable the Single_Index state. 

Unit Select this check box to enable the Unit state. 

   

Edit Direct Phase Tags Dialog Box 
The Edit Direct Phase Tags dialog box displays the following items: 

Enter Tag  

The following table lists the contents of the Enter Tag area:  

Item Description 

Alias Placeholder for the node name. If you want to edit the name, close 
this dialog box and enter the new node name into the Node field 
in the Direct Phase Template dialog box. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment Editor, 
the Name field in the Edit Equipment Phase dialog box replaces this 
generic PHASE placeholder. 

Suffix 
The Enter tag suffix. By default, this value is set to _RE for Running, 
_OE for Holding, _HE for Held, _AE for Aborting, _PE for 
Stopping, and _TE for Restarting. 

Type 
The Enter tag type. By default, the tag type is set to the current value, 
displayed as a number (F_CV). 
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Item Description 

Value 
Enter the value of the Enter tag.  By default this value is set to 1.  

Valid Entries:  For the active level, the acceptable values are 0 - 
65534.  For the inactive level, the acceptable values are 0 or 1.  

For example, when the controller indicates it is running, the 
controller sets the status to the active level.  When complete, the 
controller sets the status back to a 0 if the active level was 1 - 65534. 
Otherwise if the active level is zero, the controller sets the status to 1. 

Exit Tag  

The following table lists the contents of the Exit Tag area:  

Item Description 

Inverse of Enter Tag Select this check box if you want the Exit tag to use the same 
address as the Enter tag, but invert the active level.  For instance, 
if the Enter tag is equal to 1, the Exit tag would be set to 0. 

If you select this check box and the Enter tag is set to something 
other than a 1 or 0, the Exit tag is automatically set to 0. 

Alias Placeholder for the node name. If you want to edit the name, close 
this dialog box and enter the new node name into the Node field in 
the Direct Phase Template dialog box. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment Editor, 
the Name field in the Edit Equipment Phase dialog box replaces this 
generic PHASE placeholder. 

Suffix 
The Exit tag suffix. By default, this value is set to _RX for Running, 
_OX for Holding, _HX for Held, _AX for Aborting, _PX for 
Stopping, and _TX for Restarting. 

Type 
The Exit tag type. By default, the tag type is set to the current value, 
displayed as a number (F_CV). 
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Item Description 

Value 
Enter the value of the Exit tag.  By default this value is set to 1.  

Valid Entries:  For the active level, the acceptable values are 0 - 
65534.  For the inactive level, the acceptable values are 0 or 1. 

Status Tag  

The following table lists the contents of the Status Tag area:  

Item Description 

Same as Enter Tag Select this check box to make the Status tag use the same address 
as the Enter tag. 

Alias Placeholder for the node name. If you want to edit the name, close 
this dialog box and enter the new node name into the Node field in 
the Direct Phase Template dialog box. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment Editor, 
the Name field in the Edit Equipment Phase dialog box replaces this 
generic PHASE placeholder. 

Suffix 
The Status tag suffix. By default, the Status tag is set to _ST for 
standard phases. For Batch Direct phases, the Status tag is set to _RS 
for Running, _OS for Holding, _HS for Held, _AS for Aborting, _PS 
for Stopping, and _TS for Restarting. 

Type 
The Status tag type. By default, the tag type is set to the current 
value, displayed as a number (F_CV). 

Operator 
Select a logical operator from the drop-down list. 

Value 
Enter the value of the Status tag.  By default this value is set to 1.  

Valid Entries:  For the active level, the acceptable values are 0 - 
65534.  For the inactive level, the acceptable values are 0 or 1. 
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Edit Enumeration In Dialog Box 
The Edit Enumeration In dialog box displays the following items: 

Enumeration 

Enter the enumeration string for the corresponding ordinal value.  This is the string displayed to recipe 
authors and operators.  Enumeration string names must be unique within enumeration sets. 
Enumeration names should not contain spaces or these characters:  !@#$%^&*() 

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Example: WINTERGREEN   

Ordinal 

Enter the ordinal or number that represents the enumeration.  This number must match the number that 
is programmed into the phase logic in the process controller.  Ordinals must be unique within 
enumeration sets.  

Edit Enumeration Set Name Dialog Box 
The Edit Enumeration Set Name dialog box displays the following item: 

Enumeration Set 

Enter the enumeration set name.  Enumeration set names must be unique within enumeration sets. 
Enumeration set names should not contain spaces or these characters:  !@#$%^&*()"   

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Example: FLAVOR  

Edit Equipment Phase Class Dialog Box 
The Edit Equipment Phase Class dialog box displays the following items: 

General Tab 

The following table lists the contents of the General tab:  
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Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank.  

Icon 
Displays a list of available icons. 

Number of Request 
Tags 

Enter the number of request tags required for this equipment phase. 
 This number must match the number of requests that are made by 
the phase logic.   

Number of Message 
Partners 

Enter the number of phase partners that this equipment phase must 
communicate with.   

Parameters Tab 

The following table lists the contents of the Parameters tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank. 

Phase Parameters 
Lists the phase parameters that are currently configured for this 
equipment phase. 
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Item Description 

Add 
Lets you add a parameter to the equipment phase. 

Edit 
Lets you edit the selected phase parameter.  

Delete 
Deletes the selected phase parameter. 

Reports Tab 

The following table lists the contents of the Reports tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank.  

Phase Reports 
Lists the phase reports that are currently configured for this 
equipment phase. 

Add 
Lets you add a phase report to the equipment phase. 

Edit 
Lets you edit the selected phase report.  

Delete 
Deletes the selected phase report. 
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Operator Messages Tab 

The following table lists the contents of the Operator Messages tab:  

Item Description 

Name Enter the equipment phase class name.  Equipment phase names 
can be up to 255 characters and must be unique within equipment 
phase class names.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Type 
Enter the equipment phase type or leave this field blank.  

Operator Messages 
List the operator messages that are currently configured for this 
equipment phase.  These messages are displayed to the operator 
during manual phase control.   

Add 
Lets you add an operator message to the equipment phase.  

Edit 
Lets you edit the selected operator message.  

Delete 
Deletes the selected operator message. 

   

Edit Equipment Phase Dialog Box 
The Edit Equipment Phase dialog box displays the following items: 

Name 

Enter the equipment phase name.  Equipment phase names must be unique within an area model. 

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Examples:  COOL2, ADD_INGS2 
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Phase 

Displays the equipment phase class for this equipment phase.  

Icon 

Displays the icon that represents this equipment phase.  

Equipment Phase Tags  

The following table lists the contents of the Equipment Phase Tags area:  

Item Description 

Equipment Phase Tags 
list box 

Lists the equipment phase tags for this equipment phase. 
 Double-click a tag edit the tag.  

Server 
Lets you assign a server to all equipment phase tags.  

Defaults 
Resets all equipment phase tag names to the original Proficy Batch 
Execution defaults. 

Name 
Displays the name of the selected equipment phase tag.  To change 
the name, double-click the tag in the Equipment Phase Tags list 
box.   

Type 
Displays the data type of the selected equipment phase tag. 

Description 
Describes the selected equipment phase tag 

Arbitration  

The following table lists the contents of the Arbitration area:  

Item Description 

Equipment ID Enter the unique equipment ID to identify this equipment phase 
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Item Description 

Max Owners 
Enter the maximum number of owners that can simultaneously own 
this equipment phase. If the phase is shared, the maximum number 
of owners must be 1. 

Equipment Needed 
Lists the equipment that this equipment needs to own exclusively in 
order to begin operation.  

Add 
Lets you add equipment to the Equipment Needed list box. 

Remove 
Deletes the selected equipment from the Equipment Needed list box.  

   

Edit Equipment Phase Tag Dialog Box 
The Edit Equipment Phase Tag dialog box displays the following items: 

Name 

Enter the unit tag name.  

Class 

Enter the tag class for the unit tag. 

Type 

Identifies the data type of the equipment phase tag.  The type assigned should correspond to the actual 
data type in the data server.   

Valid Entries:  Real, Integer, String, Enumeration   

Item 

Enter the OPC item for the tag.  Make certain the appropriate OPC server is listed in the Server Name 
field.  If you have defined an OPC server for the iFIX OPCEDA driver, you can click the ? button to 
browse through the database tags.  If the tag you require does not exist, you can add a new tag to the 
database by entering the node.tag.field for the new tag in this field.   

iFIX Database Tag Valid Entries: NODE.TAG.FIELD 

Example:  DEMO.AI1.F_CV  
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Browse 

Click to browse through and select from a list of tags.  Note that this button is enabled only if you are 
using an OPC data server. 

Server  

The following table lists the contents of the Server area:  

Item Description 

Name Displays the server that is assigned to the equipment phase tag. 
 Select the down-arrow button to select a different server. 

Watchdog 
Displays the watchdog field name within the data server. Proficy 
Batch Execution sets the value to 1, then expects the process-
connected device to clear this field within a specified time-out 
period.  If the process-connected device fails to clear this field within 
the designated time-out period, Proficy Batch Execution assumes 
communication is lost.   

Edit Operator Message Dialog Box 
The Edit Operator Message dialog box displays the following items: 

Name 

Enter the text of the operator message.  This message is sent to the batch journal (.EVT file) and is 
displayed to the operator during manual phase control. 

ID 

Enter the operator message ID.  Messages are identified by this ID in the phase logic. 

Edit Phase Parameter Dialog Box 
The Edit Phase Parameter dialog box displays the following items: 

Name 

Enter the name of the equipment phase parameter.  
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ID 

Enter the phase parameter ID.  This ID must match the ID that is required by the phase logic. 

Type 

Select the data type for the phase parameter. 

Valid Entries:  Real, Integer, Sting, Enumeration  

Eng. Units 

Enter the engineering units for the phase parameter. 

High 

Enter the highest value that this parameter can be set to. 

Low 

Enter the lowest value that this parameter can be set to. 

Default 

Enter a default value for this parameter. 

Scale 

Select this check box to enable scaling for this parameter. 

Edit Phase Report Dialog Box 
The Edit Phase Report dialog box displays the following items: 

Name 

Enter the phase report name. 

ID 

Enter the phase report ID.  This ID must match the ID that is required by the phase logic. 

Type 

Select the data type for the phase report.  
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Valid Entries:  Real, Integer, String, Enumeration 

Eng. Units 

Enter the engineering units for the phase parameter. 

Edit Process Cell Class Dialog Box 
The Edit Process Cell Class dialog box displays the following items: 

Name 

Enter the name of a new process cell class.  Process cell class names must be unique within process 
cell classes.   

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Example:  INTYPLANT  

Icon 

Displays a list of available icons. 

Edit Process Cell Dialog Box 
The Edit Process Cell dialog box displays the following items: 

Name 

Enter the name of the process cell.  Process cell names must be unique. 

Valid Entries:  A - Z,  0 - 9, and the underscore character. 

Example:  TOOTHPASTE  

Class 

Displays the name of the process cell class from which this process cell was created.  

Icon 

Icon representing the process cell to be edited. 

Arbitration  

The following table lists the contents of the Arbitration area:  
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Item Description 

Equipment ID Enter the unique equipment ID to identify this piece of 
equipment. 

Max Owners 
Enter the maximum number of owners that can simultaneously own 
this process cell. 

Equipment Needed 
Lists the equipment that this equipment needs to own exclusively in 
order to begin operation.  

Add 
Lets you add equipment to the Equipment Needed list box. 

Remove 
Deletes the selected equipment from the Equipment Needed list box.  

HMI Process Cell Picture  

The following table lists the contents of the HMI Process Cell Picture area:  

Item Description 

HMI Process Cell 
Picture 

Enter the file name of the iFIX picture associated with this 
equipment entity.  You can associate pictures with process cells 
and units. 

iFIX Examples:  PLANT.GRF, MIX1.GRF 

Browse 
Browses directories for the HMI picture.  

Edit Servers Dialog Box 
The Edit Servers dialog box displays the following items: 

Servers 

Lists the currently configured data servers. 
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Alias 

Displays an alternate name associates with the active server. If you are using Batch Execution with 
Proficy Process Systems, the alternate name for the Proficy Process Systems is the active server; the 
format of this name is: Channel.Device. For example, for a channel named PAC1 and a device named 
D1, enter PAC1.D1 in this field. If you are using iFIX with Batch, the name you enter here is the 
Nodename. The name that appears in the Alias field will later be substituted into the Tag Template, 
after the template is configured.  

Watchdog 

Displays the time-out field within the data server.  Proficy Batch Execution sets the value of this field 
to 1, then expects the process-connected device to clear this field within the specified time-out period. 
 If the process-connected device fails to clear this field within the designated time-out period, Proficy 
Batch Execution assumes communication is lost.  

Bad Value String 

Identifies the string to represent bad values sent from the application. 

Server Type 

List the type of Server. For example: OPC. 

Default Server 

Select this check box to make the selected server the default server.  The equipment phases that you 
configure are assigned this server by default.   

Edit Server 

Click to edit the currently selected server. 

Delete Server 

Deletes the currently selected server. 

New Server 

Lets you configure a new server. 
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Edit Tags Dialog Box 
The Edit Tags dialog box displays the following items: 

Tag Classes 

Contains the tag classes for the area. 

Tags 

Lists the equipment phase tags for the selected tag class. 

Edit Tag 

Lets you edit the selected equipment phase tag in the Tags list box. 

Edit Unit Class Dialog Box 
The Edit Unit Class dialog box displays the following items: 

Name 

Enter a name for the unit class.  Unit class names must be unique within the unit classes. 

Valid Entries:  A - Z, 0 - 9, and the underscore character.   

Example:  MIXER  

Icon 

Displays a list of available icons. 

Tag Classes 

Lists the unit tag classes for this unit class.  A unit tag class is automatically created when the same 
class is assigned to more than one unit tag. 

Edit Unit Tag Dialog Box 
The Edit Unit Tag dialog box displays the following items: 

Name 

Enter the unit tag name.  
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Tag Class 

Enter the tag class for the unit tag. 

Type 

Identifies the data type of the equipment phase tag.  The type assigned should correspond to the actual 
data type in the data server. Valid entries include:  Real, Integer, String, Enumeration   

Item 

Enter the OPC item for the tag.  Make certain the appropriate OPC server is listed in the Server Name 
field.  If you have defined an OPC server for the iFIX OPCEDA driver, you can click the ? button to 
browse through the database tags.  If the tag you require does not exist, you can add a new tag to the 
database by entering the node.tag.field for the new tag in this field.   

iFIX Database Tag Valid Entries: NODE.TAG.FIELD 

Example:  DEMO.AI1.F_CV  

Browse (...) 

Click to browse through and select from a list of tags.  Note that this button is enabled only if you are 
using an OPC data server. 

Server  

The following table lists the contents of the Server area:  

Item Description 

Name Displays the server that is assigned to the equipment phase tag. 
 Select the down-arrow button to select a different server. 

App. Display-only value. 

Topic Display-only value. 



 

126 

Item Description 

Watchdog 
Displays the watchdog field name within the data server. Proficy 
Batch Execution sets the value to 1, then expects the process-
connected device to clear this field within a specified time-out 
period.  If the process-connected device fails to clear this field within 
the designated time-out period, Proficy Batch Execution assumes 
communication is lost.   

   

Enumeration Set Modification Dialog Box 
The Enumeration Set Modification dialog box displays the following items: 

Tags 

Lists the equipment phase tags that are assigned to the enumeration set. Proficy Batch Execution 
automatically assigns the new enumeration set name to all equipment phase tags listed.   

Parameters 

Lists the phase parameters that are assigned to the enumeration set. Proficy Batch Execution 
automatically assigns the new enumeration set name to all phase parameters listed.  

Example:  FLAVOR  ADD_INGS indicates that the FLAVOR parameter in the ADD_INGS 
equipment phase class is assigned to the enumeration set. 

Report Parameters 

Lists the phase reports that are assigned to the enumeration set. Proficy Batch Execution automatically 
assigns the new enumeration set name to all phase reports listed.  

Example:  COOL_TEMP indicates that the COOL_TEMP report in the COOL phase class is assigned 
to the enumeration set. 

File Export As Dialog Box 
The File Export As dialog box displays the following items: 

Save In 

Specifies the location where you want to locate a file or folder. Click the arrow to select another 
location, or click the icon on the toolbar to move up levels. The box below lists the items in the 
selected location. To open a file, in the Open dialog box, double-click the name of the file you want to 
open. To save a file using an existing file name, in the Save dialog box, double-click the name of the 
file you want to save. 
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Location 

Lists the folders and files in the selected location.  

Shortcuts 

Provides shortcuts to places on your computer or the network from which you can open a file, such as 
the History folder, the desktop, or My Network Places. When you click a location, it will appear in 
Look in, and the files and folders in the selected location will be listed at the right. 

File Name 

Provides a space for you to type the name of the file you want to open or save. To quickly find a file 
you’ve previously opened, click the file name in the drop-down list, if available: 

• If you are searching for a file, you can use asterisks (*) as wildcards. For example, you can 
type *.* to see a list of all files. You can also type the full path of a file, for example, 
C:\Mydocs\Letter.doc. 

• If you are saving a file, you cannot use a question mark (?) or an asterisk in the file name. If 
you use a question mark or asterisk and click Save, the file will not be saved and the dialog 
box will not close.  

Save As Type 

Specifies the type of file you are saving. 

File Import Dialog Box 
The File Import dialog box displays the following items: 

Look In 

Specifies the location where you want to locate a file or folder. Click the arrow to select another 
location, or click an icon on the toolbar to move up levels. The box below lists the items in the selected 
location. To open a file, in the Open dialog box, double-click the name of the file you want to open. To 
save a file using an existing file name, in the Save dialog box, double-click the name of the file you 
want to save. 

Location 

Lists the folders and files in the selected location.  

Shortcuts 

Provides shortcuts to places on your computer or the network from which you can open a file, such as 
the History folder, the desktop, or My Network Places. When you click a location, it will appear in 
Look in, and the files and folders in the selected location will be listed at the right. 
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File Name 

Provides a space for you to type the name of the file you want to open or save. To quickly find a file 
you’ve previously opened, click the file name in the drop-down list, if available. 

• If you are searching for a file, you can use asterisks (*) as wildcards. For example, you can 
type *.* to see a list of all files. You can also type the full path of a file, for example, 
C:\Mydocs\Letter.doc. 

• If you are saving a file, you cannot use a question mark (?) or an asterisk in the file name. If 
you use a question mark or asterisk and click Save, the file will not be saved and the dialog 
box will not close.  

Files of Type 

Lists the types of files to display. 

Import Equipment Model XML File Dialog Box 
The Select HMI Picture dialog box displays the followImport Equipment Model XMLing items: 

Look In 

Specifies the location where you want to locate a file or folder. Click the arrow to select another location, or click 
an icon on the toolbar to move up levels. The box below lists the items in the selected location. To open a file, in 
the Open dialog box, double-click the name of the file you want to open. To save a file using an existing file 
name, in the Save dialog box, double-click the name of the file you want to save. 

Location 

Lists the folders and files in the selected location.  

Shortcuts 

Provides shortcuts to places on your computer or the network from which you can open a file, such as 
the History folder, the desktop, or My Network Places. When you click a location, it will appear in 
Look in, and the files and folders in the selected location will be listed at the right. 

File Name 

Provides a space for you to type the name of the file you want to open or save. To quickly find a file 
you've previously opened, click the file name in the drop-down list, if available. 

• If you are searching for a file, you can use asterisks (*) as wildcards. For example, you can 
type *.* to see a list of all files. You can also type the full path of a file, for example, 
C:\Mydocs\Letter.doc. 

• If you are saving a file, you cannot use a question mark (?) or an asterisk in the file name. If 
you use a question mark or asterisk and click Save, the file will not be saved and the dialog 
box will not close.  
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Files of Type 

Lists the types of files to display. 

Manifold Properties Dialog Box 
The Manifold Properties dialog box displays the following items: 

Name 

Enter a unique name for the manifold. 

Orientation Group 

The following table lists the contents of the Orientation group:  

Item Description 

Vertical Select this option to display the manifold vertically. 

Horizontal 
Select this option to display the manifold horizontally. 

Arbitration  

The following table lists the contents of the Arbitration area:  

Item Description 

Equipment ID Enter the unique equipment ID to identify this manifold.  

Max Owners 
Lists the equipment that this equipment needs to own exclusively in 
order to begin operation.  

Equipment Needed 
Lists the equipment that this equipment needs to own exclusively in 
order to begin operation. 

Add 
Lets you add equipment to the Equipment Needed list box. 
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Item Description 

Remove 
Deletes the selected equipment from the Equipment Needed list box. 

   

Print Setup Dialog Box 
The Print Setup dialog box displays the following items: 

Name 

Lists the printers that are connected to your computer. 

Properties 

Click to set up options for the printer. The options available depend on the printer’s features. 

Paper 

The following table lists the contents of the Paper group:  

Item Description 

Size Specifies the size of the paper, envelope, or other print media you 
want to use. 

Source Specifies where the paper you want to use is located in the 
printer. Different printer models support different paper sources, 
such as the upper tray, envelope feed, and manual feed. 
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Orientation 

The following table lists the contents of the Orientation group:  

Item Description 

Portrait Specifies whether the document should be printed with its top 
along the short side of the paper (Portrait). 

Landscape Specifies whether the document should be printed along the long 
side of the paper (Landscape). 

 

Select Directories Dialog Box 
The Select Directories dialog box displays the following items: 

Process Cell Class Icons 

Enter the path where process cell class icons are located.  Typically this path is C:\Program 
Files\Proficy\Proficy Batch Execution\BMP\PROCCELL.  

Unit Class Icons 

Enter the path where unit class icons are located.  Typically this path is C:\Program 
Files\Proficy\Proficy Batch Execution\BMP\UNIT.  

Phase Icons 

Enter the path where equipment phase icons are located.  Typically this path is C:\Program 
Files\Proficy\Proficy Batch Execution\BMP\PHASE.  

Manifold Icons 

Enter the path where manifold icons are located.  Typically this path is C:\Program 
Files\Proficy\Proficy Batch Execution\BMP\MANIFOLD.  

Select Equipment Dialog Box 
The Select Equipment dialog box displays the following item: 
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Select Equipment 

Lists the configured equipment.  Click the plus sign to expand the folder containing the equipment you 
want to assign as needed equipment.  

Select HMI Picture Dialog Box 
The Select HMI Picture dialog box displays the following items: 

Look In 

Specifies the location where you want to locate a file or folder. Click the arrow to select another 
location, or click an icon on the toolbar to move up levels. The box below lists the items in the selected 
location. To open a file, in the Open dialog box, double-click the name of the file you want to open. To 
save a file using an existing file name, in the Save dialog box, double-click the name of the file you 
want to save. 

Location 

Lists the folders and files in the selected location.  

Shortcuts 

Provides shortcuts to places on your computer or the network from which you can open a file, such as 
the History folder, the desktop, or My Network Places. When you click a location, it will appear in 
Look in, and the files and folders in the selected location will be listed at the right. 

File Name 

Provides a space for you to type the name of the file you want to open or save. To quickly find a file 
you’ve previously opened, click the file name in the drop-down list, if available. 

• If you are searching for a file, you can use asterisks (*) as wildcards. For example, you can 
type *.* to see a list of all files. You can also type the full path of a file, for example, 
C:\Mydocs\Letter.doc. 

• If you are saving a file, you cannot use a question mark (?) or an asterisk in the file name. If 
you use a question mark or asterisk and click Save, the file will not be saved and the dialog 
box will not close.  

Files of Type 

Lists the types of files to display. 
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Set Tag Server Dialog Box 
The Set Tag Server dialog box displays the following items: 

Name 

Displays the server that is assigned to the equipment phase tag.  Select the down-arrow button to select 
a different server. 

Watchdog 

Displays the watchdog field name within the data server. Proficy Batch Execution sets the value to 1, 
then expects the process-connected device to clear this field within a specified time-out period.  If the 
process-connected device fails to clear this field within the designated time-out period, Proficy Batch 
Execution assumes communication is lost.   

Change All Tags 

Changes the server for all of the equipment phase’s tags. 

Share Equipment Phase Dialog Box 
The Share Equipment Phase dialog box displays the following item: 

Share Equipment Phase List Box 

Click the plus sign (+) next to the equipment entity that contains the equipment you want to share. 
 Then, double-click the equipment entity you want to share. 

Share Unit Dialog Box 
The Share Unit dialog box displays the following item: 

Share Unit List Box 

Click the plus sign (+) next to the equipment entity that contains the equipment you want to share. 
 Then, double-click the equipment entity you want to share. 
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Standard Phase Template Dialog Box 
The Standard Phase Template dialog box displays the following items: 

Command Row 

The following table lists the contents of the Command Row:  

Item Description 

Server Alias The SCADA server node name. The node you enter in this field 
is automatically entered into all the other node fields. This is by 
design; all tags for a phase must have the same node name. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Command register in the PLI.  By default, the Command 
register is set to _VC. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Failure Row 

The following table lists the contents of the Failure Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  
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Item Description 

Suffix 
The Failure register in the PLI.  By default, the Failure register is 
set to _F. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Owner Row 

The following table lists the contents of the Owner Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Owner register in the PLI.  By default, the Owner register is set 
to _W. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Pause Row 

The following table lists the contents of the Pause Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 
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Item Description 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Pause register in the PLI.  By default, the Pause register is set 
to _P. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Paused Row 

The following table lists the contents of the Paused Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Paused register in the PLI.  By default, the Paused register is 
set to _PD. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 
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Request Row 

The following table lists the contents of the Request Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Request register in the PLI.  By default, the Request register is 
set to _RQ. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Single_Step Row 

The following table lists the contents of the Single_Step Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Single Step register in the PLI.  By default, the Single Step 
register is set to _SS. 
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Item Description 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Status Row 

The following table lists the contents of the Status Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Status tag suffix. By default, the Status tag is set to _ST for 
standard phases. For Batch Direct phases, the Status tag is set to 
_RS for Running, _OS for Holding, _HS for Held, _AS for 
Aborting, _PS for Stopping, and _TS for Restarting. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Step Index Row 

The following table lists the contents of the Step Index Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 
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Item Description 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Step Index register in the PLI.  By default, the Step Index 
register is set to _SI. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Unit Row 

The following table lists the contents of the Unit Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Unit register in the PLI.  By default, the Unit register is set to 
_UN. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 
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Parameter Row 

The following table lists the contents of the Parameter Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Parameter Value register in the PLI.  By default, the Parameter 
Value register is set to P. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Report Row 

The following table lists the contents of the Report Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Report Value register in the PLI.  By default, the Report Value 
register is set to R. 
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Item Description 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Request Tag Row 

The following table lists the contents of the Request Tag Row:  

Item Description 

Server Alias The SCADA server node name. This field is automatically 
populated with the name you enter in the Node field for the 
Command tag. 

Phase 
Placeholder for the actual phase name. You cannot edit this field. 

When you add or modify equipment phases in the Equipment 
Editor, the Name field in the Edit Equipment Phase dialog box 
replaces this generic PHASE placeholder.  

Suffix 
The Request Data register in the PLI.  By default, the Request Data 
register is set to Q. 

Extension 
The field type. By default, the field type is set to the current value, 
displayed as a number (F_CV). 

Use Server Alias 

Click this button to populate all of the Server name fields with the "#ALIAS#." text. The #ALIAS# 
syntax allows you to use the Alias configured in the Create OPC Server dialog box.  

NOTE: To access the Create OPC Server dialog box, on the Edit menu, select Server. Select a server 
and click Edit, or click Add to add a new one. The dialog that displays after you click Edit or Add will 
display the Alias field. 
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Tag Template Dialog Box 
The Tag Template dialog box displays the following items: 

Server Alias 

Displays the alias for the server node name. You cannot edit this field. 

Phase 

Displays the phase name. You cannot edit this field. 

Suffix 

The Command register in the PLI.   

Extension 

The field type.  

Unit Properties Dialog Box 
The Unit Properties dialog box displays the following items: 

General Tab 

The following table lists the contents of the General tab:  

Item Description 

Name Enter the unit name.  Unit names must be unique within an area 
model.   

Valid Entries:  A - Z, 0 - 9, and the underscore character.  

Examples:  FLAVORING, WATER  

Class 
Displays the name of the unit class from which this unit was created. 

Icon 
Icon representing the unit to be edited.   
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Item Description 

HMI Unit Picture 
Enter the file name of the iFIX picture associated with this 
equipment entity.  You can associate pictures with process cells and 
units. 

iFIX Examples:  PLANT.GRF, MIX1.GRF 

Browse 
Click to browse directories for the HMI picture. 

Master Process Cell 
Specifies the process cell that the unit will report against in the 
Event Journal.   

Equipment Capacity Tab 

The following table lists the contents of the Equipment Capacity tab:  

Item Description 

Name Enter the unit name.  Unit names must be unique within an area 
model.   

Valid Entries:  A - Z, 0 - 9, and the underscore character.  

Examples:  FLAVORING, WATER  

Class 
Displays the name of the unit class from which this unit was created. 

Amount 
Enter the maximum amount that the unit can contain, transfer, or 
process.  During Active Binding, Proficy Batch Execution uses this 
criteria to select units that meet the unit procedure's minimum 
capacity requirement defined in the recipe.   

Example:  If a unit procedure requires a unit capacity of 1000 Liters, 
the selected unit must have a capacity amount that is greater than or 
equal to 1000 Liters.   
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Item Description 

UOM 
Enter or select the Unit's Unit of Measure (UOM).  If you enter a 
UOM that does not exist, Proficy Batch Execution prompts you to add 
it to the UNIT_OF_MEASURE enumeration set. 

NOTE: If you want Proficy Batch Execution to consider a unit’s 
capacity as part of its unit selection criteria, assign the same UOM to 
(1) all units within the same unit class, and (2) the unit procedure’s 
capacity requirement.  If a unit has a different UOM than the UOM 
specified in the unit procedure’s capacity requirement, Proficy Batch 
Execution ignores the unit’s capacity amount as part of the selection 
criteria.  

Unit Tags Tab 

The following table lists the contents of the Reports tab:  

Item Description 

Name Enter the unit name.  Unit names must be unique within an area 
model.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Examples:  FLAVORING, WATER  

Class Displays the name of the unit class from which this unit was created. 

Use Unit Ready Tag Select this option if your process uses a Unit Ready tag value to 
determine if the unit is ready for use. Proficy Batch Execution checks 
the value of this tag to determine if this unit can be allocated to a 
batch. 

Example:  If the Unit Ready tag value is set to zero (0), this indicates 
the unit is online and Proficy Batch Execution can allocate the unit to 
a batch.  If the tag is set to a non-zero value, Proficy Batch Execution 
cannot allocate this unit to a batch. 

Unit Always Ready Select this option to define the unit as always ready for use (online). 
 With this option selected, Proficy Batch Execution can allocate this 
unit to a batch. 

Unit Always Not Ready Select this option to define the unit as always not ready for use 
(offline).  With this option selected, Proficy Batch Execution cannot 
allocate this unit to a batch.    

Edit Tag Lets you define the Unit Ready tag name and data server. 
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Item Description 

Use Unit Priority Tag Select this option if your process uses a Unit Priority tag to determine 
the unit's priority.  With this option selected, Proficy Batch Execution 
checks the priority tag's value and selects the unit with the highest 
priority value. 

Use Default Priority Select this option to define a priority value for the unit.  Enter a value 
in the edit box to indicate the unit's relative importance, compared to 
other units within the same unit class.  With this option selected, 
Proficy Batch Execution selects the unit with the highest priority 
value. 

Valid Entries:  0 through 2,147,483,647  

Edit Tag Lets you define the Unit Priority tag name and data server.  

User Defined Tags Lists the unit tags configured for this unit.  

Add Lets you add a unit tag for this unit.  

Edit Lets you edit the currently selected unit tag.  

Remove Deletes the currently selected unit tag. 

Arbitration Tab 

The following table lists the contents of the Arbitration tab:  

Item Description 

Name Enter the unit name.  Unit names must be unique within an area 
model.   

Valid Entries:  A - Z, 0 - 9, and the underscore character. 

Examples:  FLAVORING, WATER  

Class 
Displays the name of the unit class from which this unit was created. 

Equipment ID 
Enter the unique equipment ID to identify this unit.   
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Item Description 

Max Owners 
Enter the maximum number of owners that may simultaneously own 
this unit. 

Equipment Needed 
Lists the equipment that this equipment needs to own exclusively in 
order to begin operation.  

Add 
Lets you add equipment to the Equipment Needed list box. 

Remove 
Deletes the selected equipment from the Equipment Needed list box.  

   

Zoom Dialog Box 
The Zoom dialog box displays the following items: 

Scale  

The following table lists the contents of the Scale area:  

Item Description 

50% Use this command to reduce the work area display by 50%.  

100% 
Use this command to return to the normal display size of 100%.  

150% 
Use this command to magnify the work area by 150%.   

200% 
Use this command to magnify the work area by 200%.   

250% 
Use this command to magnify the work area by 250%.   
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Item Description 

300% 
Use this command to magnify the work area by 300%.   

Custom 
Enter the zoom percentage. Valid values include 50 through 300 
percent. 

Default 

Returns the picture to the default view (100%).   

How Do I... 
The following sections explain how to work with the Equipment Editor: 

• Configuring an Area Model 

• Defining Data Servers 

• Configuring Areas 

• Configuring Process Cells 

• Configuring Units 

• Configuring Unit Connections 

• Configuring Equipment Phases 

• Configuring Control Modules 

• Configuring Enumerations 

• Configuring Arbitration 

• Configuring Shared Resources 

Configuring an Area Model 
For information on configuring an area model, refer to the following sections: 

• Overview: Configuring an Area Model 

• Importing a .TXT Version of the Area Model 

• Importing an .XML Version of the Area Model 

• Exporting the Area Model 

• Viewing Audit Versioning Information 
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Overview: Configuring an Area Model 

To configure an area model: 

1. In the Batch Equipment Editor or WorkSpace, configure an area. 

2. Configure process cell classes. 

3. Configure process cell instances.  

4. Configure unit classes.  

5. Configure unit instances. 

6. Configure the equipment paths between physically connected units.  

7. Configure a server. 

8. Configure equipment phase classes.  

9. Configure equipment phase instances.  

Importing a .TXT Version of the Area Model 

To import a .TXT version of the area model: 

1. In the Batch Equipment Editor, on the File menu, point to Import, and then click Text. A 
message appears explaining that the existing .CFG file will be overwritten. 

2. Select OK to continue. The File Import dialog box appears. 

3. From the File Import dialog box, enter the name of the text file to import in the File name 
field and click Open. 

NOTE: The imported .TXT file must be in ASCII format. 

4. Enter any required electronic signatures: 

• If a Performed By electronic signature is required for the import command, a dialog 
appears requesting the appropriate signature.  

• If a Verified By electronic signature appears, a second dialog appears requesting the 
appropriate signature. 

Importing an .XML Version of the Area Model 

To import an .XML version of the area model: 

1. In the Batch Equipment Editor, on the File menu, point to Import, and then click XML. A 
message appears indicating that Proficy Batch Execution will modify the existing .CFG file. 

2. Click OK to continue. The Import Equipment Model XML File dialog box appears. 

3. From the Import Equipment Model XML File dialog box, select the file that you want to 
import. 

4. Click Open. 

5. Enter any required electronic signatures:  
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• If a Performed By electronic signature is required for the import command, a dialog 
appears requesting the appropriate signature. 

• If a Verified By electronic signature appears, a second dialog appears requesting the 
appropriate signature. 

The file then opens in the Proficy Batch Execution Equipment Editor. 

Exporting the Area Model 

To export the current area model: 

1. On the File menu (Equipment Editor) or Area menu (WorkSpace), click Export. The sub-
menu opens with the export formats. 

2. Select either Text or XML as the export format. The File Export As dialog box appears unless 
Proficy Batch Execution requires that you enter electronic signatures first. 

3. From the File Export As dialog box, in the File name field, enter a name for the file. 

4. Select a location to save the file. 

5. Click Save. 

6. Enter any required electronic signatures: 

• If a Performed By electronic signature is required for the export command, a dialog 
appears requesting the appropriate signature. 

• If a Verified By electronic signature appears, a second dialog appears requesting the 
appropriate signature. 

Viewing Audit Versioning Information 

To view the audit versioning information for the current file: 

1. In the Batch Equipment Editor or WorkSpace, on the File menu, click Audit Information. The 
Audit Information dialog box appears. 

2. Examine each of the fields. 

The fields displayed in the Audit Information dialog box include the audit version number and 
electronic signature information for the user(s) who authorized the Proficy Batch Execution 
Equipment Editor to save the current version of the area model.  

NOTE: Information only appears in these fields if you enabled auditing and configured Save 
or Save As signature requirements in the Batch Execution Configuration dialog box in the 
WorkSpace, and then saved the area model with the required electronic signatures. 
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Defining Data Servers 
For information on defining data servers, refer to the following sections: 

• Defining an OPC Data Server 

• Defining the VBSIM Server 

• Selecting a Default Data Server 

• Selecting the Equipment Phase Data Server 

Defining an OPC Data Server 

To define an OPC data server: 

1. In the Batch Equipment Editor or WorkSpace, on Edit menu, click Servers. The Edit Servers 
dialog box appears. 

2. Click the New Server button. The Edit Server Name dialog box appears. 

3. In the Server Name field, enter the name of the OPC server and click the OPC Server button. 
The Create OPC Server dialog box appears. 

4. In the Select a Server list box, select the OPC I/O driver you want to associate with the OPC 
server name. 

To communicate with iFIX SCADA Server, select the I/O driver Intellution.OPCEDA. For the 
GES OPC Server for Proficy Process Systems, select the GE.GES.OPCServer server name. 

5. In the Alias field, enter an alternate name that you would like to associate with the active 
server for Proficy Process Systems. The format of this name is: Channel.Device. 

The name that you enter here will later be substituted into the Tag Template, after it is 
configured. For example, for a channel named PAC1 and a device named D1, enter PAC1.D1 
in this field. 

6. In the Watchdog field, enter a tag to act as a watchdog register. For Proficy Process Systems, 
the format of this name is: Channel.Device.WatchDog.WD.  

For example, for Proficy Process Systems, for channel named PAC1, a device named D1, and 
a Watchdog function block named WD5, enter PAC1.D1.WD5.WD in this field. 

7. Click OK. The new OPC server appears in the list in the Edit Servers dialog box. 

Selecting a Default Data Server 

To select a default data server: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Servers. The Edit 
Servers dialog box appears. 

2. Highlight the server that by default you want to assign to all equipment phase tags. 

3. Select the Default Server check box. 
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Selecting the Equipment Phase Data Server 

To select an equipment phase’s data server: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, double-click the phase 
instance. The Edit Equipment Phase dialog box appears. 

2. Click the Server button. The Set Tag Server dialog box appears. 

3. Click the down arrow next to the Name field and select the appropriate data server. 

4. Confirm that the Change All Tags check box is selected to assign this server to all tags. This 
check box is unavailable for editing; it should be automatically selected for you. 

5. Click OK. 

Configuring Areas 

To configure an area: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Areas. The Edit Area 
dialog box appears. 

2. Enter a unique area name. 

3. Enter a version number for the area. 

4. Click OK. 

NOTE: Starting the Equipment Editor automatically creates a default area called AREA1. 

Configuring Process Cells 
For information on configuring process cells, refer to the following sections: 

• Overview: Configuring Process Cells 

• Configuring Process Cell Classes 

• Configuring Process Cell Instances 

• Configuring Process Cell Instances to Toggle to an iFIX Picture 

• Maintaining Process Cells 

Overview: Configuring Process Cells 

To configure process cells: 

1. Define a process cell class. 

2. Define a process cell instance.  
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Configuring Process Cell Classes 

To configure a process cell class: 

1. In the Batch Equipment Editor or WorkSpace at the process cell level, on the Class menu, 
click New. The Create Process Cell Class dialog box appears. 

2. In the Name field, enter the process cell name. 

3. Select an appropriate icon for the process cell. 

4. Click OK. 

Configuring Process Cell Instances 

To configure a process cell instance: 

1. In the Batch Equipment Editor or WorkSpace at the process cell level, in the Cell Classes 
area, select a cell class. 

2. Move the pointer into the work area and click once. An instance of the process cell class 
appears. 

3. Right-click the mouse button and select Cell Properties from the pop-up menu. The Edit 
Process Cell dialog box appears. 

4. In the Name field, enter the process cell name. 

5. In the HMI Process Cell Picture field, enter the corresponding iFIX picture. 

6. Enter any equipment arbitration information.  

7. Specify any needed equipment.  

8. Click OK. 

Configuring Process Cell Instances to Toggle to an iFIX Picture 

To configure a process cell or unit instance to toggle to an iFIX picture: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, right-click the process cell or 
unit instance, and select Cell Properties or Unit Properties. The Edit Process Cell or Edit Unit 
Properties dialog box appears. 

2. In the HMI Process Cell or Unit Picture field, enter the corresponding iFIX picture name, 
including the file path. 

3. Click OK. 

Maintaining Process Cells 

For information on maintaining process cells, refer to the following sections: 

• Modifying Process Cells 

• Deleting Process Cells 
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Modifying Process Cells 

To modify a process cell: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, select the process cell you 
want to modify. 

2. Right-click the process cell and select Class Properties. The Edit Process Cell Class dialog 
box appears. 

3. Enter your changes and click OK. 

4. Right-click the process cell and select Cell Properties. The Edit Process Cell dialog box 
appears. 

5. Enter your changes and click OK. 

Deleting Process Cells 

To delete a process cell: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, click the process cell you 
want to delete. 

2. Press the Delete key on the keyboard. 

NOTE: Before you can delete a process cell, you must first delete all units and equipment 
phases within the process cell. 

Configuring Units 
For information on configuring units, refer to the following sections: 

• Overview: Configuring Units 

• Configuring a Unit Class 

• Configuring Unit Instances 

• Configuring Unit Capacity 

• Connecting Units 

• Configuring Unit Tags 

• Maintaining Units 

Overview: Configuring Units 

To configure units: 

1. In the Batch Equipment Editor or WorkSpace, configure a unit class. 

2. Configure a unit instance.  

3. Configure the unit's equipment capacity.  
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4. If appropriate, define unit tags.  

5. Configure the unit's equipment paths.  

6. If the unit is shared by another process cell, share the unit.  

Configuring a Unit Class 

To configure a unit class: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, double-click the process cell 
containing the units you are configuring. 

2. On the toolbar, click the Add New Object button. The Create Unit Class dialog box appears. 

3. In the Name field, enter a class name. 

4. Click an appropriate icon. 

5. Click OK. The unit class appears in the Configured Classes window. 

NOTE: Tag classes are automatically created when you define more than one unit tag of the 
same class on multiple units. 

Configuring Unit Instances 

To configure a unit instance: 

1. In the Batch Equipment Editor or WorkSpace, in the Phase Classes area, click a class. The 
cursor changes to a right angle. 

2. Move the cursor into the work area and click the mouse button. An instance of the unit 
appears. 

3. Right-click the mouse button and select the Unit Properties command from the pop-up menu. 
The Unit Properties dialog box appears. 

4. In the Name field, enter a unit name. 

5. In the HMI Unit Picture field, enter the corresponding iFIX picture. 

6. Define the unit's equipment capacity.  

7. Configure user-defined unit tags, Unit Ready, and Unit Priority tags.  

8. Enter any equipment arbitration information.  

9. Specify any needed equipment.  

10. Click OK. 

Configuring Unit Capacity 

To configure a unit's equipment capacity: 

1. In the Batch Equipment Editor or WorkSpace, in the Phase Classes area, left-click the mouse 
on a phase class. The cursor changes to a right angle when you move it into the work area. 

2. Click inside the work area. An instance of the unit appears. 
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3. Right-click the mouse button and select the Properties command from the pop-up menu. The 
Unit Properties dialog box appears. 

4. Select the Equipment Capacity tab. 

5. In the Amount field, enter the maximum amount the unit can contain, transfer, or process. 

6. In the UOM field, enter the unit's unit of measure. Choose from a list of predefined UOMs or 
enter a new unit of measure and add it to the UNIT_OF_MEASURE enumeration set.  

NOTE: If you want Proficy Batch Execution to consider a unit’s capacity as part of its unit 
selection criteria, assign the same UOM to (1) all units within the same unit class, and (2) the 
unit procedure’s capacity requirement. If a unit has a different UOM than the UOM specified 
in the unit procedure’s capacity requirement, Proficy Batch Execution ignores the unit’s 
capacity amount as part of the selection criteria. 

Connecting Units 

To link physically connected units together: 

1. If you are linking multiple units together, in the Batch Equipment Editor or WorkSpace, click 
the Manifold button to drop in a manifold object. 

2. On the toolbar, click the Link Units button. The cursor changes to indicate that you are in 
connection mode. 

3. Position the cursor over a handle on the origin unit. This highlights the handle. 

4. Press and hold the left mouse button down while dragging the pointer from the origin unit to a 
handle on either the destination unit or manifold object. 

5. Release the left mouse button. A connector line appears with the arrow pointing to the 
destination unit or manifold object. 

6. Optionally, configure connection properties.  

7. Optionally, configure manifold properties.  

Configuring Unit Tags 

For information on configuring unit tags, refer to the following sections: 

• Configuring Unit Tags 

• Configuring Unit Ready and Unit Priority Tags 

• Configuring User-Defined Unit Tags 

• Adding Unit Tags to the iFIX Database 

Configuring Unit Tags 

To configure unit tags: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, select the unit instance 
containing the unit tags you want to define. 

2. Right-click the unit and select the Unit Properties. The Unit Properties dialog box appears. 
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3. Select the Unit Tags tab. 

4. Configure Unit Ready and Unit Priority tags.  

5. Configure user-defined unit tags.  

Configuring Unit Ready and Unit Priority Tags 

To configure Unit Ready and Unit Priority tags: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, select the unit instance 
containing the unit tags you want to define. 

2. Right-click the unit and select the Unit Properties. The Unit Properties dialog box appears. 

3. Select the Unit Tags tab. 

4. In the Unit Ready area, select the appropriate option. 

5. In the Unit Priority area, select the appropriate option. 

6. If you selected either the Use Unit Ready Tag or Use Unit Priority Tag options, click the Edit 
Tag button. The Edit Unit Tag dialog box appears. 

7. Select the Server for the tag in the Server field. 

NOTE: The correct server type must be configured before configuring tags. 

8. Enter the OPC tag name or click the browse button next to the Item field to display the 
Browse OPC Items dialog box. If you are using the iFIX OPC server and the tag you require 
does not exist, you can add the tag to the database. For more information, refer to the Adding 
a Unit Tag to the iFIX Database section. 

NOTES: (a) The browse functionality is available only if your OPC server supports the 
browse function as defined in the OPC Specification. GE’s OPC server supports the browse 
function. (b) The correct server type must be configured before configuring tags. 

9. Click the plus (+) sign to expand the selected server’s tags. 

10. Double-click a tag from the list. The tag name appears in the Item field. 

11. Click OK to return to the Edit Equipment Phase Tag dialog box. 

Configuring User Defined Unit Tags  

To configure user defined unit tags: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, select the unit instance 
containing the unit tags you want to define. 

2. Right-click the unit and select the Unit Properties. The Unit Properties dialog box appears. 

3. Select the Unit Tags tab. 

4. In the User Defined Tags area, click the Add button. The Create Unit Tag dialog box appears. 

5. Enter a unique unit tag name in the Name field. 

IMPORTANT: Do not use UNITNAME_STATUS or UNITNAME_PRIORITY (where 
UNITNAME is the actual name of the unit) for the unit tag names because Proficy Batch 
Execution uses these names internally to represent the Ready and Priority tags, respectively. 



Equipment Configuration Manual  

157 

These names are reserved. 

6. Enter a new tag class in the Tag field or select an existing class using the down-arrow. 

Assigning multiple unit tags to the same class across units automatically creates a unit tag 
class. 

7. Click the down-arrow next to the Type field to select the data type. 

8. If the tag uses an enumeration data type, select the enumeration set in the Enum field.  

9. Enter the tag name or click the browse button next to the Item field to display the Browse 
OPC Items dialog box. If you are using the iFIX OPC server and the tag you require does not 
exist, you can add the tag to the database. For more information, refer to the Adding a Unit 
Tag to the iFIX Database section. 

NOTES: (a) The browse functionality is available only if your OPC server supports the 
browse function as defined in the OPC Specification. GE’s OPC server supports the browse 
function. (b) The correct server type must be configured before configuring tags. 

10. Click the plus sign to expand the selected server’s tags. 

11. Double-click a tag from the list. 

12. The tag name appears in the Item field. 

13. Click OK to return to the Edit Equipment Phase Tag dialog box. 

Adding a Unit Tag to the iFIX Database 

To add a unit tag to the iFIX database: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, select a unit. 

2. Right click the unit select Unit Properties. The Edit Unit dialog box appears. 

3. Select the Unit Tags tab. 

4. For Unit Ready and Unit Priority tags, click the Edit Tag button. For user-defined tags, click 
the Add button. The Create or Edit Unit Tag dialog box appears. 

5. In the Server area, enter the Intellution OPC server in the Name field. Click the down-arrow 
to select from a list of configured servers. 

6. In the Item field, enter the node.tag.field for the tag that you want to add to the database. A 
message appears indicating that the tag does not exist and asks if you want to add it to the 
database.  

7. Click Yes to add the tag to the new database. The iFIX Add Block dialog box appears. 

8. Select the block type you want to add to the database. The selected block’s dialog box 
appears. 

9. Configure the block and click OK. The new block is added to the iFIX database and is 
assigned to the unit tag. 

NOTE: When saving and exiting the WorkSpace, you are prompted to save your changes in 
the database if a tag was added through the Equipment Editor. 
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Maintaining Units 

For information on maintaining units, refer to the following sections: 

• Deleting Units 

• Modifying Units 

Modifying Units 

To modify a unit: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, click the unit you want to 
modify. 

2. Right-click the unit and select Class Properties. The Edit Equipment Class Properties dialog 
box appears. 

3. Enter you changes and click OK. 

Deleting Units 

To delete a unit: 

IMPORTANT: If this unit is shared, refer to the Deleting a Shared Unit Instance or Deleting 
a Master Shared Unit section for steps on how to delete. The keyboard Delete button cannot 
be used to delete a shared instance. 

1. In the Batch Equipment Editor or WorkSpace, in the work area, click the unit you want to 
delete. 

2. Press the Delete key on the keyboard. 

NOTE: Before you can delete a unit, you must first delete all equipment phases within the 
unit.  

Configuring Unit Connections 
For information on configuring unit connections, refer to the following sections: 

• Connecting Units 

• Configuring Connection Properties 

• Configuring Manifold Properties 

Connecting Units 

To link physically connected units together: 

1. If you are linking multiple units together, in the Batch Equipment Editor or WorkSpace, click 
the Manifold button to drop in a manifold object. 
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2. On the toolbar, click the Link Units button. The cursor changes to indicate that you are in 
connection mode. 

3. Position the cursor over a handle on the origin unit. This highlights the handle. 

4. Press and hold the left mouse button down while dragging the pointer from the origin unit to a 
handle on either the destination unit or manifold object. 

5. Release the left mouse button. A connector line appears with the arrow pointing to the 
destination unit or manifold object. 

6. Optionally, configure connection properties.  

7. Optionally, configure manifold properties.  

Configuring Connection Properties 

To configure properties for connections: 

1. In the Batch Equipment Editor or WorkSpace, create the connection.  

2. Double-click the connection line. The Connection Properties dialog box appears. 

3. In the Name field, enter a name for the connection. 

4. Optionally, in the Label field, provide a descriptive label for the connection. 

5. Enter any equipment arbitration information.  

6. Specify any needed equipment.  

Configuring Manifold Properties 

To configure properties for manifolds: 

1. In the Batch Equipment Editor or WorkSpace, create a manifold object.  

2. Double-click the manifold object. The Manifold Properties dialog box appears. 

3. In the Name field, enter a name for the manifold. 

4. Select either Vertical or Horizontal orientation. 

5. Enter any equipment arbitration information.  

6. Specify any needed equipment.  

Configuring Equipment Phases 
For information on configuring equipment phases, refer to the following sections: 

• Configuring the Standard Phase Template 

• Configuring the Direct Phase Template 

• Overview: Configuring Equipment Phases 

• Configuring Equipment Phase Classes 
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• Configuring Equipment Phase Parameters 

• Configuring Equipment Phase Reports 

• Configuring Operator Messages 

• Configuring Equipment Phase Instances 

• Updating the Edit Equipment Phase Dialog Box 

• Tying Equipment to the Data 

• Adding an Equipment Phase Tag to an iFIX Database 

• Assigning OPC Data Items to Standard Equipment Phase Tags 

• Editing Enter, Exit, and Status Tags for a State Block in a Direct Phase 

• Modifying the Standard Tags for a Direct Phase 

• Modifying the Direct Phase tag 

• Maintaining Equipment Phases 

Configuring the Standard Tag Template 

To configure the Standard Tag Template: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Tag Template. The 
Standard Phase Template dialog box appears. 

2. If you want to change the SCADA node name, enter a new value in the Node field for the 
Command tag, including the separator – for example, a period (.). This value automatically 
populates the other Node name fields. Otherwise, click the Use Server Alias button to 
populate all of the Server name fields with the "#ALIAS#." text. The #ALIAS# syntax allows 
you to use the Alias configured in the Create OPC Server dialog box. 

NOTE: To access the Create OPC Server dialog box, on the Edit menu, select Server. Select 
a server and click Edit, or click Add to add a new one. The dialog that displays after you click 
Edit or Add will display the Alias field for you to edit. You will want to use the Alias feature 
when using Proficy Process Systems with Batch Execution. 

3. In the Suffix field, the third column, enter the separator and PLI variable for the standard tags. 
For example, for the RX7i, you would enter a period (.) before each suffix name, instead of 
the underscore (_) that appears by default for iFIX. 

4. If you want to change the field type for any of the standard tags, in the Extension fields, enter 
each of your changes in the fourth column. For example, for iFIX the extension for the current 
value is .F_CV. 

5. After you finish making updates, click OK. 

Configuring the Direct Phase Template 

To configure the Direct Phase Template: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Direct Tag Template. 
The Direct Tag Template dialog box appears. 

2. From the Direct Tag Template dialog box, select the check box for each state that you want to 
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enable, by default. 

3. To modify the Enter, Exit, and Status tags for the direct phase state blocks, in the Direct Tags 
group box, click the browse button (…) next to the state block you want to edit. The Direct 
Phase Tag Template dialog box appears. 

4. Enter your changes to the Enter, Exit, and/or Status tags, and click OK. 

5. To modify the tag for a standard phase, in the Standard Tags group box, click the browse 
button (…) next to the standard tag you want to edit. The Tag Template dialog box appears.  

6. Enter your changes to the tag or field, and click OK to return to the Direct Phase Template 
dialog box. 

7. To modify the node name for all phases, enter it in the Node field. Otherwise, click the Use 
Server Alias button to populate all of the Server name fields with the "#ALIAS#." text. The 
#ALIAS# syntax allows you to use the Alias configured in the Create OPC Server dialog box. 

NOTE: To access the Create OPC Server dialog box, on the Edit menu, select Server. Select 
a server and click Edit, or click Add to add a new one. The dialog that displays after you click 
Edit or Add will display the Alias field for you to edit. 

8. Click OK. 

Overview: Configuring Equipment Phases 

To configure equipment phases: 

1. In the Batch Equipment Editor or WorkSpace, configure an equipment phase class for every 
equipment phase required in your process.  

2. Configure an instance of each equipment phase class on each unit where the equipment phase 
executes.  

3. Tie each equipment phase instance to the equipment.  

4. If the equipment phase is shared by multiple units, share the equipment phase between units.  

Configuring Equipment Phase Classes 

To configure an equipment phase class: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, double-click any unit in your 
process cell. The Create Equipment Phase Class dialog box appears. 

2. From the General tab, enter a unique name for the equipment phase class in the Name field. If you 
are creating a Batch Direct class, consider using a prefix such as BD_ at the beginning of the name. 

3. Enter the equipment phase type in the Type field, or leave this field blank. 

4. Select an appropriate icon for the equipment phase class. 

5. For standard phases only, enter the number of: 

• Request tags required by this equipment phase class. 

• Phase partners required by this equipment phase class. 

NOTE: Both of these fields are unavailable for direct phases. Direct phases do not support 
message partners. 
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6. Select the Parameters tab and configure any phase parameters required by the equipment 
phase class.  

7. Select the Reports tab and configure any phase reports required by the equipment phase class.  

8. For standard phases only, select the Operator Messages tab and configure any operator 
messages required by the equipment phase class.  

9. For direct phases only, select the Enable Tags tab and enable any tags required by the direct phase class. 

NOTE: The Enable Tags tab is only available for direct phases. Similarly, the Operator 
Messages tab only appears in the dialog box for standard phases. 

Configuring Equipment Phase Parameters 

To configure equipment phase parameters: 

1. In the Batch Equipment Editor or WorkSpace, in the Create or Edit Equipment Phase Class 
dialog box, or Direct Phase Class dialog box, select the Parameters tab. 

2. Click the Add button. The Edit Phase Parameter dialog box appears. 

3. In the Name field, enter a unique, meaningful name. 

4. In the ID field, enter a unique ID. This ID must match the ID used by the phase logic. 

5. Click the down-arrow and select the phase parameter’s data type. 

6. For integer and real parameters: enter the engineering units in the Eng Units field, enter the 
high, low, and default values, and, if appropriate, check the Scale check box to enable scaling. 

7. For string parameters: in the Eng Units field enter the engineering units, and in the Default 
field enter a default value. 

8. For enumeration parameters: click the down-arrow next to the Enum field and select the 
parameter’s enumeration set. Then, click the down-arrow next to the Default field and select 
the default enumeration value. 

9. Click OK.  

Configuring Equipment Phase Reports 

To configure phase reports: 

1. In the Batch Equipment Editor or WorkSpace, in the Create or Edit Equipment Phase Class 
dialog box, or Direct Phase Class dialog box, select the Reports tab. 

2. Click the Add button. The Edit Phase Report dialog box appears. 

3. In the Name field, enter a unique, meaningful name. 

4. In the ID field, enter a unique ID. This ID must match the ID used by the phase logic. 

5. Click the down-arrow and select the phase report’s data type. 

6. For real, integer, and string reports: enter the engineering units in the Eng Units field.  

7. For enumeration reports: click the down-arrow next to the Enum field and select the report’s 
enumeration set. 

8. Click OK. 
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Configuring Operator Messages 

To configure phase operator messages for standard phases: 

1. In the Batch Equipment Editor or WorkSpace, in the Create or Edit Equipment Phase Class 
dialog box, select the Operators Messages tab. 

2. Click the Add button. The Edit Operator Message dialog box appears. 

3. In the Name field, enter the text of the operator message. 

4. In the ID field, enter a unique ID. This ID must match the ID used by the phase logic. 

5. Click OK. 

6. For each operator message you configure, increment the Request field by one.  

Configuring Equipment Phase Instances 

To configure an equipment phase instance: 

1. In the Batch Equipment Editor or WorkSpace, make sure that a server is configured. 

2. In the Equipment folder, double-click the unit to which you want to add the equipment phase. 

3. Select the appropriate equipment phase class from the Phase Classes area. 

4. Move the cursor to the work area. The cursor changes to a right angle. 

5. Click the left-mouse button. An instance of the equipment phase appears. 

6. Double-click the equipment phase instance. The Edit Equipment Phase dialog box appears. 

7. In the Name field, enter a unique name. If you are creating a Batch Direct class, consider 
using a prefix such as BD_ at the beginning of the name. 

8. Click the Server button to select a data server for the equipment phase tags.  

9. Double-click an item in the list box to modify the associated tag (standard phase) or tags 
(direct phase). 

10. Enter any equipment arbitration information.  

11. Specify any needed equipment.  

12. Click OK. 

Updating the Edit Equipment Phase Dialog Box 

To update the Edit Equipment Phase dialog box: 

1. In the Batch Equipment Editor or WorkSpace, right-click the phase and select Equipment 
Phase Properties. The Edit Equipment Phase dialog box appears.  

2. In the Name field, enter a unique name. If you are creating a Batch Direct class, consider 
using a prefix such as BD_ at the beginning of the name. 

3. Click the Server button to select a data server for the equipment phase tags.  

4. Double-click an item in the list box to modify the associated tag (standard phase) or tags 
(direct phase). 
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5. Enter any equipment arbitration information. 

6. Specify any needed equipment.  

7. Click OK. 

Tying Equipment to the Data 

To tie equipment to the data: 

1. In the Batch Equipment Editor or WorkSpace, define the OPC data server. 

2. Assign the OPC data server to equipment phase tags. 

3. Assign the OPC items to the standard equipment phase tags.  

4. Additionally, if you are configuring a direct phase, assign the Enter, Exit, and Status tags for 
the direct phase state blocks (Running, Holding, Held, Restarting, Stopping, or Aborting).  

Adding an equipment phase tag to an iFIX Database 

To add an equipment phase tag to an iFIX database: 

1. In the Batch Equipment Editor or WorkSpace, double-click the equipment phase. The Edit 
Equipment Phase dialog box appears. 

2. Assign the Intellution OPC server to the equipment phase tags.  

3. In the Equipment Phase Tags list box, double-click the equipment phase tag. The Edit 
Equipment Phase Tag dialog box appears. 

4. In the Item field, enter the node.tag.field for the tag that you want to add to the database. A 
message appears indicating that the tag does not exist and asks if you want to add it to the 
database. 

5. Click Yes to add the new tag to the database. The iFIX Add Block dialog box appears. 

6. Select the block type you want to add to the database. The selected block’s dialog box 
appears.  

7. Configure the block and click OK. The new block is added to the iFIX database and is 
assigned to the selected equipment phase tag. 

NOTE: When saving and exiting the WorkSpace, you are prompted to save your changes in 
the iFIX database if a tag was added through the Equipment Editor. 

Assigning OPC Data Items to Equipment Phase Tags 

To assign an OPC item to a standard equipment phase tag: 

1. In the Batch Equipment Editor or WorkSpace, double-click the equipment phase. The Edit 
Equipment Phase dialog box appears. 

2. In the list box, double-click the equipment phase tag. The Edit Equipment Phase Tag dialog 
box appears. 

3. Enter the OPC tag name or click the ? button next to the Item field to display the Browse OPC 
Items dialog box. If you are using the iFIX OPC server and the tag you require does not exist, 
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you can add the tag to the database. For more information, refer to the Adding an equipment 
phase tag to an iFIX Database section. 

NOTE: The browse functionality is available only if your OPC server supports the browse 
function as defined in the OPC Specification. GE’s OPC server supports the browse function. 

4. Click the plus sign (+) to expand the database. 

5. Double-click a tag from the list. The tag name appears in the Item field. 

6. Click OK to return to the Edit Equipment Phase Tag dialog box. 

7. Click OK. 

Editing the Enter, Exit, and Status tags for a State Block in a Direct Phase 

To edit the Enter, Exit, and Status tags for a state block in a direct phase: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Direct Tag Template. 
The Direct Tag Template dialog box appears. 

2. In the Direct Tags group box, click the browse button (…) next to the state block you want to 
edit. The Direct Phase Tag Template dialog box appears. 

3. For each tag, enter any changes to the tag suffix, field, or value: 

If you want the Status tag to have the same address as the Enter tag, select the Same as Enter 
tag check box.  Be aware that for the Status tag you can also change the operator from = to 
another logical operator from the drop-down list. 

If you want the Exit tag to use the same address as the Enter tag, but invert the active level, 
select the Inverse of the Enter tag check box.  For instance, if the Enter tag is equal to 1, the 
Exit tag would be set to 0. 

4. Click OK. 

NOTE:  You cannot edit the Node or Phase fields from the Direct Phase Tag Template dialog 
box. To change the node name, change the Node field from the Direct Phase Template dialog 
box. Be aware that the Phase name field is just a placeholder for information that gets added 
when you actually add the phase; the Phase name field gets modified when you add or modify 
equipment phases in the Equipment Editor.  

Modifying the Standard Tags for a Direct Phase 

To edit a standard phase tag for a direct phase: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Direct Tag Template. 
The Direct Tag Template dialog box appears. 

2. Select the browse (...) next to the standard tag that you want to edit. The Tag Template dialog 
box appears. 

3. If you want to change the tag name, enter the change in the third field. 

4. If you want to change the tag type, enter the change in the fourth field. 

5. Click OK. 

NOTE: You cannot edit the Node or Phase fields from this dialog box. To change the node 
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name, change the Node field from the Direct Phase Template dialog box. Be aware that the 
Phase name field is just a placeholder for information that gets added when you actually add 
the phase; the Phase name field gets modified when you add or modify equipment phases in 
the Equipment Editor. 

Modifying the Direct Phase Tags in the Template 

To edit the direct phase tags in the template: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Direct Tag Template. 
The Direct Tag Template dialog box appears. 

2. In the Direct Tags group box, click the browse button (…) next to the state block you want to 
edit. The Direct Phase Tag Template dialog box appears. 

3. Enter the tags and values for the Enter, Exit, and Status tags. Click the browse button (…) to 
browse tags from your OPC server software, if it’s available. 

If you want the Status tag to have the same address as the Enter tag, select the Same as Enter 
tag check box. Be aware that for the Status tag you can also change the operator from = to 
another logical operator from the drop-down list. 

If you want the Exit tag to use the same address as the Enter tag, but invert the active level, 
select the Inverse of the Enter tag check box. For instance, if the Enter tag is equal to 1, the 
Exit tag would be set to 0. 

4. Click OK. 

Maintaining Equipment Phases 

For information on maintaining equipment phases, refer to the following sections: 

• Editing Equipment Phase Tags 

• Resetting Equipment Phase Tag Items to the Proficy Batch Execution Defaults 

• Enabling Tags 

• Modifying Equipment Phase Classes 

• Deleting Equipment Phase Classes 

Editing Equipment Phase Tags 

To edit all equipment phase tags: 

1. In the Batch Equipment Editor or WorkSpace, on Edit menu, click Tags. The Edit Tags dialog 
box appears. 

2. Select the tag class type for the equipment phase tags you want to edit. All equipment phase 
tags for the selected tag class appear in the Tags list box. 

3. In the Tags list box, select the tag you want to edit. 

4. Click the Edit Tag button to edit the tag. 
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Resetting Equipment Phase Tag Items to the Proficy Batch Execution Defaults 

To reset tag items to the Proficy Batch Execution default names: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, double-click the equipment 
phase instance. The Edit Equipment Phases dialog box appears. 

2. Click the Default button. All tags are renamed to the Proficy Batch Execution defaults. 

Enabling Tags for Direct Phases 

To enable tags for direct phases: 

1. In the Batch Equipment Editor or WorkSpace, click the Add Batch Direct Phase icon, or 
double-click the batch direct phase class in the Phase Classes area. The Create or Edit Direct 
Equipment Phase dialog box appears. 

2. Select the Enable Tags tab. 

3. Select the check box next to each state block that you want to enable tags for. 

NOTE: Only the Running state block is required. As such, the check box is not available; you 
cannot clear the check box next to the Running state block. 

4. Click OK. 

Modifying Equipment Phase Classes 

To modify an equipment phase class: 

1. In the Batch Equipment Editor, in the Phase Classes area, double-click the equipment phase 
class that you want to modify. The Edit Equipment Phase Class dialog box appears. 

2. If necessary, modify the name for the equipment phase class in the Name field. 

3. If necessary, modify the equipment phase type in the Type field, or leave this field blank. 

4. If necessary, select an appropriate icon for the equipment phase class. 

5. If necessary, for standard phases only, modify the number of: 

• Request tags required by this equipment phase class.  

• Phase partners required by this equipment phase class. 

NOTE: Both of these fields are unavailable for direct phases. Direct phases do not support 
message partners. 

6. If necessary, configure any phase parameters required by the equipment phase class. For more 
information, refer to the Configuring Equipment Phase Parameters section. 

7. If necessary, configure any phase reports required by the equipment phase class. For more 
information, refer to the Configuring Equipment Phase Reports section.  

8. If necessary, for standard phases only, configure any operator messages required by the 
equipment phase class. For more information, refer to the Configuring Operator Messages 
section.  
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9. If necessary, for direct phases only, enable any tags required by the direct phase class. For 
more information, refer to the Enabling Tags for Direct Phases section.  

NOTE: The Enable Tags tab is only available for direct phases. Similarly, the Operator 
Messages tab only appears in the dialog box  

Deleting Equipment Phase Classes 

To delete an equipment phase class: 

1. In the Batch Equipment Editor, in the Phase Classes area, select the equipment phase class 
that you want to delete. 

2. Press the Delete key. 

NOTE: Before you can delete a phase class, you must first delete all its associated equipment 
phases. 

Configuring Control Modules 
For information on configuring control modules, refer to the following sections: 

• Configuring Control Modules 

• Deleting Control Modules 

• Modifying Control Modules 

Configuring Control Modules 

To configure control modules: 

1. In the Batch Equipment Editor or WorkSpace, on Edit menu, click Control Modules. The Edit 
Control Modules dialog box appears. 

2. In the Classes area, click the Add button. The Add Control Module Class dialog box appears. 

3. Enter a unique name for the control module class and click OK. 

4. Select the control module class to which you want to add a control. 

5. In the Control Modules area, click the Add button. The Add Control Module dialog box 
appears. 

6. Enter a unique name for the control module in the Name field. 

7. Enter any equipment arbitration information. 

8. Specify any needed equipment. 
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Deleting Control Modules 

To delete control modules: 

1. In the Batch Equipment Editor or WorkSpace, on Edit menu, click Control Modules. The Edit 
Control Modules dialog box appears. 

2. In the Control Module Class list box, select the class containing the control module you want 
to delete. 

3. In the Control Modules list box, select the control module you want to delete. 

4. Click Delete. The resource is removed from the Control Modules list box. 

Modifying Control Modules 

To modify control modules: 

1. In the Batch Equipment Editor or WorkSpace, on Edit menu, click Control Modules. The Edit 
Control Modules dialog box appears. 

2. In the Control Module Class list box, select the class containing the control module you want 
to modify. 

3. In the Control Modules list box, double-click the control module you want to modify. 

4. Modify the name or arbitration information as appropriate. 

Configuring Enumerations 
For information on configuring enumerations, refer to the following sections: 

• Overview: Configuring Enumerations 

• Defining Enumeration Sets 

• Defining Enumerations 

• Modifying Enumeration Set Names 

• Configuring the UNIT_OF_MEASURE Enumeration Set 

• Deleting Enumeration Sets 

Overview: Defining Enumerations 

To define enumerations: 

1. Define enumeration sets: 

a. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Enumeration 
Sets. The Create Enumerations Sets and Enumerations dialog appears. 

b. In the Sets area, click the New button. The Create Enumeration Set dialog appears. 

c. Enter a unique name for the enumeration set in the Enumeration Set field. 
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d. Click OK. 

2. Define enumeration strings and their corresponding ordinal values: 

a. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Edit 
Enumerations. The Create Enumerations Sets and Enumerations dialog box appears. 

b. Click the appropriate enumeration set.  

c. In the Enumerations area, click the New button. The Create Enumeration dialog box 
appears. 

d. In the Enumeration field, enter a unique, meaningful name.  

e. In the Ordinal field, enter the corresponding numeric value. This value must match 
the value defined in phase logic. 

f. Click OK.  

NOTE: Proficy Batch Execution supplies two predefined enumeration sets: 
PHASE_FAILURES and UNIT_OF_MEASURE. These sets are required by Proficy Batch 
Execution and cannot be deleted. 

Defining Enumeration Sets  

To define enumeration sets: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Enumeration Sets. The 
Create Enumerations Sets and Enumerations dialog appears. 

2. In the Sets area, click the New button. The Create Enumeration Set dialog appears. 

3. Enter a unique name for the enumeration set in the Enumeration Set field. 

4. Click OK. 

Defining Enumerations 

To define enumerations: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Enumeration Sets. The 
Create Enumerations Sets and Enumerations dialog box appears. 

2. Click the appropriate enumeration set.  

3. In the Enumerations area, click the New button. The Create Enumeration dialog box appears. 

4. In the Enumeration field, enter a unique, meaningful name.  

5. In the Ordinal field, enter the corresponding numeric value. This value must match the value 
defined in phase logic. 

6. Click OK.  



Equipment Configuration Manual  

171 

Modifying Enumeration Set Names 

To modify an enumeration set name: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Enumeration Sets. The 
Create Enumeration Sets and Enumerations dialog box appears. 

2. Click the appropriate enumeration set. 

3. Enter the new name for the enumeration set. 

4. Click OK. 

NOTE: You cannot modify the names of the UNIT_OF_MEASURE or PHASE_FAILURES  

Configuring the UNIT_OF_MEASURE Enumeration Set 

To configure the UNIT_OF_MEASURE enumeration set: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Enumeration Sets. The 
Create Enumerations Sets and Enumerations dialog box appears. 

2. In the Enumeration Sets list box, select the UNIT_OF_MEASURE enumeration set. A list of 
the existing units of measure appear in the Enumerations list box. 

3. To add a new unit of measure, in the Enumerations area, click New. 

4. To edit an existing unit of measure, in the Enumerations list box, select the unit of measure 
and click Edit. 

5. To delete a unit of measure, in the Enumerations list box, select the unit of measure and click 
Delete. 

NOTE: You cannot delete a unit of measure that is currently assigned to a unit. First, assign 
a different unit of measure to the unit and then you can delete the unused unit of measure. 

Deleting Enumeration Sets 

To delete an enumeration set: 

1. In the Batch Equipment Editor or WorkSpace, on the Edit menu, click Enumeration Sets. The 
Create Enumeration Sets and Enumerations dialog box appears. 

2. Click the appropriate enumeration set. 

3. In the Sets area, click the Delete button. 

NOTE: You must delete all enumerations within an enumeration set before you can delete the 
enumeration set. 

4. Click Yes when prompted for confirmation. 

5. Click OK. 

NOTE: You cannot delete the UNIT_OF_MEASURE or PHASE_FAILURES enumeration 
sets. 
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Configuring Arbitration 
For information on configuring arbitration, refer to the following sections: 

• Configuring Equipment Arbitration 

• Configuring Needed Equipment 

Configuring Arbitration 

To configure arbitration: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, select the piece of equipment 
for which you need to define arbitration settings. 

2. Right-click the equipment, select Properties. The Edit or Properties dialog box for the 
equipment instance appears. 

NOTE: For control modules, select the Edit Control Modules button on the toolbar and 
double click the control module. 

3. In the Equipment ID field, enter a unique ID. Proficy Batch Execution assigns a default 
unique ID. 

NOTE: If your phase logic performs requests to acquire and release this equipment, it must 
match the ID in the phase logic. 

4. In the Max Owners field, enter the maximum number of owners that can simultaneously use 
this piece of equipment. 

NOTE: If the equipment phase is shared, you need to set the Max Owners field to 1 in the 
Edit Equipment Phase dialog box. 

   

Configuring Needed Equipment 

To assign needed equipment: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, select the equipment entity 
you want to assign needed equipment. 

2. Right-click the equipment and select Properties. The Edit dialog box for the equipment 
instance appears. 

NOTE: For control modules, select the Edit Control Modules button on the toolbar and 
double-click the control module. 

3. In the arbitration area, click the Add button. The Select Equipment dialog appears. 

4. Click the plus sign (+) next to the folder containing the required equipment. The folder 
expands listing all the configured equipment. 

5. Double-click the required equipment. The selected equipment appears in the Needed list. 

6. Click OK.  
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Configuring Shared Resources 
For information on configuring shared resources, refer to the following sections: 

• Sharing Resources 

• Sharing Units Between Process Cells 

• Sharing Equipment Phases Between Units 

• Defining a Master Process Cell for Shared Units 

• Deleting a Master Shared Unit 

• Deleting a Shared Unit Instance 

Sharing Resources 

To share a unit between process cells: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, double-click the process cell 
to which you want to add the shared unit. 

2. Click the Share button on the Equipment Editor toolbar, or from the Edit menu, click Share 
Unit. The Share Unit dialog box appears. 

3. Click the plus sign (+) next to the process cell containing the unit that you want to share. The 
folder expands listing all of the configured units. 

4. Select the unit you want to share, and click OK. 

The unit appears in the work area. A share icon displays beneath the unit to indicate it is shared. 

5. Define a master process cell for the shared units:  

a. Right-click the shared unit and select Unit Properties. The Unit Properties dialog box appears. 

b. On the General tab, in the Master Process Cell drop-down list, select a process cell to 
designate as the master (primary) process cell for the shared units.   

After you select a master for this shared unit, all shared instances of this unit are updated with 
the master process cell name. 

To share an equipment phase between units: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, double-click the unit to which 
you want to add the shared equipment phase. 

2. Click the Share button on the Equipment Editor toolbar, or from the Edit menu, click Share 
Equipment Phase. The Share Equipment Phase dialog box appears. 

3. Click the plus sign (+) next to the unit containing the equipment phase you want to share. The 
folder expands listing all of the configured equipment phases. 

4. Select the equipment phase you want to share, and click OK. 

5. The equipment phase appears in the work area. A share icon displays beneath the equipment 
phase to indicate it is shared. 
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Sharing Units Between Process Cells 

To share a unit between process cells: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, double-click the process cell 
to which you want to add the shared unit. 

2. Click the Share button on the Equipment Editor toolbar, or from the Edit menu, click Share 
Unit. The Share Unit dialog box appears. 

3. Click the plus sign (+) next to the process cell containing the unit that you want to share. The 
folder expands listing all of the configured units. 

4. Select the unit you want to share, and click OK. 

The unit appears in the work area. A share icon displays beneath the unit to indicate it is shared. 

5. Define a master process cell for the shared units:  

a. Right-click the shared unit and select Unit Properties. The Unit Properties dialog box appears. 

b. On the General tab, in the Master Process Cell drop-down list, select a process cell to 
designate as the master (primary) process cell for the shared units.   

After you select a master for this shared unit, all shared instances of this unit are updated with 
the master process cell name. 

Sharing Equipment Phases Between Units 

To share an equipment phase between units: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, double-click the unit to which 
you want to add the shared equipment phase. 

2. Click the Share button on the Equipment Editor toolbar, or from the Edit menu, click Share 
Equipment Phase. The Share Equipment Phase dialog box appears. 

3. Click the plus sign (+) next to the unit containing the equipment phase you want to share. The 
folder expands listing all of the configured equipment phases. 

4. Select the equipment phase you want to share, and click OK. 

The equipment phase appears in the work area. A share icon displays beneath the equipment 
phase to indicate it is shared. 

Defining a Master Process Cell for Shared Units 

To define a master process cell for your shared units: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, double-click the process cell 
that contains the unit that you want to become the master. 

2. Right-click the unit and select Unit Properties. The Unit Properties dialog box appears. 

3. On the General tab, in the Master Process Cell drop-down list, select the process cell to 
designate as the master (primary) process cell for the shared units.   

After you select a master for this shared unit, all shared instances of this unit are updated with 
the master process cell name. 
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Deleting a Master Shared Unit 

To delete a master unit: 

NOTE: When you remove a master unit that is shared amongst process cells, all instances of 
that unit are removed. If you do not delete all the equipment phases before attempting to 
remove the master unit, then the removal fails and the system displays an error message. 

1. In the Batch Equipment Editor or WorkSpace, delete all equipment phases within the unit. 

2. In the work area, click the master shared unit you want to delete. 

3. On the Edit menu, select Delete Unit. A confirmation message box appears. 

4. Click Yes to continue. The master and all instances of that unit are deleted from your project. 

Deleting a Shared Unit Instance 

To delete an instance of a shared unit: 

1. In the Batch Equipment Editor or WorkSpace, in the work area, click the unit you want to 
delete. 

2. On the Edit menu, select Remove Shared Unit. 
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